This manual was written by Sibylle Mühlke (www.pangramm.de) and translated into English by Mag. Lisa Calnan (www.reddragontrans.com).

The layout was designed by H. Erich Fraas and Jens F. Adam using Meta fonts (Erik Spiekermann, FontShop). Formulas, special characters and keycap symbols are set in Zapf Dingbats (Hermann Zapf, International Typeface Corporation), Prestige 12 Pitch (Bitstream Inc), Zeal (The Font Bureau) and Hilden 95 (Jens F. Adam, RagTime.de Development GmbH).

Version: 6.5 en (March 30, 2009)
Overview
Chapter 1: Overview

1.1 WELCOME – RAGTIME 6 TRAINING

The RagTime 6.5 documentation consists of several parts on various media:

- **First Steps with RagTime** (on screen)
  An interactive introduction presented when RagTime 6.5 first launches.

- **Training Manual** (printed, PDF document)
  The basics in 13 easy exercises for beginners to RagTime 6.5.

- **RagTime 6.5 Reference** (printed, on screen, PDF document)
  All about RagTime documents and their components, detailed descriptions of all windows, palettes, commands, dialog boxes and their panels.

- **RagTime Formulas and Functions** (on screen, PDF document)
  Descriptions and examples of calculation functions and operators.

- **The RagTime Web Site** (Internet)
  Latest news around RagTime 6.5. Visit http://www.ragtime-online.com (English) or http://www.ragtime.de (German) or http://experts.ragtime.de for the expert pages (German).

The complete RagTime 6.5 documentation is suitable for Microsoft Windows and Mac OS users alike. **Differences between operating systems** are marked with special symbols.

โดยเฉพาะ Compatible Procedures and functions typical for Windows are marked like this paragraph. For short remarks, you'll find this symbol in the body text as well.

This symbol points out functions and commands typical for the Mac OS.

The **on-screen documentation** is installed with the program. It contains detailed descriptions of commands, features, functions etc. and is best used to look up information. All topics are interconnected by hyperlinks and a number of search facilities are available (index, list of commands, list of functions, full text search.) Commands to open the on-screen documentation are available in the RagTime menus INFO (Intellect) or HELP (Intellectual), respectively.

**RagTime 6.5-Training Manual**

The training manual that you are currently reading provides a quick introduction into working with RagTime 6.5, which will soon enable you to
use the program productively in your day-to-day working life and find solutions to individual tasks. It is directed at computer users, who have yet to learn about RagTime or are not at all familiar with the product.

In chapter \textit{RagTime at a Glance} [p. 19], \textbf{basic information} about RagTime 6.5 is presented. You can read about the features provided by RagTime 6.5 for the effective compiling, designing and publishing of all kinds of data and information. This therefore gives you an idea of what can be done with RagTime 6.5. In the first section you also learn about the most important concepts and operating modes and are provided with RagTime 6.5 terms, which will prove to be essential when working with RagTime 6.5. An insight into the fundamentals of operating RagTime will really help you complete the practice exercises in this manual!

In the next section, \textit{RagTime-Basic Knowledge} [p. 33] you will get to know more about the user interface of RagTime 6.5. You will also become acquainted with the most important commands for creating, searching, opening and saving files, which are absolutely essential in day-to-day working life.

The most extensive and significant sections in the manual are the \textbf{practical} exercises. RagTime facilitates three different ways of dealing with new documents, with varying levels of planning and time savings of time when making subsequent changes or in case of frequent use. The 13 exercises are arranged accordingly in three chapters:

- \textit{Quick Introduction: Tools, Functions, Working Methods} [p. 49]: Learn all the important functions and commands in RagTime necessary for typical tasks such as writing and creating a layout for a business letter, using the mail merge function or creating a price list. The documents, which you are building step-by-step, can be used immediately!

- \textit{The RagTime Stationery Pad: Style Sheets for Frequently Used Documents} [p. 165]: You can use forms and stationery pads, if you want to use a specific document again and again without having to recreate it every time. Business letters, memos and protocols or invoices are typical areas of application for forms. RagTime forms not only deliver as many independent copies for a one-time document as you like, but also boast “intelligent” automatic page generation. This means that your document always has the exact amount of pages you actually require. In the second group of exercises you will find out more about these time-saving documents.

- \textit{The RagTime Master Layout: Complex Documents} [p. 207]: The RagTime master layout is used if you want to gradually add to extensive documents and easily deal with any changes to be made. Mas-
ter layout components enable you to systematically build as many complex layouts as you wish. Changes to extremely sizable documents can also be easily made at a central location. Furthermore, you can specify detailed settings for automatic page generation in the document. The initial planning and setup pays off with greater editing ease and productivity.

In each exercise you will find a short overview of the contents and objectives, then you can work through the subject matter in a detailed, step-by-step introduction. Some exercises also contain additional sections, in which a new working technique or concept is fundamentally explained.

The necessary files are included with RagTime 6.5 so that you can understand the exercises as described. Instructions in the exercises indicate if you require files from this folder.

After the exercise section you will be provided with information on the output of RagTime 6.5 documents in print, as HTML or as PDF export (RagTime Documents as PDF or HTML File [p. 241]).

In the Appendix you will find a list of frequently asked questions – and answers (Frequently Asked Questions – and Answers [p. 259]).

The Legend [p. 267] informs you of the typographical conventions in this manual and explains the symbols used.

The Glossary [p. 271], which illustrates special terms, and the extensive Index [p. 283] bring the manual to a close.

This training manual is an introduction to RagTime 6.5. It conveys the ideas and basic concepts behind RagTime 6.5 and makes you familiar with all the important tools in step-by-step exercises, thus ensuring that you are able to learn about RagTime’s functional principles in practice. Not all functions can, however, be explained in exhaustive detail, nor can acute problems arising from a specific working situation be anticipated – this would probably require a whole series of books just dedicated to RagTime 6.5. In the event that the training manual is not able to answer one of your questions, please consult the other sections of the RagTime 6.5 documentation [p. 4].
# 1.2 CONTENTS

## 1 Overview
1.1 Welcome – RagTime 6 Training ................................................. 4
1.2 Contents .............................................................................. 7
1.3 Figures .................................................................................. 10
1.4 Tips ...................................................................................... 17

## 2 RagTime at a Glance
2.1 Mastering Content Diversity: Business Publishing with RagTime ................................................................. 20
2.2 The Concepts behind RagTime ............................................. 21
2.2.1 Planning Expenditure and Editing Ease .............................. 22
2.2.2 Effective Formatting with Style Sheets ........................... 23
2.2.3 Contents with Varied Elements: Components .................. 25
2.2.4 Essential for the Layout: Container ................................. 28
2.2.5 Start Anywhere ................................................................. 29
2.2.6 Data Import, Data Export ................................................. 32

## 3 RagTime-Basic Knowledge
3.1 RagTime User Interface ......................................................... 34
3.1.1 Menus, Bars and Palettes in Windows ............................... 35
3.1.2 Menus, Bars and Palettes in Mac OS .................................. 38
3.1.3 All Components at a Glance: The Inventory .................... 40
3.2 Becoming Familiar with Files .............................................. 43
3.2.1 Retrieving and Creating Files: The RagTime Foyer ............ 43
3.2.2 Foreign File Formats: Importing Files .............................. 45
3.2.3 Saving Files ........................................................................ 45
3.2.4 Printing Files ................................................................. 46
3.2.5 Closing Files ................................................................. 47

## 4 Quick Introduction: Tools, Functions, Working Methods
4.1 Exercise 1: Greeting Card with Text and Pictures ............... 50
What’s it about? ..................................................................... 50
Step by Step ........................................................................... 50
4.2 Exercise 2: Formal business letter with automatic date
generation ............................................................................ 68
What’s it about? ..................................................................... 68
Step by Step ........................................................................... 68
4.3 Exercise 3: Quickly Designed Flyer: Text Container with
Pipelines .............................................................................. 84
What’s it about? ..................................................................... 84
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Overview</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>4.4</td>
<td>Preparation: Spreadsheet Basics</td>
<td>85</td>
<td></td>
</tr>
<tr>
<td>4.4.1</td>
<td>Configuration, Technical Terms, Tools</td>
<td>93</td>
<td></td>
</tr>
<tr>
<td>4.4.2</td>
<td>Create Spreadsheets</td>
<td>93</td>
<td></td>
</tr>
<tr>
<td>4.4.3</td>
<td>Tips for Data Entry</td>
<td>95</td>
<td></td>
</tr>
<tr>
<td>4.4.4</td>
<td>Navigation in the Spreadsheet</td>
<td>95</td>
<td></td>
</tr>
<tr>
<td>4.4.5</td>
<td>Selections in Cells and Spreadsheets</td>
<td>98</td>
<td></td>
</tr>
<tr>
<td>4.4.6</td>
<td>Calculations and Formulas</td>
<td>98</td>
<td></td>
</tr>
<tr>
<td>4.5</td>
<td>Exercise 4: An Invoice with the Spreadsheet</td>
<td>103</td>
<td></td>
</tr>
<tr>
<td>4.6</td>
<td>Exercise 5: Turnover Evaluation in Spreadsheet</td>
<td>103</td>
<td></td>
</tr>
<tr>
<td>4.7</td>
<td>Exercise 6: Mail Merge</td>
<td>103</td>
<td></td>
</tr>
<tr>
<td>4.8</td>
<td>Preparation: Drawing Basics</td>
<td>118</td>
<td></td>
</tr>
<tr>
<td>4.8.1</td>
<td>Differences and Similarities</td>
<td>118</td>
<td></td>
</tr>
<tr>
<td>4.8.2</td>
<td>Begin with Drawing Component</td>
<td>118</td>
<td></td>
</tr>
<tr>
<td>4.8.3</td>
<td>Tools for Closed Shapes</td>
<td>137</td>
<td></td>
</tr>
<tr>
<td>4.8.4</td>
<td>Tools for Lines</td>
<td>137</td>
<td></td>
</tr>
<tr>
<td>4.8.5</td>
<td>Polygon and Bézier Tool</td>
<td>137</td>
<td></td>
</tr>
<tr>
<td>4.8.6</td>
<td>Edit Drawing Objects</td>
<td>137</td>
<td></td>
</tr>
<tr>
<td>4.8.7</td>
<td>Change Polygons and Bézier Objects</td>
<td>137</td>
<td></td>
</tr>
<tr>
<td>4.9</td>
<td>Exercise 7: Working with the Drawing Component: CD Cover</td>
<td>144</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>The RagTime Stationery Pad: Style Sheets for Frequently Used Documents</td>
<td>144</td>
<td></td>
</tr>
<tr>
<td>5.1</td>
<td>What can a Stationery Pad do?</td>
<td>145</td>
<td></td>
</tr>
<tr>
<td>5.2</td>
<td>Exercise 8: A Simple Stationery Pad for Minutes</td>
<td>145</td>
<td></td>
</tr>
<tr>
<td>5.3</td>
<td>Exercise 9: Letter Stationery Pad with Multiple Pages</td>
<td>147</td>
<td></td>
</tr>
<tr>
<td>5.4</td>
<td>Exercise 10: A Stationery Pad with Different Following Pages</td>
<td>152</td>
<td></td>
</tr>
</tbody>
</table>
1.3 FIGURES

1. The gallery contains various prepared layouts for graphs.
2. A document created with RagTime looks like this, for example, when printed.
4. The RagTime user interface in Windows with a layout component containing a still empty text container.
5. Tearing off of a submenu.
6. A torn-off submenu as a floating palette.
7. The RagTime user interface with a layout component containing a still empty text container.
8. Tearing off of the submenu so that it can be used as a palette.
9. The palette dock serves as a space-saving interim storage facility.
10. Inventory in Windows.
11. Inventory in Mac OS.
12. The Foyer is an easy-to-operate control center for locating already saved documents and creating new files.
13. Importable File Types.
14. The intermediate results of the first exercise.
15. View of Foyer: How do you want to begin a new document?
17. Select drawing object: pay attention to correct mouse cursor shape.
18. Selected drawing object.
19. Layout page with unhidden grid.
20. Drawing rectangles (and similar objects).
22. Increasing the size of the rectangle while maintaining the original proportions.
23. Widening rectangle.
24. The rectangle is ready to be moved.
25. Moving of drawing objects: the object outline moves as well; the mouse cursor changes.
26. Placing a moved drawing object in a new position.
27. Intermediate result for Exercise 1: three aligned rectangles.
28. Transferring a picture file to a drawing object via drag and drop (Windows).
Transferring a picture file into a drawing object via drag and drop (Mac OS). ........................................ 63
You can scale down the pictures with the Scale tool. .... 65
Increasing a picture with the Scale tool. .................... 65
Subsequently formatting Graphical Text. ....................... 66
Moving Graphical Text. ........................................ 67
Selecting individual characters in Graphical Text. ........... 67
Changing wording of text in Graphical Text. ................ 67
Intended result for exercise 2: business letter. ............... 69
Specifying the content type of containers using the menu. .... 70
The COORDINATES panel in the DRAWING INFORMATION dialog box ............................................. 71
Setting content type of a drawing object prior to drawing. .... 72
An empty picture component is characterized by two diagonal lines (shaped like an X). ......................... 73
The guide is “dragged out” of the ruler. ....................... 74
The guide position is displayed, while the guide is moved with the mouse. .............................................. 74
Dialog box for the fine adjustments of a guide. ............... 75
Exercise 2: the company logo has been put into position. .... 75
Typography tools in the typography palette. .................. 76
Tool bar: settings for line spacing, text alignment, tabs and an extra button for footnotes. ................. 77
The letterhead as a close-up .................................. 77
Unhidden special characters ................................. 78
Changing the text indentation by mouse and margin stop 78
The panel TEXT MARGINS in the information dialog box. 79
Intermediate result of Exercise 2: The reference lines split into four blocks with the help of tabs. ............ 80
Calculated text highlighted on the screen ...................... 81
Interim result of Exercise 2: The business details cannot be aligned with default tabs. .................... 81
Changing tab positions with the mouse. ..................... 82
The finished business details – perfectly aligned. .......... 82
Intended result for Exercise 3: Realizing layout with pipelines. ......................................................... 84
Exercise 3: potential container arrangement, first example. 85
Exercise 3: potential container arrangement, second example. .............................................................. 86
Exercise 3: potential container arrangement, third example. 86
Chapter 1: Overview

60 Intermediate result of Exercise 3: Layout page with containers, picture and inserted text. 88
61 Installing a pipeline – the source container. 89
62 The pipeline enters the target container. 90
63 Pipelines can also be installed across “uninvolved” containers. 91
64 The spreadsheet tools 94
65 You can start writing. A selection like this can be stretched over numerous cells. It is the basis for many formatting and entry aids. 95
66 Correct numerical entry 97
67 If the cell looks like this, existing contents can be changed. 99
68 If the cell looks like this, existing contents are being replaced by new entries. 99
69 Complete columns or rows can be selected by clicking once on the column or row bar. 100
70 Selection of the whole spreadsheet 100
71 Select non-connected spreadsheet ranges 101
72 The formula palette and the function window 102
73 You will create an invoice like this in this exercise. 103
74 Setting cell border properties. 105
75 The first row is finished. During entry, don’t be concerned if the text in some cells is partially hidden by the next cell (due to the small cell size). 105
76 Fill cells automatically 106
77 A completed numerical sequence. 106
78 The finished item names. 107
79 The finished columns – perfectly aligned 108
80 The ARRANGEMENT panel in the spreadsheet information dialog box 110
81 Selection in the spreadsheet: non-connected cells. 112
82 Filling the neighboring cells. 114
83 A formula was spread to neighboring cells in the spreadsheet. 115
84 The FUNCTIONS window. 116
85 The result of exercise 5: Spreadsheet and graph arranged on a layout page. 119
86 Adjusting the spreadsheet width to the container width. 120
87 Spreadsheet: Transferring cell contents into neighboring cells. 121
88 Sorting in the spreadsheet 125
The Character Style Sheet Editor .................................................. 127
Edit style sheet .............................................................................. 130
The window CHARACTER STYLE SHEET EDITOR, Settings of
the newly designed style sheet TITLE ........................................... 131
Assigning style sheets ................................................................... 132
Document with spreadsheet and (still) empty graph component. .................................................................................. 133
A bar chart ...................................................................................... 134
Inserted graph. Representation details can vary depending on the size of the container ........................................... 135
Example of a graph with inserted data ........................................... 135
The correct mouse position to add addresses to the mail merge ...................................................................................... 138
Incorrect mouse position: You won’t be able to insert addresses into mail merges like this! ........................................ 139
Dialog box DROP OPTIONS: Necessary options for mail merges ...................................................................................... 139
Address components in a spreadsheet, which should be used for mail merges ................................................................. 140
The print dialog box for serial printing in Windows .................................................. 142
Settings for serial printing in Mac OS .............................................. 142
Drawing a polygon: a click has to be placed for every change of direction ........................................................................ 147
Polygons are always treated as closed objects – even if the outline is not closed ................................................................. 147
Examples for various drawing objects, which are selected ........ 148
Changing an arc by using the mouse ................................................ 149
Changing the “corners” in a rounded rectangle .......................... 149
Three text containers in comparison: unedited, enlarged, transformed .................................................................................. 150
Rotating a square with the mouse .................................................. 151
Skewing a square with the mouse .................................................. 151
Edit polygon: selected anchor point .............................................. 153
Edit polygon: the anchor point is moved ....................................... 153
Edit polygon: simultaneous selection of two anchor points .......... 154
Edit Bézier curves: tangent lines help when shaping the curve ...................................................................................... 154
The CURVE EDITING palette ......................................................... 154
The intended result of the seventh exercise: CD cover“design” ...................................................................................... 155
117 Exercise 7, Intermediate Result: The two squares are the most important elements in the planned CD cover.

118 Glue flap, Step One: the first line of the trapezoid-shaped drawing object.

119 Draw trapezoid, Step two: the first slant.

120 The first hold point is activated in order to draw the second slanting line.

121 Draw trapezoid, Step four: draw the second slant.

122 Draw trapezoid – and you’re finished!

123 The finished trapezoid is selected.

124 CD protective cover with two glue flaps – nearly finished!

125 The finished drawing for the CD cover without lettering.

126 The dialog box PAGE SELECTION FOR PDF PLACEMENT.

127 CD cover, intermediate result: alignment of two squares to each other.

128 Folding template for a CD cover with inserted text (labeling) and graphics.

129 In the DRAWING INFORMATION dialog box you can also set how texts should wrap around objects.

130 The intended result of Exercise 8: a stationery pad for the minutes.

131 Drawing objects can be aligned to each other in the dialog box ALIGN OBJECTS.

132 Assignment of a line style sheet in the formatting palette section from the OBJECTS panel in the information dialog box.

133 Exercise 8, intermediate result: the upper section of the subsequent minutes stationery pad.

134 Saving a document as a stationery pad in Windows.

136 Saving a document as a stationery pad in Mac OS.

137 Favorites Panel in the Foyer.

138 Append Pages with stationery Pads.

139 Setting a tab for perfect right alignment.

140 Installing the Circular Pipeline.

141 Installing the Circular Pipeline.

142 Various pipelines and their representation.

143 In DOCUMENT SETTINGS you can specify the tear-off settings for stationery pads.

144 Double-sided stationery pad with different right and left following pages.
153 Manually enter font size .................................. 194
154 the formatting palette .................................... 196
155 FORMATTING palette: Give the new style sheet a name. . 196
156 SPREADSHEET INFORMATION dialog box: Settings for the alignment of the cell contents. .................. 201
157 Intermediate result of Exercise 11: Selection for centering cell contents. ................................. 202
158 SPREADSHEET INFORMATION dialog box: Settings for centering cell contents. ............................ 203
159 Intermediate result of Exercise 11: selection for setting value format. ................................. 204
160 A page is just being transferred from the library to the main document. ................................. 206
161 Schematic overview of the interaction between the document, master layout and layout components. .... 209
162 You will generate such a document with a front and simple following page in exercise 12. ............ 211
163 Preliminary result, exercise 12: the two master pages with guide frames and rectangles. ................ 214
164 “Stacked” containers: Text over picture container. ...... 215
165 Set Usage Rules for a Master Page ......................... 217
166 In the dialog box NEW LAYOUT you can specify that new layout components are dependent on master layout components. ........................................ 220
167 Change Cell Height and Position of Cell Contents. .......... 221
168 Moving Style Sheets to Other Documents ........................ 223
169 The effect of the settings COLOR, OPACITY and TINT .... 225
Chapter 1: Overview

170 A document like this should be created in this exercise: front page, double-sided layout, back page. 226
171 Intermediate result of Exercise 13: the basic master layout frame. 228
172 Dotted green line as design element (detailed view of finished document). 230
173 Selection of Non-Default Color 232
174 The dialog box for determining custom colors (Windows) 232
175 The dialog box for specifying custom colors (Mac OS) 233
176 The window LINE STYLE SHEET EDITOR: Settings for the dotted line in Exercise 13. 234
177 Exercise 13 (document detail): Text and picture components in the header on the first page. 235
178 Exercise 13, Detail on second page: more flexible design grid. 236
179 Detail on third page from Exercise 13. 236
180 Installing pipelines in Exercise 13. 238
181 Dialog Box FIT CONTAINER TO PICTURE. 239
182 PDF EXPORT dialog box, GENERAL panel. 243
183 JOB SETTINGS PDF Export panel 244
184 PDF EXPORT dialog box, PAGE SETUP panel for documents with layout component. 245
185 PDF EXPORT dialog box, PAGE SETUP panel for documents non-layout components. 246
186 Edit CMYK colors 247
187 The HTML EXPORT SETTINGS dialog box. 251
188 Splitting a window so that non-connected areas of a document are viewed at the same time. 265
1.4 TIPS

Tips are boxes with further information, which can be skipped when reading this manual for the first time.

Page Representation and Print Pages

Reset RagTime User Interface
Adjust Foyer

Other Components Set as Default for Document Generation
Using Grid Lines
Drawing Circles and Squares
Undo Steps
Changing Picture Size, Picture Position and Container Size
Background Knowledge: Containers and Content Types
Using Guides
Filling Multiple Cells with the Same Contents
Exact Changes
Other Methods of Calculation
Printing Spreadsheet Components Separately
Inserting Spreadsheets in Other Components
Other Ways of Entering Formulas
Naming Style Sheets
Rearranging Style Sheets and Making them Globally Available
Customizing Graphs
Working with Multiple Windows
Data from Foreign Applications as Address Source
Turning Lines into Arrows
Changing Object Type to Change the Shape

Effectively Managing Stationery in the Foyer
Aligning Tabs to Left or Right Margin
Double-sided Document with Two-column Page Layout
Font Sizes and Units
Inserting Symbols
Library: Transferring Pages from Existing Documents

Summarized in Short: The Steps to Achieving a Master Layout
Master Page Usage at a Glance
Moving Fill Style Sheets to Other Documents
Determining Guide Positions
CHAPTER 1: OVERVIEW

Layout Development in Master Layout . . . . . . . . . . . . . . 230
Which PDF Properties are Implemented? . . . . . . . . . . . . . . 242
Why Color Management? . . . . . . . . . . . . . . . . . . . . . . 248
CHAPTER 2

RagTime at a Glance
Chapter 2: RagTime at a Glance

2.1 MASTERING CONTENT DIVERSITY: BUSINESS PUBLISHING WITH RAGTIME

What actually is “Business Publishing”? Even if the term itself is not that well-known – “business publishing” has long-since had a permanent position in the business world. Compiling, editing, designing and passing on all kinds of data plays an important part in companies and institutions of all sizes and in almost every sector and also takes up a considerable amount of working hours. Documents are designed as mail merges, minutes, memos or letters and serve as external or in-house means of communication. Bids, invoices and time sheets combine figures with some text and also comprise calculations, which should be carried out automatically wherever possible. Product flyers, brochures, catalogues and product lists often incorporate text, pictures and price quotations. Figures and calculations also appear as diagrams or tables in statistics, analyses, synopses and many other documents.

All this data should, of course, be designed as attractively as possible, but is then, however, passed on in various different ways: it can, for example, be printed from your office desktop printer or by a printing company in case of larger print runs and increased quality requirements, sent as PDF files, which can be easily shared between various computers and are safe and compatible with all systems, saved as a HTML page for the internet or intranet or shown as an illustrated “slide show” during a presentation.

RagTime enables you to edit various contents like text, figures, spreadsheets, tables and calculations, diagrams and pictures – and a whole lot more – in one program, in a single document and usually always in the same file format. If required, RagTime acts like a text processing program; it also offers spreadsheet functions like a spreadsheet calculation program; in addition there are also special functions like graphs, which translate figures from the spreadsheet into descriptive diagrams. Pictures, as well as sound and interactive elements like buttons and such like, can be integrated and in part also edited in RagTime documents. In short: RagTime can create complex documents with diverse content types. It is therefore always able to offer the tools you need to change or adapt the respective contents. You can master the many different content types of a RagTime document with RagTime’s layout features. You can therefore combine various types of data in a document; professional functions are available for the design of documents. These functions also enable you to carry out more extensive and complex tasks. You are therefore able to easily integrate texts, spreadsheet tables, drawings, pictures, diagrams and a whole lot more – regardless of how the data is to be out-
put at a later date. Furthermore, you can save time and automate the use of frequently used documents with RagTime and also effectively change and edit extensive documents.

RagTime documents are, however, more than just the well-designed composition of various content types: RagTime documents are “live”. That means that dynamic connections can be established between the various pieces of information, which can be edited by RagTime. Data from a spreadsheet can, for example, be illustrated in a graph, which can be embedded in a document that also contains text and further pictures. If the spreadsheet data changes then the graph is automatically updated.

There are many ways of reproducing your data with RagTime: RagTime documents can, of course, be printed out on a desktop printer. They can, however also be professionally prepared for production at a printing company and can be ported as a PDF or HTML file. The additional module SlideTime, which is built into RagTime, also facilitates the generation and simple playback of presentations directly from RagTime. This way you also save having to manage and elaborately update parallel file versions for various export types.

RagTime is therefore a productive tool and at the same time the location, in which you can integrate, design and prepare various content types for issue in diverse media. The advantages of the “everything in one document” principle, which is consistently applied by RagTime, are obvious: it is no longer necessary to compile data from various sources in an external layout tool and there is now only one data source – the RagTime document – which serves as a basis for reproduction in various media. This means that there is no more need for various data of different reproduction types to be managed at the same time and that any time spent on updating is dispensed with.

2.2 THE CONCEPTS BEHIND RAGTIME

But how does Business Publishing with RagTime actually work? What are the main concepts? How does RagTime “tick”? Anyone who knows the basic principles of a program, will soon gain an overview of the main working procedures and also be able to better understand the details of the functions – and therefore learn how to operate everything altogether quicker. So here are a few words about the ideas and concepts behind RagTime.
2.2.1 PLANNING EXPENDITURE AND EDITING EASE

You have already read about RagTime being able to combine completely different content types in one document and that it is therefore basically able to manage with just one file format (.rtd for “RagTime document”). This way you are not committed to various document types and can work extremely flexibly. And yet there are still differences in RagTime documents. Alongside the quickly created “normal” RagTime documents, RagTime offers functions for frequently used documents and for extensive documents, which require comprehensive editing. An increased expenditure in the preparation and conception of the document is rewarded by increased ease during editing. This additional expenditure is, however, not always necessary and simple RagTime documents can also be edited rather well.

Do you need a finished document as quickly as possible? Or a style sheet, which should be used again and again? Are you dealing with a more complex piece of writing that is being gradually developed? Is there going to be a longer editing phase or how about frequent changes? Clarify all these questions, then you’ll quickly find the right way of working for you!

- You can immediately start working without further preparations and create a complete individual document, which can be edited in exactly the way you want. You will get to know almost all the important functions and working techniques of RagTime in the first exercise section (Quick Introduction: Tools, Functions, Working Methods [p. 49]) based on these “simple documents”.

  When you have worked through this exercise section, you will already be able to use RagTime to edit urgent tasks that are just waiting to be dealt with!

- For efficient multiple use, you can save a document as a so-called stationery pad. You can also subsequently turn a normal document into a stationery pad. Stationery pads can be recognized according to the file extension “.rtt”. A stationery pad serves as a template for as many further documents as you like (“forms”). Subsequent changes to the stationery pad have no effect on documents that were previously generated from the stationery pad.

Despite their “official-sounding” name, stationery pads are not only suitable for forms and such like. All frequently used documents ranging from a simple memo to an extensive illustrated list of articles can be saved as a stationery pad. An especially useful function in the stationery pad is its intelligent page management: a document “torn
2.2: The Concepts behind RagTime

New pages are only generated if required. Even different-looking following pages can be specified in advance. In section The RagTime Stationery Pad: Style Sheets for Frequently Used Documents [p. 165] you will find out more about the tips and tricks surrounding the creation and usage of RagTime stationery pads.

- **Master layouts** lend themselves to working with more complex documents. As the name already suggests, they are especially suitable for the effective organization of challenging layouts. Master layouts are style sheets for other layouts within the same document. A document can contain one or more master layouts (or even none). Every layout, which derives from a master layout, has all the properties of the master layout, but can also contain separate elements. Pages that derive from a master layout, always remain linked to the master layout. This facilitates editing at a later date: you only have to carry out changes from a central location instead of having to completely work through a document in order to enter all changes. Exercises on the master layout can be found in the third exercise section The RagTime Master Layout: Complex Documents [p. 207].

For further reading: The appendix to the training manual includes a checklist comprising all the properties of normal documents, stationery pads and master layouts (see Checklist — When To Use Which Document Type? [p. 253]).

### 2.2.2 EFFECTIVE FORMATTING WITH STYLE SHEETS

RagTime’s style sheets have also been designed to save time and effort when changing a document. With the help of style sheets, you can manage numerous document properties from a central location. RagTime contains some predefined style sheets, but you can also create your own. Style sheets definitely make it easier to format documents and edit formats. Working with style sheets is recommended to also ensure that the exact same format is used in various documents – for example, in all documents generated by a company.

There are style sheets for characters, paragraphs, colors, lines and fillings, but also for auxiliary tools like rulers and units as well as for value formats, which are mainly used in spreadsheets. Connections can be established between some of the style sheets. It is, for example, possible to define a specific blue, e.g., “company blue” as a color style sheet and to then generate a character style sheet – perhaps with the name “logo font” – which, alongside properties like font and style of lettering, also
determines the color of the font and reverts back to the color style sheet “company blue”. Here are the most important style sheets at a glance:

- **Paragraph style sheets** define character properties, which do not apply to individual characters, but whole paragraphs. These include, among others line spacing, text alignment, tabs, wraps and indentations.

- **Color style sheets** appear in many other style sheets, but do not depend on any other style sheets themselves. In color style sheets you are not only able to determine the colors, but also various color spaces – depending on how the document should be reproduced at a later date.

- **Fill style sheets** can be basically used wherever there is color. They do, however encompass more properties than just the color itself. In fill style sheets colors are combined with patterns, transparency and tint.

  ➞ **Color, Tint and Transparency:** Fig. 169 [p. 225] descriptively shows the difference in the properties of color, tint and transparency.

- **Line style sheets** access the fill style sheet by additionally defining the width, position, ends, corners and dotting of lines.

- **Typical character formats** like, for example, font, font style and font size are determined by character style sheets. The letter color can be specified using separate color style sheets or without a style sheet. In addition, there are settings regarding linguistics such as language and hyphenation and regarding value format, which has an effect on, for example, the spelling of numerical values or currency details.

  The small amount of additional time and effort spent using style sheets is soon proved worthwhile – even in smaller documents: if you individually format every text, paragraph, or all lines in a document, then just “clicking together” the required formats is often rather tedious. Four or more properties have, for example, to be changed to set a font. Once a suitable style sheet has been created, then you only have to activate it with a click for it to be applied to sections of a document. And changes can be made quickly at a central location with the help of style sheets without the document having to be reviewed and reformatted bit by bit.

  The functional principle of style sheets is simple. For instance, you don’t simply assign the format “Arial, 14 point, bold” to text elements that serve as a heading, but you assign, for example, the style sheet “chapter heading” to these text elements, which you have previously generated with the requested properties “Arial, 14 point, bold”. If you subsequently
determine that the chapter headings look better in the font “Times, 16 point, bold”, then you only have to alter the style sheet. All text passages in a document, which use the style sheet “chapter heading”, are immediately changed. Elements, which were formatted with style sheets, can, however, still be directly changed at all times – without having to take the style sheet route; Such changes are retained by RagTime even if the style sheets are changed.

You don’t have to generate every single style sheet you require from scratch. Here RagTime works on the principle of inheriting format properties. You can generate a whole family of similar style sheets from one style sheet with just a few clicks and quickly change them by editing the “family head”– the hierarchically superordinated style sheet.

### 2.2.3 CONTENTS WITH VARIED ELEMENTS: COMPONENTS

Components and containers are the entities, which enable various data and contents to be freely combined within a RagTime document. Insight into their interaction is essential when working with RagTime.

“Component” is the collective term for important content modules of RagTime documents, like, for example, a text, picture or spreadsheet. Components do, however, also have design functions: the components layout and the master layout form the basis for the arrangement of further components in the document.

RagTime makes use of numerous different component types. Some components can be created and extensively edited with RagTime (e.g. text and spreadsheet), other components can only be imported into RagTime and either never changed at all or only changed slightly (like, for example, pictures and sounds). Some components will probably be used frequently in RagTime (e.g. the layout, text or picture components), others (like button or sound components) are used for more special tasks. All component types can be inserted into a document as often as required. Here is an overview of the individual components:

- Text can be written in a container or also in a separate window and then edited and thus **text components** are created. RagTime boasts numerous tools for the formatting and designing of text. Alongside the settings for the font, font size and other typographical parameters, there also various ways of typesetting columns and working with baseline grids, footnotes and paragraph numbering. You can insert other components like, for example, pictures into text components – even if this isn’t a typical method of application.
• **Spreadsheet Components** offer opportunities comparable to text components: they can be created and edited in containers or separate windows. Numerous different functions and tools are available for working with spreadsheets. You can enter, calculate and sort data, specify rows and column headings, unhide and hide elements in the spreadsheet and naturally also make use of numerous design possibilities for the spreadsheet. In the cells of a spreadsheet you can install other components or also further spreadsheet components.

• **Graph Components** can be created in RagTime from a gallery (Fig. 1 [p. 26]) with various prepared diagram and row types. Fig. 1: RagTime’s gallery provides various pre-formatted diagram and row types, which therefore enable you to easily find the best representation for your data.

You can manually supply the necessary data or otherwise link the graph up with a spreadsheet component. Specialized tools and commands can be used to modify the graph. They influence all parameters ranging from the legend to the alignment and shading and from dimension settings to the representation of the axes.

• **A Drawing Component** has a large surface theoretically measuring a few square meters which you can draw on. RagTime drawings are, for example, suitable for the representation of organization charts and such like. In practice it has, however, been proven that drawing components for illustrations should first be created in a sepa-
2.2: The Concepts behind RagTime

rate window and then placed in a document in their intended location. As with the previously mentioned components, drawing components can also be created and changed with RagTime. Drawing objects can furthermore serve as so-called containers for other components and thus play an important role in the layout of documents.

- The layout component and the closely related master layout component have taken on an exceptional position within RagTime. They are responsible for constituting document pages and form the basis for the arrangement of other components within documents. Though it is in fact also possible to install components in text or spreadsheet components, in day-to-day work with RagTime it is usually the layout or master layout components, which form the basis of a document and its design.

Out of all components, the layout and master layout are most similar to something we would describe as a “page”, and also have a similar function: you can imagine the other components as elements of a collage, which are arranged on the layout page and RagTime’s tools, commands and functions as a “range of tools”, which are used to create the collage.

Page Representation and Print Pages

By the way, the pages that are displayed in RagTime when you work with layout or master layout components correspond exactly to the subsequently printed pages. The properties of the printer, which is defined in your system as the default printer, are taken into consideration in the representation. Therefore you will always be able to view your subsequent print results while creating the document – thus making a separate print preview unnecessary in RagTime!

In WINDOWS ➔ SHOW you will find the commands to hide any notes in the page representation, which may assist you in your work and orientation guides; these are then omitted in the printout of the document. This way you get an even better impression of the subsequent printed page.

- Picture Components like, for example, photos inserted into a document, are not generated by RagTime, but are imported into RagTime from other sources whereby you can drag pictures into RagTime from the pool of pictures on your hard disk or import them directly from a
scanner or digital camera. The editing functions for picture components mainly refer to the size, position and print. Grayscale pictures can be colored.

- **Sound Components (Sounds)** can be imported in RagTime and inserted into documents – similar to pictures. With the appropriate hardware and software equipment, you can also record with RagTime. Sound components can always only be edited in combination with a document page and not in a separate window.

- Interactive elements like buttons, checkboxes, drop-down lists or radio buttons are referred to as **button components (buttons)** in RagTime. Button components are mainly designed to assist you in your work. They can be linked to frequently used formulas and commands and then serve to automate documents. This lends itself especially if you are working with master layouts (see above) or forms, i.e. you want to use a document more than once. A typical application is, for example, to trigger calculations “at the push of a button” in spreadsheet components. Here (Fig. 3 [p. 31]) a button component entitled **Pop-up Menu** is used at the top of the document. The synopsis can therefore be easily personalized for various senders: the setting in the pop-up menu influences the sender name further down in the document. Button components are not usually printed with the document.

### 2.2.4 ESSENTIAL FOR THE LAYOUT: CONTAINER

--- **Sample Documents:** You can use the file Short Synopsis.rtd from the training folder to check out a typical RagTime document with a layout component, containers and other content components in more detail. The same document can also be seen in the pictures Fig. 2 [p. 30] and Fig. 3 [p. 31].

Many of the more important component types can also be created, changed and saved as a separate document without layout components. A layout and master layout component is, however, usually used for attractively designed documents and for combining numerous component types within one document. Containers are also required to insert, arrange and design other components within the document. “Containers” are used as receptacles for components. Or, to be more precise, containers are frames, which indicate the locations, in which further components could be installed within a layout component.

--- **Spreadsheet Exception:** The cells of a spreadsheet automatically
adopt container properties and can easily incorporate other components.

You can create containers in every part of a document, optionally change their size and position and fill them with various contents. Containers and components can be arbitrarily nested, thus creating documents of varied complexity. When designing documents each container can be given properties individually. It is, however, possible to apply commands to all containers synchronously. Document services like checking spelling or the command Search and Replace, as well as formatting commands and style sheets for certain font, paragraph, line and fill styles can be applied to the whole document. Furthermore, containers can be connected via so-called pipelines, which greatly facilitates the balanced distribution of contents to numerous containers. This way a longer text simply flows through the pipeline and on to the next container, if there is not enough room in the first container for all the characters to be displayed.

Representation of Containers on the Screen: The container borders are always displayed by default in RagTime. If you should miss seeing them, check out Windows → Show. A tick should be placed alongside the menu command Nonprinting Items, then the “boxes” are once again displayed. A blue hairline is provided by default for the representation of the containers – this can also be seen in the sample file Short Synopsis.rtd. Other representational modes can, however, be set, if required. This could, therefore, mean that you encounter RagTime documents where the container borders have a different appearance than they usually do.

2.2.5 START ANYWHERE

The integration principle, which is facilitated by components and containers, allows for tables and text, calculations and pictures, diagrams and drawings and other components to be used simultaneously and on almost an equal footing in a RagTime document. With so much flexibility, you have also got an almost free choice as to how to start a new RagTime document, because the diverse contents of a document (the various components) are, after all, not fixed to various file formats.

You can start a document with a layout component and install the required components in the container. In this case you then work page oriented, because a layout component always also constitutes a document page. This is an extremely conventional way of working. It is rec-
This lovely Victorian house is situated in a quiet and friendly area next to Cressingham Park and ten minutes from the City Centre.

Downstairs: good sized living room, dining room and kitchen with all mod-cons.

Upstairs: three spacious bed rooms, bath room and separate toilet.

The property is fitted with central heating and double glazing and has very attractive and well maintained gardens at front and back.

<table>
<thead>
<tr>
<th>mortgage example</th>
<th>State 1/07</th>
</tr>
</thead>
<tbody>
<tr>
<td>price</td>
<td>$220,000,00</td>
</tr>
<tr>
<td>duration</td>
<td>(180 months) 15 years</td>
</tr>
<tr>
<td>monthly payments</td>
<td>$1,373,78</td>
</tr>
<tr>
<td>total price + APR</td>
<td>$247,280,00</td>
</tr>
</tbody>
</table>

Offer is subject to contract
2.2: The Concepts behind RagTime

Fig. 3: ... reveals this framework in RagTime. The layout component is presented as a “sheet of paper” with a numbered tag. The rectangles represented with fine blue lines are the containers and their contents are the components installed within (here you can see text, picture and spreadsheet).
ommended for newcomers, because the page logic is easily comprehensible. It is also easier to maintain an overview. It is not compulsory to proceed in this manner. With the exception of the sound and button components, you can start a document with any component you want (use the Foyer for this (see Retrieving and Creating Files: The RagTime Foyer [p. 43])). You can also subsequently add a layout component to a document and insert already existing components here.

### 2.2.6 DATA IMPORT, DATA EXPORT

The restriction to one work file format (“.rtd”) – with the format “.rtt” for the special case “Stationery Pad” – does not, however, signify that there is a RagTime monoculture. RagTime offers numerous opportunities for file or data exchanges with other programs. To insert foreign files into RagTime, you can either use the ubiquitous “Drag and Drop” working technique with the mouse, copy and paste with the Clipboard, the menu command IMPORT or directly import from a scanner or camera. Specialized PDF and HTML exports and the command EXPORT are available to you in order to be able to utilize RagTime files for other applications.

The possibilities for data import and export in detail:

- You can export RagTime documents as a PDF or HTML file. The required commands EXPORT PDF and EXPORT HTML can be found in the menu FILE.
- All established picture file formats like TIFF, EPS, BMP, JPEG, PICT, PNG, EMF or WMF can be integrated into RagTime documents (by using Drag and Drop or the Clipboard). It is also possible to directly import pictures from scanners or digital cameras (Menu FILE → SCANNER AND CAMERAS).
- Microsoft Excel Tables can be easily imported whereby you can choose whether you only want to convert formulas or formats or both (Command FILE → IMPORT).
- Documents from Microsoft Word can also be imported into RagTime. You can determine how the existing formatting should be handled.
- Access to existing data bases is possible by means of extensions, which can be additionally installed.
RagTime User Interface

The illustrations and explanations in the training manual refer to the RagTime default settings. The explanations are easier to follow if you do not change these settings yet!

The RagTime user interface is flexible. The program automatically offers the tools you require in the current working environment – depending on which component and element is presently active. Users can also adapt the RagTime interface to suit their own working methods. The basic set-up of the user interface does, however, remain the same at all times, so that you can quickly familiarize yourself with the tool you are working with.

Reset RagTime User Interface

You have carried out changes to the user interface and would like to restore “Initial Settings”. The quickest way is by deleting the files, in which RagTime stores the information on the user interface settings.

These are the files `RagTime settings.xml` and `RagTime settings.ini`, which can be found in the folder `Application Data\RagTime`. The location of the folder `Application Data` can vary according to where RagTime is installed. In standard installation it is located in `C:\Documents and Settings\⟨Your User Name⟩\`.

Tip: The folder `Application Data` is hidden by default. You have to display this hidden document (i.e. using desktop folder options) in order to carry out any changes.

These are the documents `RagTime settings.xml` and `RagTime settings.ini` in the folder `~/Library/Preferences/RagTime/`, abbreviated spelling: `~/Library/Preferences/RagTime/

Your individual settings are removed next time RagTime is opened. You can set new individual settings at any time.
3.1.1 MENUS, BARS AND PALETTES IN WINDOWS

Even if it can be changed, the most important elements in the user interface always remain the same. At a glance (compare Fig. 4 [p. 35]):

![Fig. 4: The RagTime user interface in Windows with a layout component containing a still empty text container.](image)

- The program title bar is located at the top of the window 1. This tells you which of your opened documents is currently active. It can be good for orientation purposes, if you are editing numerous RagTime documents at the same time. RagTime windows also feature buttons typical for the operating system, which are used for minimizing, maximizing and closing documents or programs.
- Underneath you will find the menu bar 3. In the menus and submenus you will find the most important commands required for working with RagTime. This screenshot shows an example of the menu WINDOWS 4 with the opened submenu PALETTES.
- Many popular menu commands are also available in Context Menus for faster access and can be activated by right-clicking. Context menus are context sensitive – just carry out a few trial runs in various work situations to find them.
- Underneath the menu bar you will find bars with various tools. The bars shown in the screenshot BASIC COMMANDS and TOOL BAR (5 and 6, partially covered) are always displayed by default, because they are required so frequently. The tool bar, in particular, adapts to the current working situation and can display completely differ-
ent tools. Sometimes individual tools or whole tool bars are inactive (light gray appearance), if the application of the appropriate commands is not sensible or possible in the current working situation. You will find out more about the individual tools in the exercise section!

- If you are not sure about the function of a tool, move the mouse to the appropriate button. A small “Info Banner” (Tool Tip) appears. You can receive detailed information by activating the command INFO → WHAT’S THIS? and then clicking the tool button you would like to know more about. Short function tips are also displayed in the bottom part of the program window 7.

- In the bottom of the picture, floating in the user interface, is (Fig. 4 [p. 35]) a palette 8. Palettes have to be specially displayed – see below for more info.

  Palettes are important for smooth-running working procedures. They can be accessed via WINDOWS → PALETTES if necessary and placed in a position of your choice on the user interface as a floating window. Palettes contain combinations of tools and commands for various tasks for easy access. Many of these commands can also be found in the menus, but it is, however, often much quicker working with palettes. You can easily close a palette again if you no longer need it and thus make space on your user interface.

  Some submenus are actually really palettes, too. By tearing off the submenu with the mouse (Fig. 5 [p. 37] and Fig. 6 [p. 37]) you can release the palette from the menu and place it on the user interface. Here you can further adjust the palette:

  - You can click on the title bar of a palette and move it back and fore.
  - You can change the size of the palette by dragging the bottom right corner.
  - In Windows, palettes also have the characteristic of being able to magnetically adhere to the edges of the program window and thus change their shape. A palette can therefore be positioned as a “tool bar”, for example, underneath the menu bar or float as a small window somewhere on the user interface.
  - The most recently used palette constellation is reactivated when you restart the program.
3.1: RagTime User Interface

Fig. 5: Most submenus can be dragged out of the menu and then deposited as a palette.

Fig. 6: The former submenu PARAGRAPH STYLE SHEET as a floating palette.
3.1.2 Menus, Bars and Palettes in Mac OS

Even if it’s flexible, the main elements of the user interface do, however, remain the same. At a glance (compare Fig. 7 [p. 38]):

Fig. 7: The RagTime user interface with a layout component containing a still empty text container.

- The menu bar is located at the top of the screen 1. You probably already know the first three menus, File and Edit, from other programs, alongside these menus you will find RagTime-specific menus. The screenshot shows an example of the contents of the menu Windows 2 with the open submenu Palettes.
- Many popular menu commands are also available in Context Menus for faster access, which can be activated by clicking [ctrl] or, if available, by activating the right mouse button. Context menus are context sensitive – just carry out a few trial runs in various work situations to try and find them.
- The tool bar is located underneath the menu bar by default 3 and features the most important functions. Other tools appear here depending on which component or element is presently active.
- The document title bar 4 contains information on the file name and format as well as the buttons typical for the operating system for closing, minimizing and maximizing the window.
- Floating on the user interface at the bottom of the screenshot is a
3.1: RagTime User Interface

(Fig. 7 [p. 38]) palette 5. Palettes have to be specially displayed – see below for more info.

• If you are not sure about the function of a tool, move the mouse to the appropriate button. A small “info banner” (Tool Tip) appears. You can receive detailed information, if you additionally press 3.

Palettes are important for smooth-running working procedures. They can be accessed via Windows → Palettes if necessary and placed in a position of your choice on the user interface as a floating window. Palettes contain combinations of tools and commands for easy access to various tasks. Many of these commands can also be found in the menus, but it is, however, often much quicker working with the palettes. You can easily close a palette again if you no longer need it and thus make space on your user interface.

Some submenus are actually really palettes, too. By tearing off the submenu with the mouse (Fig. 8 [p. 39]) you can release the palette from the menu and place it on the user interface. Here you can further adjust the palette:

![Image of a palette](image.png)

**Fig. 8:** Tearing off of the submenu so that it can be used as a palette.

• You can click on the title bar of a palette and move it back and fore.
• You can change the size of the palette by dragging the bottom right corner.
• In Mac OS there is a palette dock, which actually floats over the user interface as a palette itself. Click the green button in a palette title...
to place the palette in the palette dock. It still moves to the palette
dock though, even if a new window has been opened and the palette
is in the way. The palette dock cannot be found on any menu. It is
automatically opened and populated by RagTime, if required. Click-
ing on the name of a palette in the palette dock reopens it.

Fig. 9: The palette dock serves as a space-saving interim storage facility.

- The most recently used palette constellation is reactivated when you
  restart the program.

### 3.1.3 ALL COMPONENTS AT A GLANCE: THE INVENTORY

You already know that components are an important entity within
RagTime Documents. Components are the actual document contents.
The layout and master layout components are the almost indispensable
basis for document design. Together with containers, the arrangement
of the various components is relevant to the appearance of the documents.
The inventory is essential in order to administer components and racion-
ally edit them.

You gain fastest access to the inventory if you click on the “Squir-
rel” button in the tool bar; you can alternatively use the command
**Windows → Palettes → Inventory (⏭) or Windows → Open Inventory
(⤢).** The inventory window is slightly different in Windows and Mac OS.

In Windows, the inventory lists of all opened documents are listed
in a window. The inventory window displays the various document
names including all components of the appropriate document in
alphabetical order (☞ Fig. 10 [p. 41]). Folders can also be created for
components within the inventory. The inventory therefore also gives
you an overview in extensive documents.

Mac OS has a separate inventory window for every opened docu-
ment. All components of the document are listed in alphabetical
order in the appropriate inventory window. Folders for components
Fig. 10: Inventory in Windows: Here you can see the inventory window, in which all components used in the various currently opened documents are listed. The button for creating component folders can be seen above.

can also be created within an inventory. The inventory therefore also gives you an overview of extensive documents.

Double-clicking on one of the component titles in the inventory opens that component in a separate editing window. Sometimes it is more comfortable to edit a component separately within the context of the entire layout. You can use the mouse to drag components into the container from the inventory – for example, to reuse an already existing component in another location in a document – or to copy it into other documents.
Alongside components, the inventory also includes all auxiliaries (e. g. measurements) and formatting style sheets of a document.

→ **Auxiliaries in the menu:** You can also access the settings to style sheets and other auxiliaries via WINDOWS → AUXILIARIES.

→ **For further reading:** You can find out more about style sheets in ➤ Effective Formatting with Style Sheets [p. 23] ➤ Create Character Style Sheets for Formatting [p. 126].
3.2 **BECOMING FAMILIAR WITH FILES**

Open files, browse the hard drive for a specific folder, save and close files – the commands in the menu *File* and a whole host of buttons in the basic command bar are available in RagTime to carry out these procedures. Furthermore, the Foyer provides an effective “Management Center”, which saves you many clicks and tedious and lengthy navigation within the folder system of your computer.

3.2.1 **RETRIEVING AND CREATING FILES: THE RAGTIME FOYER**

The Foyer is automatically opened when you start RagTime.

You can also open the Foyer independently of running the program. For this simply click on the button in the tool bar.

The Foyer is a dialog box where you can quickly create new documents, reopen recently used documents or quickly access certain folders on your computer. The menu item *File* also contains all important commands for opening, saving and creating files – but the Foyer is often just more manageable and easier to use.

Which functions does the Foyer provide (Fig. 12 [p. 43])?

![RagTime Foyer](image)

*Fig. 12:* The Foyer is an easy-to-operate control center for locating already saved documents and creating new files.
Chapter 3: RagTime-Basic Knowledge

- The panelFavoritesincorporates the most important ways of creating new and opening existing data for quick access. In Favoritesyou can place your most frequently used functions. Other functions which are not used as frequently can be accessed in another location in the foyer! In a new RagTime installation three different components are initially included in the section New Document Beginning with Component. You can create separate lists of frequently used documents or stationery pads, in the Open Document and Tear off from Stationery sections. Recently used RagTime documents are automatically entered in Open Recently Used Document.

- In New Beginning With, all commands which can be used to start a new document with a specific component, are once again assembled.

- Recent Documents lists all of your recently used files – the most recent six are listed by default. This amount can be increased.

- The panel Samples is a service available to you. It contains various completed RagTime files for demonstration purposes, which show you what can be done when using RagTime or which can be used and modified for your own needs. You can also access training files to accompany the chapters of this book in □Training.

\[
\text{Adjust Foyer}
\]

You have various opportunities of adjusting the properties in the Foyer. One thing does, however, apply to all changes in the Foyer: you do not delete or move these files themselves, but only modify them and their arrangement within the Foyer.

- Use the yellow i button to access a dialog box, in which you can set all general properties of the Foyer. You can also carry out changes in the settings for some of the panels like Favorites or Samples this way (what is displayed, where is the sample folder and such like).

- A click on the plus and minus symbol either adds new panels to the Foyer or removes – after a short safety check – the appropriately active (top) panel.

- Further setting opportunities are often also hidden in the context menus for individual elements in the Foyer. In the panel Favorites you can, for example, add to or remove the components listed in New Document Beginning with Component. For this you should first access one of the context menus. You
3.2: BECOMING FAMILIAR WITH FILES

3.2.1 SHOWING OR HIDING COMPONENTS

can show or hide the individual components in the Foyer by activating Show; Set as Default definitely shortens the way to your “Favorite Component” or also a specific form (i.e. a document template). Whatever you set as default here is given its own button within the Foyer. The setting “Layout Component as Standard” does, however, usually prove itself as being very well in practice.

3.2.2 FOREIGN FILE FORMATS: IMPORTING FILES

As mentioned, you can also import information from file formats, which are foreign to RagTime, into RagTime documents by activating the import command and thus continue to use such information productively. The command Import in the File menu opens a dialog box, which can be used to navigate to the file that should be imported. In the dialog box you can also learn about which file formats RagTime is able to import Fig. 13 [p. 46]).

The import dialog box does not raise many questions otherwise. You should take note of the option Linked to File. This causes subsequent alterations to the original file to be accepted in the import (e.g. the RagTime document). For picture files you can also specify whether actually the whole picture should be completely saved in the document (COMPLETE DATA IN THE DOCUMENT) or whether only the picture component required for the document view is saved in the document (ONLY SCREEN REPRESENTATION IN DOCUMENT). Importing files with this option creates “slimmer” files, but also, however, requires that the original file is available for reloading, if the picture should be represented in another size or printed.

3.2.3 SAVING FILES

In RagTime there are two different commands for saving files in the File menu.

- SAVE DOCUMENT: This command saves the current version of the currently active document. It is perfect for intermediate saving. If the document has never been saved before then SAVE AS will automatically be accessed.
- SAVE AS opens a dialog box, which enables you to specify where to save the file as well as the file name and file type (normal document
Fig. 13: In the IMPORT dialog box you will find a pop-up menu (FILE TYPE, ENABLE) with importable file types – you can select from various file types.

or stationery pad). This command is also suitable for creating copies of a file. In the save dialog box you can then specify whether you would like to continue working with the new (i.e. saved as a separate document under a separate name) or present document.

### 3.2.4 PRINTING FILES

To reproduce a document on the desktop printer at the office or at home, select PRINT in the FILE menu. The dialog box which you will then see depends mainly on the printer you have installed and should not cause you any problems.

The command PRINT ONCE in the FILE menu prints the document without asking any further questions with the most recently used settings, the print dialog box is not even displayed. If you have never printed anything off RagTime, the command will not work – as there are no settings to access.

What influences the printing results: Numerous document settings
have an influence on the printing results (i.e. currently set paper format, filling of lines, special print settings for picture components, special representation options...). You can find an overview on all this in ➔ About Printing [RagTime Reference].

➔ For further reading: In ➔ RagTime Documents as PDF or HTML File [p. 241] the preparation of files for printing is explained in detail. Here you can also find out how to output your RagTime document as an HTML-page.

Further printing tips can be appropriately found in the practice exercises in ➔ Quick Introduction: Tools, Functions, Working Methods [p. 49].

3.2.5 CLOSING FILES

This command does not have to be explained in great detail. It is worth emphasizing the fact that there are numerous variations on this command in RagTime:

- **Close Document** closes (as you might expect) the active document.
- **Close** helps you if numerous windows in one document or multiple documents are open at the same time. The command only closes the appropriate front window. The complete document is closed if you have only opened one document window.
- **Quit** quits the program.

➔ **Safety check:** If you have changed a file, but not saved it, you will be asked by RagTime whether you want to accept the changes prior to the closing of the file or the program.
Quick Introduction: Tools, Functions, Working Methods
4.1 EXERCISE 1: FLEXIBLE LAYOUT WITH TEXT AND PICTURES: GREETING CARD

Your first practical exercise with RagTime makes you familiar with one of the most important tools – containers. You will draw containers and learn to change their size and position. You’ll get to know a couple of tricks for aligning containers in a layout component and find out how to create many identical containers in a time-saving manner. We will then show you how to put pictures into containers. And you’ll learn various methods for creating new layout components and get to know Graphical Text, which is especially suitable for short text excerpts.

Fig. 14: You’ll get to know about the most important RagTime working methods by using this simple composition.

Voyages | Reisen | Journeys | Viaggi | Reizen | Viagens

STEP BY STEP

Begin File with Layout Component

After starting up the program, RagTime welcomes you by presenting an open Foyer environment, a blank user interface is usually located behind the Foyer. If you want to create a new document, you have to decide which component type you would like to start using. Your selection depends on the type of information the document should initially comprise. You will subsequently be able to extend a RagTime document in different directions whenever you want to add further components or to insert it
into another document, thus allowing for flexible integrated layouts.

For further reading: Find out more about properties and the scope of services of the individual component types in the chapter Contents with Varied Elements: Components [p. 25].

Technically, a new document can be created using every component type that can be independently edited (layout, master layout, text, spreadsheet, picture, graph or drawing). In many cases layout components are, however, often used as the basis of new documents. They are especially tailored to incorporate all kinds of further components. A document beginning as a layout, effectively acts as an assembling table, on which other document components can be arranged.

Due to the frequent usage of layout components for new documents, there are many different ways of getting started. Decide on one of these methods and create a new file.

- In the Foyer you should also find the Layout button in the New Beginning With panel.
- There is also a button entitled Create Document with Layout on the bottom margin of the Foyer.
- You can use the menu command Create Document with Layout in the File menu.
- In the Basic Commands tool bar you will find a button, which begins a new document with a new layout component (it looks like a blank piece of paper).

Other Components Set as Default for Document Generation

The Create Document with Layout function appears so often on the user interface, because it is set as a default preference in RagTime. If you prefer to begin most new files with other component types in future, you can change this preference in the Foyer. For this, you need to access the context menu for the component, which you would like to specify as the default for new files, in the New Beginning With panel and click on Set as Default (Fig. 15 [p. 52]). The setting influences the tool bar button, the additional button in the Foyer and the entry in the File menu.
Fig. 15: New documents don’t have to begin with layout components: specify the default component type of your choice in the Foyer for document generation.

**Delete Default Container**

The new layout component is not completely empty. On the white “sheet of paper” you can see a light gray frame and a rectangle represented with a fine blue line. The gray frame displays the non-printable area of the layout page. Its size depends on the printer you have installed. The fine blue rectangle contains a predefined text component. This text container is automatically supplied by RagTime, because one of the most popular working procedures is, after all, the insertion of text in layout components.

The default container is not required in this exercise. To delete the container, you’ll first have to select it. For this you have to click precisely on the outline of the rectangle. Small, black squares on the outline then indicate that the container can be edited. To delete, simply press (Z) or (Del).

**Specify Page Format**

The objective of this exercise is to create a greeting card. The preset page format, A4, is too big for this purpose, which is why the page format has to be altered. A somewhat smaller landscape format is more suitable!
4.1: Exercise 1: Greeting Card with Text and Pictures

Fig. 16: The new layout component with the default settings.

Fig. 17: It’s worth having a really good look! The changing mouse cursor shapes provide excellent orientation when working with drawing objects. If the mouse cursor is correctly positioned over the outline, then it becomes a large “X” with arrow tips.

To change the page format you need to select the command FILE \(\rightarrow\) PAGE FORMAT and specify a suitable size in PAGE AND PAPER MEASUREMENTS.

You can zoom into a document to view any details more clearly, or also zoom out to be able to have a complete overview of the whole document. To change the display scale you may either use the commands in WINDOWS \(\rightarrow\) DISPLAY SCALE (here you will also find the useful command FIT TO WINDOW!) or one of
the small buttons on the bottom left margin of the document window.

**Show Grid, Draw First Container**

Now you should add your first own container. You can either work according to your own visual judgment, or unhide the grid lines for more accuracy via Windows → Rulers and Grids → Show Grid.

---

**Using Grid Lines**

**Change Units of Measurement:** The sizes of drawn objects are usually displayed by RagTime in centimeters. If you, however, change the unit of measurement in Ruler and Grid Settings found in Windows → Rulers and Grids, then this will also have an impact on the grid, the representation of the rulers, the size display when drawing and the preset unit of measurement in some entry fields of the dialog boxes.

**Snap to Grid:** In Windows → Rulers and Grids you will also find the command Snap to Grid. Snap to grid causes drawn objects to precisely align to the grid lines – and in fact only to these grid lines. This grid property does, however, sometimes result in difficulties, because it is not possible to position objects between magnetic grid lines. To switch off the magnetic function of the grid, simply remove the tick from the command Snap to Grid in the menu. Make sure that you do not inadvertently switch on the magnetic grid without making it visible!
Drawing containers is no different to drawing objects. You use the same tools and procedures – further procedures then determine whether a graphics object or a container, which can then incorporate other components, is created.

You work with a drawing tool, the Rectangle tool. Access this tool by clicking on it in the tool bar.

You can draw a rectangle by holding down the left mouse button. The current size of the rectangle is displayed on the mouse cursor (Fig. 20 [p. 56]). You do not have to be completely precise when doing this exercise. It is sufficient to draw a portrait format based on visual judgment; whereby three such portrait formats will subsequently be able to fit side by side on the “page”. The rectangles for the example (Fig. 14 [p. 50]) are $4 \times 5.5$ cm in size. The first rectangle is completed as soon as you release the mouse.

**Drawing Circles and Squares**

If you want to draw an exact square, hold down $\text{⇧}$ when dragging the rectangle in order to create an object with sides of the same length. This keyboard command also works in combination with
many other tools, such as, for example, if you want to draw exact circles with the Oval tool.

Fig. 20: Move the cross-shaped mouse cursor diagonally over the page to draw rectangles or other drawing objects.

**Switching Between Tools**

For the other two rectangles yet to be drawn, you once again require the Rectangle tool. Even if this was the tool you used most recently, you still have to click on it in the tool bar. It does not remain active, because RagTime always automatically reverts back to the Arrow tool after other tools have been used. If you want to use a different tool to the Arrow tool, then you need to reactivate it. You have various options to do this:

- Click on the required tool in the tool bar.
- Clicking `ctrl` (⌘) or `Esc` (_esc_) reactivates the most recently used tool.
- If you want to use a drawing tool in quick succession, you should either hold down `ctrl` (⌘) or `Esc` (_esc_) while clicking to begin drawing the next object.

Have you completely lost the drawing tools? If so, then you have most probably clicked on the gray interface in the meantime. A
click on the tool box or in a neutral part of your “paper page” immediately unhides the tools again.

**Adjust Rectangle**

When you draw the second rectangle, you probably won’t be able to get the required size and position at first go. That’s not a problem: subsequent adjustments to the size, position, proportions or even rotation of the drawing objects can be easily made. For this you need to **select** the rectangle that you want to edit, if you have not already done this.

---

**Further Tricks for Selection:** You can also select numerous objects at one time in order to then, for example, collectively move or delete them. For this you must hold down ⌘ when selecting (clicking on) the drawing objects. By clicking on the empty section of the page or interface, all document are deselected. Using ⌘ to click on the outline deselects individual drawing objects from a group of selected objects.

The small squares on the outlines and the dot in the middle of a drawing object not only show that this object has been selected, but they are also “handles”, with which the drawing object can be changed. The small squares are used to change the **object size**. They act as “move handles”, which you can click on and drag with the mouse.

- Clicking on and dragging the handles on the sides of the rectangle allows you to increase or reduce either the width or height of the object ✷ Fig. 21 [p. 57].

![Fig. 21: The size of the rectangle is reduced.](image)

- Clicking on the corner handles allows you to modify the width and height of drawn objects at the same time ✷ Fig. 22 [p. 58].
- If you hold down ⌘ when dragging on the corner handles, the original proportions of the object will be maintained ✷ Fig. 23 [p. 58].
Fig. 22: Increasing the size of the rectangle while maintaining the original proportions.

Fig. 23: This rectangle is just being widened.

For our example you should follow these instructions to create a rectangle with approximately the same measurements as the first object you have drawn. To be able to then change the **object position**, you should make use of the tried-and-tested Drag and Drop principle. Simply click on the area of the already activated object. The mouse cursor is initially the well-known large “X” with arrows (Fig. 24 [p. 59]). Hold down the mouse button and drag the object in the required direction. The mouse cursor turns into an arrow with a miniature rectangle, a second, black object outline appears and displays the new position (Fig. 25 [p. 59]). The object is in its new position as soon as you release the mouse cursor (Fig. 26 [p. 59]).
4.1: Exercise 1: Greeting Card with Text and Pictures

**Fig. 24:** The rectangle can now be moved.

**Fig. 25:** The object outline also moves when the object is being moved. The mouse cursor changes.

**Fig. 26:** The object moves into its new position when you release the mouse button.
Positioning objects is often all about accuracy.

- To precisely move objects vertically or horizontally, you do not need to do any precise mouse work. Simply press \( \text{shift} \) when moving the object. This button restricts the movement to a vertical or horizontal direction. The sequence, in which you press the mouse and additional button, is, however, extremely important: click “first” with the mouse and “then” \( \text{shift} \). Otherwise you will only cancel the selection of the object with \( \text{shift} \)!

- You can work more precisely than with the mouse if you move a highlighted object with the arrow keys on your keyboard.

- You can move multiple drawing objects at the same time.

**Undo Steps**

If an editing step has gone wrong you can undo it with \( \text{ctrl} + \text{Z} \) (\( \text{Z} \)) or \( \text{c} - \text{Z} \) (\( \text{z} \)). This is not only the case for changing drawings, but for when you are working with RagTime in general.

**Create Duplicate of Drawing Object**

Duplicates are an especially quick way of creating “identical” copies of existing drawing objects. You should try out this working method on the third rectangle, which you have still yet to draw. RagTime once again offers numerous approaches:

- The menu command **EDIT \( \rightarrow \) DUPLICATE** immediately creates a copy of the drawing object you have previously selected. You can then drag the duplicate into the required position with the mouse.
- The keyboard shortcut \( \text{ctrl} + \text{D} \) (\( \text{D} \)) or \( \text{c} - \text{D} \) (\( \text{z} \)) works in exactly the same way.
- You can, however, also work directly with the mouse. You should in turn initially select the drawing object, first press the mouse button and then additionally \( \text{ctrl} \) (\( \text{D} \)) or \( \text{c} \) (\( \text{z} \)). Then drag the original object with the mouse: a duplicate is created. You can position it in a place of your choice.

You can use already familiar commands and functions to move such duplicates. There are also numerous special functions for the uniform and straight alignment of numerous duplicates.
• If you duplicate and move a drawing object, RagTime remembers the route and direction of the movement. If you were to create another copy from the duplicate, this would be moved by exactly the same amount and in exactly the same direction as the first copy. This does, however, only work if you have not selected any further objects or carried out further working procedures in the meantime!

• Select the object, keep pressing the mouse button and press in order to move a duplicate exactly vertically or horizontally to the initial object.

• If you want to string a whole chain of the same objects at an equal distance to each other, then you can set their distance to the millimeter in Extras → Basic Settings and then in the Drawing panel. In Duplication Offset you can set horizontal and vertical offset. The distance is always relative to the most recently created duplicate. If you, for example, create a duplicate by means of the keyboard shortcut, the recently inserted duplicates are automatically added at the previously set distance.

• The command Drawing → Arrange Objects offers you even more opportunities. It only works, however, if at least two objects have been selected.

Fig. 27: However you actually go about placing and aligning the containers, your exercise document should look something like this at some point in time.
Why not have a go getting to know RagTime’s drawing function, as drawing objects can be easily deleted. You’ll be needing it all the time – so it’s best to take the time to learn the working procedures and keyboard shortcuts now – this way you’ll make life much easier for yourself as a RagTime user in the future.

Drawing Objects as Containers: Add Pictures

The photos can be inserted when you have completed the three containers. Strictly speaking, the three rectangles arranged in the layout component are still drawing objects – and are not yet containers. To convert a drawing object to a picture container, you just have to insert a picture file. Drag and Drop works smoothly with RagTime and even cooperates with other programs. This means that the picture files can be dragged from of your file folder or your desktop directly into the drawing object where the picture should be installed.

Insert Files in Windows: The RagTime Training folder contains the sample pictures you need for this exercise. These are the following files: Hanguk.jpg, Roma.jpg and Potsdam.jpg.

Select Info → Example Files → Training → Open “Training” Folder. The Training folder is opened in the file browser. Align the program windows of your file browser so that you can simultaneously view the contents of the folder and the RagTime document. Click on the required file and drag it with the mouse over the drawing object. A gray marker shows that the picture can be positioned here (Fig. 28 [p. 63]). You can now release the mouse button.

Carry out the same procedure on all three containers to insert pictures.

If you then open the inventory (the shortest way is via the squirrel button!), you’ll see that three new picture components are listed here. The file names of the pictures have been used as the title for the components.

Inserting files in Mac OS: The RagTime Training folder contains the sample pictures you need for this exercise. These are the following files: Hanguk.jpg, Roma.jpg and Potsdam.jpg.

Select Help → Example Files → Training → Open “Training” Folder. The folder is opened in Finder. It contains all files you need for the exercises. Align the program window of your Finder so that you can simultaneously view the contents of the folder and the RagTime document. Click on the required file and drag it with the mouse over the drawing object. A gray marker shows that the pic-
Fig. 28: Transferring a picture file to a drawing object via drag and drop (Windows).

Fig. 29: Transferring a picture file into a drawing object via drag and drop (Mac OS).

Picture can be positioned here (Fig. 29 [p. 63]). You can now release the mouse button.
Carry out the same procedure on all three containers to insert the pictures.
If you then open the inventory (the shortest way is via the squirrel button!), you’ll see that three new picture components are now listed here. The file names of the pictures have been used as the title for the components.

**Changing Picture Size, Picture Position and Container Size**

In this exercise pictures should be smoothly adapted to fit the size of the container. This, however, doesn’t always work, because sometimes the proportions of the picture don’t correspond with the format of the container. In the tool bar you will find a whole host of functions in order to be able to move a picture within the container or to adapt it to fit the container.

In this case, you also have to have selected the object that you want to edit (i.e. the picture), then suitable tools will appear in the tool bar. Select a picture by clicking on it. Do not click on the sides of the picture, as otherwise you’ll select the picture container instead of the picture. A selected picture can be recognized by the animated dashed line ("Ant Line"), which surrounds it.

To move a picture within the container with the mouse, you need to use the Move Tool. The arrow keys (on the keyboard) also allow for movements to be made pixel by pixel.

Various buttons on the tool bar help you to automatically align pictures in containers. The position of the blue square on the respective button symbolises the position of the picture in the container.

Another way of fitting a picture to a container is to resize the picture ("Scale"). Activate the Scale Tool and move the mouse in the picture while holding down the mouse button. You are now able to “handle” the picture on the edges or corners and drag it to increase or reduce its size (see also pictures below).

Further commands to influence the relationship between the picture and container can also be found in the picture context menu and in the dialog box PICTURE INFORMATION (accessible via i button on the tool bar or in PICTURE → GET INFO).
4.1: Exercise 1: Greeting Card with Text and Pictures

Fig. 30: You can scale down the pictures with the Scale tool.

Fig. 31: You can also increase the size of the picture to go beyond the container borders.

Writing and Formatting Graphical Text

Apart from the text components, which have already been introduced in the introductory chapter, RagTime also offers a further opportunity of inserting text into files: so-called **Graphical Text**. Graphical Text is especially suitable for short texts, which probably do not have to be changed again. Graphical Text is not listed in the inventory. In extensive documents it can help reduce the size of the document. Graphical Text is typically suited to be used for elements like headings, footnotes or page numbers, but also the short text of the postcard in the exercise can also be nicely integrated into the document in this manner.
To insert Graphical Text, click on the Text tool in the tool palette.

The typography palette is automatically activated.

Show the typography palette via **Windows → Palettes → Typography**.

In the typography palette you can then change settings for font, font size or style. The example used a bold, 16 point “Times New Roman” font. Specify the settings and move the mouse to where you want to write.

The mouse cursor takes on the shape of this caret. Click on it and now write the text. The line should be approximately as wide as the three pictures.

Subsequent adjustments of a Graphical Text are possible at all times. You have to watch out slightly when selecting the text for adjustments. You have to proceed differently depending on whether you want to change the whole text or just parts of the text.

- **To subsequently format the complete text**, you have to click somewhere in the text. As soon as the “move handles” appear, you can specify the changes in the typography palette (**Fig. 32** [p. 66]).
- With the help of the position frame around the text block, you can also move the text (with the Arrow Tool) (**Fig. 33** [p. 67]).
- To change the **format of individual characters**, you should reactivate the Text tool and select the characters by mousing over them (**Fig. 34** [p. 67]).
- To change the **wording** of the text, you should reactivate the Text tool and click in the line of text. You can write when the cursor starts flashing (**Fig. 35** [p. 67]).

Your first RagTime file is completed when you have correctly positioned and formatted the Graphical Text. Now you only have to save it and print it off – if you want.

**Fig. 32**: Subsequently formatting the complete text.
Fig. 33: Moving Graphical Text.

Fig. 34: Selecting individual characters in Graphical Text for editing.

Fig. 35: Changing wording of text in Graphical Text.
4.2 EXERCISE 2: BUSINESS LETTER, PERFECT IN FORM AND WITH AUTOMATIC DATE GENERATION

The second exercise is already extremely practical: you will learn how to create a formally correct business letter with RagTime including letter head, address field, reference line and footer. The main focal points of the exercise are the application of a more complex layout structure comprising various elements and the generation of text. With the help of various containers you will construct the formal structure of the letter right down to the millimeter. You will fill the container with pictures and text and learn about how to format and align the font and how to work with tabs. And you will also apply a formula to automatically generate the date.

STEP BY STEP

Install New Layout Component
You should once again begin a new file with the layout component. The new layout component automatically has the A4 page format, which is required here.

⚠️ You need this or a similar letter for exercises 5 and 6 as well, so it’s best to save it immediately!

Adjust First Container
As shown in the first exercise, the first container is already available in a layout component generated according to this procedure. The content type is specified as TEXT. At the push of a button RagTime therefore delivers a “ready-to-write” document, in which you can immediately enter text. For the exercise letter you should, however, initially create and position all containers in order to specify the structure of the document. The text of the letter itself can be entered into the supplied text container at a later date, as this only requires minimum changes. The width can remain unchanged, but the height has to be reduced slightly at the top and bottom to make space for further layout elements. For this you should proceed as already described in exercise 1. Select the container and drag on the move handles with the mouse so that the container is approximately only half its original height and move it so that there is still enough room for the business details underneath.

Container for Address Field
You should then draw a container using the Rectangle tool, which has approximately the correct size and position for the recipient address. Leave
In the second exercise you will create a business letter that is suitable for everyday use.

This container selected. In the tool list you will find the setting CONTENT TYPE on the right. Here you can determine which component type is created. The current setting for your recently created container would have to be NO CONTENTS. A text component should be created, because the container is intended for recipient address entry. Open the list and select TEXT (Fig. 37 [p. 70]).
Chapter 4: Quick Introduction

Fig. 37: The menu in the tool bar serves to specify the content type. You can, however, also use it to check, to which content type a container is set; the current setting of a selected container is always displayed here.

Background Knowledge: Containers and Content Types

You have already seen that a drawn object is turned into a container by installing a component in it like, for example, when you drag a picture into a drawn rectangle.

There is also another way of turning drawing objects into containers, namely by specifying the content type. RagTime recognizes the following content types: picture, graph, button, spreadsheet, text, sound, drawing and “no contents” (the setting for drawing objects, to which no content type has as yet been applied).

There are various different ways of assigning a specific content type to containers. You can specify the content type before drawing the container or subsequently assign or change it. If you want to drag a component or file onto a drawing object, the content type is automatically set without your assistance.

As soon as the content type has been set for a drawing object, the content is regarded as a component – no matter whether it has been already filled or not. You can find out for yourself by checking out the component list in the inventory while you try out the setting Content Type.

In layouts with multiple drawing objects, which should be filled with various contents, it is definitely recommended that the content type is set prior to the filling of the containers. It is therefore easier to find orientation points.

Now the position and dimensions of the address field container have to be precisely set (the container should still be selected!). This time it is not sufficient to work according to your own visual judgement, because
the recipient address needs to accurately fit into the window of a paper envelope at a later date. You now need the INFORMATION dialog box. In this powerful dialog box you can control and change all the properties of the currently selected object.

The quickest way of accessing the information dialog box is by using the i button. The command DRAWING → GET INFO also accesses the dialog box. Double clicking on the container boundaries also accesses the information. Change over to the category COORDINATES in the information dialog box.

 OBJECT COORDINATES palette as an alternative: This palette contains mainly the same entry fields as the COORDINATES panel in the DRAWING INFORMATION dialog box. You can also work with the palette.

Fig. 38: The COORDINATES panel in the DRAWING INFORMATION dialog box. Transfer the dimensions of this picture to your own document, then you’ll receive an address field, which fits exactly into the window of an envelope (standard paper size) (assuming that the letter is correctly folded).

You only need to adjust the values in POSITION and SIZE on the COORDINATES panel, the rest sorts itself out. It’s best to work from the top to the bottom whereby you always have to look very closely: the
icons in POSITION (to the left you can see one of the two icon groups) are buttons, with which you can specify whether to edit the position of the left, right, top, bottom edge or middle of the container. The violet marker on the buttons stands for the respective edges. For the address field, the left and top edges have to be changed. First you have to click on the respective button before entering the values into the fields.

The container for the recipient address is the only one whose dimensions have to fit exactly. It is therefore recommended that you fix it so that it cannot be unintentionally moved. For this you should select the command EXTRAS -> PROTECTION -> FIXED or the setting FIXED in the category OBJECTS in the INFORMATION dialog box. You can easily recognize fixed objects, if you move the mouse in their proximity then the mouse cursor adopts the shape of a pin.

Create Remaining Containers
The next task is to position the sender letter head in the top right corner. For this you require two containers – one for the company name and the other for the logo. You can also already set the content type of a container prior to drawing the container. Click on the Rectangle tool and hold the mouse button down for a longer time period. The menu with the already familiar content types will then appear (Fig. 39 [p. 72]).

![Fig. 39: Setting content type of a drawing object prior to drawing.](image)

Select the required content type and then draw the container. Create both a text and picture component (Fig. 40 [p. 73]), which should be approximately arranged and positioned as shown in Fig. 36 [p. 69]. The filling comes later on!
Fig. 40: A picture component, in which no picture has yet been installed (“empty container” with PICTURE content type) is characterized by two diagonal lines (shaped like an X).

Using Guides

Guides are another useful “assistant” when it comes to drawing and the exact alignment of drawing objects and containers. Guides can be used in layout, master layout and drawing components (wherever the screen rulers are visible). Guides are “magnetic”: if, for example, you move a container near a guide, it will snap on the guide.

To create a guide, you just have to use the mouse to click on one of the rulers (the horizontal ruler for horizontal guides, the vertical ruler for vertical guides), keep pressing down the mouse button and then slowly drag the line which appears to the required position (Fig. 41 [p. 74]). The guide is dropped into position as soon as you release the mouse. You can read the position of the guide (calculated from the left or top margin) above the mouse cursor while dragging (Fig. 42 [p. 74]).

Double clicking on the guide opens a small dialog box (Fig. 43 [p. 75]), in which you can specify the exact position and color of the guide (if the guide is partially lying on a component, e.g. a layout container, make sure that you set the double click on the part of the guide that projects beyond the component). Renewed dragging with the mouse will also cause the position of a guide to change.

To delete a guide, simply drag it out of the document until the mouse cursor takes on the shape of a waste paper bin.

Guides can also be exactly positioned with the help of the GUIDES palette (to be found in WINDOWS -> PALETTE; ) all guides can also be deleted here in one go.

If you place one guide above and one guide to the left of the
fixed recipient address container in the sample business letter, then you can align other page elements to them and thus save the time-consuming process of having to set the margin distances in the DRAWING INFORMATION → COORDINATES dialog box or in the OBJECT COORDINATES palette.

Fig. 41: The guide is “dragged out” of the ruler.

Fig. 42: On the mouse cursor you can read the position (calculated according to the ruler zero point, which is usually on the left or top margin).

Two identical long, narrow containers now have to be created underneath the address field, in which the reference lines should be subsequently entered. The upper text component should contain “specific,
4.2: Exercise 2: Formal business letter with automatic date generation

fixed text” and the lower text component should contain the current details. Here you can once again work with the trick you have already learned in exercise 1: create a container, then duplicate it and move it.

The content type for both reference line containers is again Text. Have a go at subsequently changing the content type of the container. Activate the container by clicking on it and then select another content type in the bar with the Drawing tools (Fig. 37 [p. 70]).

Now all you need is one more container at the bottom of the page where you should subsequently enter the business details (address, bank details etc.). For this you can create a further duplicate of the narrow, long reference container and move it downwards or simply draw a new container. The content type here should again be Text.

Create Letterhead

You should now enter the graphics and the company name into the top right corner of both containers. For this you require the file Logo 1.tif from the Training folder as a picture. Continue exactly as already described in exercise 1 to insert the picture into the picture component.

Dragging pictures into the inventory: it is also possible to initially drag and drop pictures (and other components) into the inventory and to then divide them up between the containers in the document in a later step – this is also carried out using the drag and drop principle with the mouse. This is especially useful when a picture should be reproduced more than once in the document or if you have to distribute numerous pictures within an extensive document.

The company name should now be inserted into the text component next to the picture. For this you just have to click on the container and start writing. Pressing creates a line break. A new paragraph is simultaneously initiated with every manual line break. This detail is impor-
tant for the formatting of texts, because RagTime differentiates between character formats (which are assigned to individual characters) and paragraph formats (which can only be assigned to complete paragraphs).

→ **Character Formats** (like font, font size or style) can be individually assigned to each character. Technically speaking, a paragraph, sentence or word could therefore contain various different fonts. To assign a character format, the characters, which are to receive this format, should be previously selected by being “moused over”. The commands to assign character formats are easily accessed in the typography palette. Those who would prefer to work with the mouse, will find all commands in FORMAT. The dialog box CHARACTER FORMATS incorporates all important commands on five clearly laid-out panels.

Fig. 44: The inserted logo.

Fig. 45: The symbols of the Typography tools are clear enough; you can intuitively work with the typography palette (or bar).

→ **Paragraph Formats** (like, for example, alignment or line spacing) are applied one paragraph at a time and not to individual lines, sentences or words. Within a paragraph there cannot be numerous types of alignment or various line spacing settings. To assign a paragraph format to a paragraph, you just have to have previously placed the mouse cursor in the paragraph, i.e. clicked into the text once. To edit numerous paragraphs at the same time, they have to, however, be selected as well. The commands for paragraph formats can be found in the tool bar or in FORMAT. In FORMAT → PARAGRAPH FORMATS you will in turn find the most important commands in a handy synopsis.
Fig. 46: Settings for line spacing, text alignment, tabs and an extra button for footnotes in the tool bar.

In our example the character formats, e.g. font, font size and style, will be initially assigned line by line. The first line was formatted in “Times New Roman”, 14 point, bold, the second line in “Times New Roman”, 14 point, regular and the third line in “Times New Roman”, 12 point, bold.

Then set up the line spacing. The line spacing for the first two lines stays the same; to increase the space for the third line, you should position the cursor in the line. The buttons you require will appear in the tool bar. Then click on the middle line spacing button (picture) to extend the line spacing.

Fig. 47: The letterhead as a close-up. When formatting text-picture combinations of this kind it is advisable to occasionally hide the container boundaries to better evaluate the impact of the font (command WINDOWS ➔ SHOW, tick checkbox to remove NON-PRINTING ITEMS).

By changing the container size or position you can continue to adjust the company name to suit the logo, if required.

**Fill in Address Box**

The recipient address should now be entered. For this you have to click on the already prepared container. By continually pressing ← you create spaces so that the text does not directly adhere to the top of the container. Then enter the address. “Times New Roman”, 12 point was also used here.

Now you should indent the recipient address slightly to the right so that it can be better seen in the envelope window at a later date. For this you need to work with the margin stops. These are the small triangular
Chapter 4: Quick Introduction

Fig. 48: The command WINDOWS → SHOW → SPECIAL CHARACTERS displays line breaks and other (non-printing!) typographical features on the screen.

“arrows” on the margins of the gray bar, which can be seen on the top of the screen above the corresponding container (Fig. 49 [p. 78]). As with line spacing and text alignment, text indentation is also a paragraph format. This means that when numerous lines separated by line breaks — technically separate paragraphs — should be edited at the same time, they have to be selected at the same time. For this you could perhaps try out the command EDIT → SELECT ALL.

Fig. 49: Changing the text indentation using the mouse and margin stop. It’s sometimes difficult to work to the millimeter this way; if this is the case you should enter the position numerically (Fig. 50 [p. 79]).

⚠️ Take a good look and make a precise click: The left margin stop is divided into two and there is a big difference between handling the upper or lower “triangle”. Dragging on the upper triangle changes the left indentation of the first line of the paragraph — and only the first line. Dragging on the lower triangle moves the upper triangle as well and changes the left margin of all lines in a paragraph. If you want to move the lower triangle separately without the upper triangle changing, you have to hold down the key.
Approach the bottom left margin stop with the mouse cursor, keep the mouse button held down and move the mouse slightly to the right. The new position of the text block is shown by an orientation aid. The text moves into its new position as soon as you release the mouse.

The recipient address is now ready.

![Image of Text Information dialog]

**Fig. 50**: The Text Margins panel in the information dialog box (which can also be opened via FORMAT → PARAGRAPH FORMATS). Here you can numerically enter the position of the paragraph margins, if the positioning with the mouse (Fig. 49 [p. 78]) is not accurate enough.

**Enter and Align Reference Lines**

The reference line is divided up into two containers. The data, which will not change, should be written in the top container and the current references should be written in the bottom container. This division makes it easier to reuse the letter for other purposes at a later date. The four text blocks are split with the help of tabs.

**Tabs are labor-saving devices**: Using tabs for alignment is more precise and less error-prone than when using spaces. Texts which have been “aligned” according to spaces often have to be reworked after changes to the font, which can also result in some nasty surprises when printed. Working with tabs is therefore the preferred choice!
Chapter 4: Quick Introduction

RagTime has default tabs, but you can also set your own, if required. For the reference lines it is sensible to use a somewhat smaller font – the example letter displays a 10 point “Times New Roman” font. Unhidden “special characters” are also extremely helpful in this case (in the first instance you can’t tell whether a blank text has been structured with spaces or tabs). In this case you can work with the default tabs. Enter the text in the same way as shown in Fig. 51 [p. 80]. Each of the small arrows shown in the picture corresponds with the tab key (→) being pressed once.

<table>
<thead>
<tr>
<th>Date and reference of our letter</th>
<th>Date and reference of our letter</th>
<th>Telephone</th>
<th>Nutgrove</th>
</tr>
</thead>
</table>

Fig. 51: The reference lines with tabs split into four blocks.

The spreadsheet as an alternative to working with tabs: A spreadsheet component is usually the better option if you’ve got more complex constructions with numerous rows or columns. Spreadsheets are an excellent aid when it comes to tabular composition even if you don’t want to do any calculations. They can be easily changed and formatted.

Enter Date Formula

Up to now your texts have been exclusively comprised of text. You can, however, also incorporate formulas – actually a classic spreadsheet element – into texts. Such formulas are, for example, useful for the date or for numbering pages. In Edit → Insert Special Text you will find the most frequently required formulas used in connection with text.

The significance of PAGE NUMBER, NUMBER OF FOLLOWING PAGE and AMOUNT OF PAGES should be clear. The date formula requires slightly more explanation.

- The DOCUMENT DATE is the date on which the document was created (or a form was torn off from the stationery pad). It can be manually changed in the document settings EXTRAS → DOCUMENT SETTINGS → DOCUMENT, but it doesn’t adjust when the current date changes.
- AUTOMATIC DATE is always the current date. This date is updated whenever the document is opened.
- AUTOMATIC TIME also remains up-to-date; this information is updated every minute.
- The DATE FIELD and TIME FIELD on the other hand remain constant; you have to add the current point in time.
• You also have the choice between longer (e. g. Wednesday March 8, 2006) and shorter displays (e. g. 8.3.2006) when selecting date information.

Any formula can basically be entered into text. If there are not enough selections in EDIT → INSERT SPECIAL TEXT, then you can open the formula palette by clicking on the abacus symbol in the toolbar. A further click on the $f$ Symbol (for “function”) in the palette opens a list of all available functions. Find out more about formulas in the spreadsheet exercises!

Now you should date the last reference line. For this you have to click in the right place and then select EDIT → INSERT SPECIAL TEXT → DOCUMENT DATE (SHORT).

<table>
<thead>
<tr>
<th>Date and reference of your letter</th>
<th>Date and reference of our letter</th>
<th>Telephone</th>
<th>Nutgrove</th>
</tr>
</thead>
</table>

**Fig. 52:** The command WINDOWS → SHOW → FORMULA BORDERS IN TEXT makes text components, which comprise a formula, recognizable by a dotted border. To have the formula displayed, you have to initially select the respective text component then WINDOWS → PALETTES → FORMULAS.

**Fill Footer**

Now the only thing left to do is to fill the bottom container with the business details. You should also work with tabs in this case.

**Fig. 53:** Here the document window has been condensed to ensure that text ruler and document text can be simultaneously viewed. As shown in the picture, the default tabs are no longer sufficient to align the business details.

Separate tabs have to be created, because the default tabs are not suitable for aligning the company details. The most important aid is the text ruler – which you already know from indenting the recipient address. Apart from the already familiar margin stops, you will be able to recognize further small triangles, which are distributed on the text ruler at an
equal distance to each other. These are the default tabs, which you have already been using (without knowing) when writing the reference lines. In addition to this, you can also define separate tabs or move existing tabs. Your most important instruments are the mouse and the tab buttons on the tool bar. If you want to work extremely accurately, you should use the dialog box \textit{Format $\rightarrow$ Paragraph Formats}.

Now write the text in the container and split the separate blocks by pressing $\rightarrow$ once for each text block. Press $\rightarrow$ twice between the company name (“Roderich S. Quirrel, kernels, fruits, nuts”) and “bank details”. You should then highlight the whole text – in this case we are once again dealing with paragraph formats, which should be assigned to the three different paragraphs (the three lines). Then click into the text ruler (underneath the “normal ruler”) and drag the mouse to the right. The second and the third text blocks move as well. An orientation line shows the text and mouse position. In this case you can proceed according to your visual judgment. It’s easy to make subsequent corrections. Release the mouse button, when the orientation line is somewhat to the left of the center of the container (\textbf{Fig. 54} [p. 82]).

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{dummy_letter.png}
\caption{Changing tab positions with the mouse.}
\end{figure}

Continue highlighting the text and then click again on the text ruler to indent the third block to the right of the container. If necessary, readjust both new tabs. You document should look similar to the illustration shown in \textbf{Fig. 55} [p. 82].

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{dummy_letter_indented.png}
\caption{The finished business details – perfectly aligned. Special characters have been once again unhidden here for orientation purposes.}
\end{figure}

\textbf{Enter Letter Contents} \\
To fill the largest container in the document, you can either enter a text yourself or use the prepared file \texttt{DummyText.txt} from the Training
folder. First select the container, into which the text should be entered.

**Import File:** To transfer the dummy text to your document, select **File** → **Import**. In the dialog box, which then opens, you should navigate to the RagTime Training folder on your hard disk.

In a default installation you will find the **Training** folder in:

- C:\Documents and Settings\(your user name)\Application Data\RagTime\RagTime 6 Samples (en)\Training.

In a default installation you will find the **Training** folder in:

- /Library/Application Support/RagTime/Samples6.localized/English/Training.

**Alternative to command Import:** You can also simply transfer a text, which you would like to use in RagTime, from another application with the help of the Clipboard and the Copy & Paste feature. Make sure that the content type **Text** is set before entering the text in the container!

The business letter is now finished!
Up to now you have only worked with smaller quantities of text, which can be easily incorporated into one container. But what happens if you’ve got a somewhat longer text that should be distributed between numerous containers for design purposes? In such cases you can lay “pipelines”
between the containers so that individual containers become linked containers. Pipelines also work on spreadsheets. Containers connected by pipelines act like a connected container: the content flows into the next container as soon as the first container is full. Text abbreviations, breaking the line of a pipeline or deleting a container immediately result in a new arrangement of the text in all containers. This way all contents, which can flow, are able to be connected with each other.

In this exercise you will now get to know this important function for the first time. You already know the other working methods in this exercise: beginning a new file with a layout, creating and aligning containers and finally filling containers with text and pictures.

**STEP BY STEP**

Create File with Layout Component, Distribute Containers

You will once again require a layout component here, in which you will have to arrange numerous containers. You can use and modify the default layout component for this exercise. You need three text containers and one picture container; the picture container should ideally be square so that the intended sample picture fits in well.

Fig. 57: To complete Exercise 3, you are given some design choices when it comes to the container arrangement.

The container respectively marked with “X” is the picture component, the other containers are intended for the text. Use all the already
Fig. 58: You should now be used to working with the Rectangle tool by now...

Fig. 59: ... so there'll definitely be no problems here.

familiar tricks and functions to create and align the containers.


**4.3: Exercise 3: Quickly Designed Flyer: Text Container with Pipelines**

---

**Fill Containers**

You should now enter a longer text into the first text container. For this you could take the text from the file `LongDummyText.txt` in the Training folder. The text is so long that it cannot be displayed in full in the container.

Pay attention to the bottom right of the container. An “overflow symbol” points out whenever the inserted text is too extensive for it to be displayed in full in the container. You could now expand the container, shorten the text, reduce the font or – install a connection to other containers with pipelines so that the text can continue to flow.

You should, however, initially enter the picture in the intended container. Use the file `Ammonite.tif` from the Training folder!

⚠️ **Release the mouse button at the right time:** Once again pay attention to the dark shading of the target container. This signalises that you have exactly hit your mark with the mouse and can now release the mouse button.

---

**Install Pipelines**

A pipeline should now be installed. It is really quite easy to install pipelines between containers. Before you start working with pipelines you should switch on the pipeline display for improved control. For this you need to select the command **Windows → Show → Pipelines**. This is extremely helpful, especially when you are not yet that familiar with pipelines.

➡️ **Pipelines in Empty Containers:** You can, by the way, also connect empty containers with a pipeline before the contents have been added.

As soon as you select a container so that it’s displaying the characteristic square move handles on its outline, the three different pipeline tools will appear in the tool bar.

The Vertical Pipeline tools is the tool that you **always** use to install pipelines between text containers, no matter whether they are running vertically, horizontally or even diagonally.

You only sometimes require the horizontal pipeline tool when you are working with spreadsheets.

The Cut Pipeline tool breaks existing pipeline connections.

You should generally take note that the order in which pipelines are installed from container to container determines the order in which the
containers are filled with the overflowing text (this applies to layout components, master layouts work completely differently; see "The RagTime Master Layout: Complex Documents" [p. 207]).

Click on the Vertical Pipeline tool. Place the mouse anywhere in the container where the pipeline should begin; the mouse cursor then changes its shape (Fig. 61 [p. 89]). While holding down the mouse button, drag the mouse to the container where the pipeline should end. The
gray shading of a container when dragging the mouse indicates that exactly these containers have been registered as the beginning or the end of the pipeline. You can now release the mouse button (Fig. 62 [p. 90]).

Fig. 61: The start of the pipeline.

The text flows over to the second container. The pipeline is now also recognisable as a line provided that you have set the pipeline display. You should now fill the bottom container by adding a pipeline to it. The procedure is exactly the same as for the first pipeline: click the Verti-
Fig. 62: The pipeline enters the target container.

cal Pipeline tool. Place the mouse on a part of the container where the pipeline should begin and drag the mouse to the bottom container. You can simply drag the pipeline over the picture container (or any other containers, which should not be connected). It will end wherever you release the mouse button. Your document is now finished.

Existing pipelines can also be subsequently changed.

- To remove a container from an existing pipeline, you have to install
Fig. 63: Pipelines can also be installed across “uninvolved” containers.

- A pipeline around it.
- The text is diverted if you delete a container, which is located within a pipeline line. It then flows to the next container on the pipeline route.
- You can also install new containers in already existing pipeline routes. For this you have to install a pipeline from the container, which is directly in front of the new container, into the new con-
tainer – RagTime automatically does the rest!

Use the opportunity to have a go at using pipeline tools yourself. Change over to the Cut Pipeline tool and break the connections again. Observe how the text reacts to this. You could also try out the tips for modifying existing pipelines.

→ **Relocate target container:** Pipelines are also allowed to intersect each other or can be installed over numerous pages in extensive documents. You may perhaps even forget where each pipeline ends. If you take the mouse cursor to the end of a pipeline on visible pipelines (Windows → Show → Pipelines), it will turn into a “walker”. One click will then show you the container at the other end of the pipeline. This container is also then selected.
4.4 **PREPARATION: SPREADSHEET BASICS**

Behind the term *Spreadsheet* you will discover a powerful and flexible tool for spreadsheet calculations, with which you can carry out complex calculations – and also really simple ones, too. A spreadsheet can also be used efficiently for layout tasks – like, for example, table composition. Spreadsheets can work on their own or can also be installed in layout and master layout components. The spreadsheet component is simply full of many functions which are extremely helpful in day-to-day life – working with it depends on knowing many details. And there's a lot to explain – so here's a short section to prepare you for the following exercises.

4.4.1 **CONFIGURATION, TECHNICAL TERMS, TOOLS**

A spreadsheet is, roughly speaking, a table that can do calculations. Sometimes “Table” is also used as a synonym for “spreadsheet”. Spreadsheet cells are also fully-fledged containers, into which other components can be installed. It would, for example, be conceivable to install a button component, which can trigger a calculation, or to combine product descriptions and pictures in a product list.

Which elements and functions are important in RagTime spreadsheets? What are they called? You may have already come across some of the technical terms used for the elements in the spreadsheet:

- An individual “box” within a spreadsheet is called a **cell**. The RagTime spreadsheet grid has $16,000 \times 16,000$ cells.
- A horizontal line of cells is a **row**.
- A vertical line of cells is a **column**.
- Every cell has its own **address**, because the clear-cut definition of cells is required for all calculations. That’s why the columns are characterized with letters and the rows by numbers in RagTime by default. The address of a cell can, for example, be D2 or S121.
- In RagTime another characteristic is added to the rows and columns, the so-called **planes**, which are arranged one after another. A plane is more than just an additional spreadsheet: planes add a third dimension to spreadsheets. Such complex spreadsheets are, for example, sensible for setting up monthly sales turnovers, which should simply be totaled up at the end.
- The boundaries of cells are called **cell borders**. The cell borders are presented in light gray on the screen by default and are non-printing. Changes to this property can be easily made (some black lines can, for example, be recognized in Fig. 73 [p. 103]).
• The contents of a cell are also called values in RagTime. The value can be a number, date, time period or text. Text comprising multiple lines within a cell is possible in RagTime and is determined as multiline text. A cell without contents is given the value empty in RagTime. Components inserted into cells are not values.

• Values can be assigned to various value formats. A number can therefore simply be noted as a number (“8”), as a price in euros (there are further differentiations here, e.g. “€ 8.00” or “EUR 8.00”) or in an exponential format with two decimal places (“8.00E00”). A date can, for example, be “20.04.2006” or “20 Apr, 06” – or even something different again.

![Cells and buttons in RagTime](image.png)

**Fig. 64**: The spreadsheet tools. Many other functions for editing spreadsheets can be found in the SPREADSHEETS menu as well as in the SPREADSHEET COMMANDS palette (to be found in WINDOWS → PALETTES).

The tool bar (**Fig. 64** [p. 94]) is your most important tool when working with spreadsheets. It gives you the control over important spreadsheet parameters and contains some frequently used functions.

• The entry in 1 shows which plane of the spreadsheet is currently visible on the screen. In spreadsheets with multiple planes, you can also use this feature to jump from plane to plane.

• In 2 you can see the address of the currently selected cell. You can also enter the addresses here in order to jump to specific cells (do not forget to confirm entry by pressing `↵`).

• For the functionality of the spreadsheet it is important to know whether a text, number, date, time period or even an error value (the result of an incorrect, undefined or invalid calculation) is in a cell or whether the cell is empty or contains multiline text. RagTime independently recognizes differences in this so-called value type – at least if you haven’t made an error when entering. The entry in 3 tells you what value type is in the selected cell.

• The buttons 4, 5 and 6 also refer to the value type. If the button with the small automobile 4 is selected, RagTime automatically recognizes the value type of the active cell. With button 5 you can assign the value type Text to a cell. For this, you have to select the respective cell and click on the button.
ton. You need this function when the value type of an entry cannot be clearly recognized or if it has been incorrectly recognized by RagTime. RagTime would, for example, therefore initially classify a football result of “21:30” as a time period with active type recognition – the value type text would have to be set manually.

Button 6 determines the value type Multiline Text for a selected cell. In multiline cells, inserted text is wrapped; the cells grow with the text. This is an especially helpful function for table composition!

- Sum button 7 adds the numbers in previously selected cells.
- To the far right there is a field, which displays the contents of the currently selected cell. You can also change or create cell contents by entering data in this field.

### 4.4.2 CREATE SPREADSHEETS

In this exercise you should initially only work with the spreadsheet component, not with a spreadsheet in the layout. You will find out how to incorporate spreadsheets into layout components in the following Exercise 5: Turnover Evaluation in Spreadsheet [p. 118].

The quickest way of accessing the spreadsheet component is via the New Beginning With panel in the Foyer, where you should click on Spreadsheet.

### 4.4.3 TIPS FOR DATA ENTRY

The most intuitive way of placing data in a spreadsheet is to enter it through the keyboard. One click on the cell, enter the data and you’re finished. It’s as easy as that – well nearly. A typo is more than just incorrect spelling to the “intelligent” spreadsheet. Incorrect entries in the spreadsheet or the formula palette can result in malfunctions, the causes of which are often only detected after a great deal of painstaking searching. It is therefore really worth taking a look at this topic in more detail.

![Fig. 65](image)

Fig. 65: You can start writing. A selection like this can be stretched over numerous cells. It is the basis for many formatting and entry aids.
As you already know, RagTime – usually automatically – differentiates between various value types when it comes to cell contents. This has its consequences: no additions or multiplications can, of course, be carried out with text, but a list with the names of months can, for example, be automatically completed. Numbers have to be clearly recognizable as numbers, so that, for example, calculations can be made or value formats properly assigned. RagTime recognizes the following value formats. They should be entered exactly as described here in order to prevent “unexplainable” mistakes from happening.

- **Numerical Entries** should solely comprise the numbers 0 to 9, signs (+ -), points for decimal places and commas for thousands (, .) and the exponential symbols (e E). Please make sure that no letter “o” or “O” or space is before or after the number in the cell.

- You can add **indication codes for currencies, dimensions or quantities** (EUR, kg, m…) to numbers, the spelling, however, has to correspond with one of the value formats that you have previously defined. You can look things up in SPREADSHEET → GET INFO → VALUE FORMAT. If you have entered an incorrect identification code, e. g. “EUr” instead of “EUR” the numerical details of RagTime are classified as text and not taken into consideration during calculations!

→ Prevent Typos: It is better not to enter currency and other identification codes, but to write the real numerical values and to then assign a specific value format to the cells, especially if you only have limited experience with value formats. The correct identification code or correct spelling (commas, decimal points etc.) is then automatically added. You can read how to assign value formats later on in this exercise.

- The spelling of **calendar dates** and the **time** accepted as correct by RagTime also depends on the default system settings on your computer. You are, of course, also using numbers here. Dates that you enter without entering the century are automatically completed by RagTime.

To determine which other characters are permitted, check out START → SETTINGS → SYSTEM CONTROL → DATE/ TIME.

To determine which other characters are permitted, check out DATE & TIME in the System Preferences.

- **Time periods** can occur in spreadsheet cells and formulas – that’s why you should make sure that the correct spelling is painstakingly maintained here. Apart from the numerical characters, RagTime knows d for days (from the Latin “Dies”), h for hours (“hora”) m for
minutes and s for seconds. At least two of these identification codes must always occur in one entry. To enter, for example, “two hours”, write 2h 0m or 0d 2h.

- All other entries, to which none of the above-mentioned rules, apply, are grouped as Text.

As you can see there are many opportunities for making small, but pivotal errors when filling spreadsheets or writing formulas. You should therefore make use of all opportunities to recognize incorrect entries as soon as possible.

- The default alignment of inserted characters within the cell assists in differentiating text from numerical entries. Text is always shown in left alignment by default, numbers are always arranged in right alignment (see Fig. 66 [p. 97] as a comparison).

When you design the spreadsheet, you can change this setting (in the information dialog box in ARRANGEMENT). It would be better not to adjust anything though while you are still busy filling the spreadsheet!

![Table](image)

**Fig. 66:** Correctly and incorrectly entered number. Above you can see the correctly entered year, below the zeros are replaced by lower case “o’s”. RagTime can no longer recognize this number as a number and aligns it, like normal text, to the left in the cell.

- Carry out frequent checks of the value type display in the tool bar!
- Make sure that the special characters are displayed in order to be able to recognize any inadvertently typed spaces (WINDOWS → SHOW → SPECIAL CHARACTERS).

⚠️ **Warning with numerical values that are too long:** If hash marks of this kind “# # #” appear in a cell with numerical values, is is not a malfunction or incorrect entry, but a reference to the fact that not all numerical places can be written out, because the cell is too small.
4.4.4 NAVIGATION IN THE SPREADSHEET

Navigation within a spreadsheet, jumping from cell to cell, can be carried out with the mouse by clicking on the cell. Many users see using the mouse to activate this frequently required function, however, as slowing down their work. It is often much quicker though to move through spreadsheets by using the keyboard.

- \(\text{[Enter]}\) completes the entry; the active cell remains selected.
- \(\text{[Tab]}\) completes the entry and selects the next cell underneath the previously active cell.

⚠️ Please note that the keys \(\text{[Enter]}\) and \(\text{[Tab]}\) have a different impact.

- If you hold down the \(\text{[Shift]}\) key in addition to pressing \(\text{[Tab]}\), the marking jumps to the next higher neighboring cell.
- Press \(\text{[Right Arrow]}\) to jump to the cell to the right.
- If you simultaneously press \(\text{[Right Arrow]}\) and \(\text{[Shift]}\), the selection moves to the left.
- \(\text{[Backspace]}\) cancels the entry and restores the contents of the cell prior to entry.

⚠️ Line Wrapping in Multiline Texts: In cells with the value type Multi-line Text you cannot use \(\text{[Tab]}\) to jump to the next cell. By pressing this you simply begin a new line within the cell. Use \(\text{[Alt]}\) and \(\text{[Tab]}\) to change over from multilime cells to neighboring cells.

4.4.5 SELECTIONS IN CELLS AND SPREADSHEETS

The basic principle of “only editing whatever is selected” also applies to spreadsheets. There are various methods of selecting cells, all showing varying results.

- To edit an existing entry (numbers, amounts etc.), you have to click twice into the cell. The cell should not be highlighted in blue, but displayed as white with a blue border. If this is the case the entries can be corrected in the same way as normal text entries (place the cursor in the text, select text, delete, overwrite, amend...) (Fig. 67 [p. 99]).
- If an already filled cell is highlighted in blue while you are attempting to carry out changes, then the existing contents would be completely replaced by the new entry (Fig. 68 [p. 99]).
Fig. 67: If the cell looks like this, existing contents can be changed.

Fig. 68: If the cell looks like this, existing contents are being replaced by new entries.

- In any case, pressing \( \text{X} \) or jumping to another cell completes any changes that have been entered. Calculations are then updated, if necessary.

\[
\text{Correcting Errors:} \quad \text{The command Edit} \rightarrow \text{Undo undoes the last respective working procedure. It works not only in spreadsheets, but in all RagTime procedures!}
\]

\[
\text{The command Edit} \rightarrow \text{Swap Two Characters is especially suitable for Swapping Numbers and Letters. It also works with digits. To use this feature, you have to have previously selected the related characters or placed the cursor between them.}
\]

To create selections covering numerous cells, you simply have to mouse over the cells. For this you should initially select one of the corner cells in the requested selection range and then move the mouse diagonally to the opposite corner while holding down the mouse button.

You can select whole rows or columns by clicking on the respective letter or number in the bars above or to the left of the spreadsheet\((\text{Fig. 69 [p. 100]})\). To select a complete spreadsheet, you have to either use the keyboard shortcut \( \mathtt{Ctrl} + \text{A (回) or } \mathtt{A (回)} \) or click on the corner where the column and row bar meet \((\text{Fig. 70 [p. 100]})\).

If you want to select non-connecting cells, columns or rows, hold down \( \mathtt{Ctrl} \) (回) or \( \mathtt{A (回)} \), while consecutively selecting the ranges \((\text{Fig. 71 [p. 101]})\).

### 4.4.6 CALCULATIONS AND FORMULAS

Calculations are carried out in spreadsheets by employing formulas. They are not only effective in classic spreadsheet calculations, but also in
other components (text, graph, button). Some dialog boxes in RagTime also facilitate working with formulas (you can recognize such cases by the abacus symbol). From page numbering to calendar functions and mail merges – various different operations are based on formulas. The formula palette is your most important tool when working with RagTime provided that you are not using a shortcut like the already familiar **Edit → Select All** has the same effect.

Formulas may be a diverse and powerful tool, but working with the formula palette is incredibly easy. To understand how it works, you first have to know how a formula is constructed.
A formula looks, for example, like the one here. It is comprised of a function – in this case \texttt{Sum} – with an argument, this is the range of cells here, which should be summed up, i.e. \((D2:D9)\). Some functions don’t actually need arguments (e.g. \texttt{Today}, a function, which delivers the current date).

Formulas are nothing other than arithmetic statements, which deliver their result wherever they are located: in a spreadsheet cell (as in this exercise), in a text (remember, for example, the date in the business letter in the second exercise) or also in entry fields in dialog boxes (you will find out about such cases later on in the manual).

Formulas can comprise fixed values (e.g. a numerical value or a date), references to cells or ranges of a spreadsheet (e.g. cell addresses) or references to mentioned text sections. These fixed values and references can be linked with operators like +, -, / or * and also create arguments of functions. Here are some examples of valid formulas:

- \(B5/6\) – the value of cell \(B5\) divided by 6.
- \(\text{Sum}(A1:C50)\) – the sum of all spreadsheet cells from cell \(A1\) to \(C50\).
- \(\text{Today} + 21\) – the date in three weeks calculated from today,
- \(24.12.2008 - 1.11.2008\) – the amount of days between both these dates.
- \(\text{ClEasterSunday}(2008)\) – delivers the date of Easter Sunday 2008.

To enter a formula in a spreadsheet cell, you usually require the formula palette. Click on the abacus button in the tool bar to open. Here you can directly enter the formula you require in the entry field and
set the necessary arguments. Many formulas and functions are, however, more complicated than, for example, a simple Date. It is difficult to remember all this and then also enter the correct spelling. That’s why there’s an additional function window containing lists of all available functions (sorted alphabetically, according to categories or based on intended use).

**Fig. 72**: The formula palette, the function window can be seen in the background, where you can browse through the prepared functions and transfer them to the formula palette.

**Enter Functions in Formulas**: A click on the $f$ symbol opens the function window. Click on the function you require. An explanation of the function is shown to jog your memory in **DESCRIPTION**. The functions can be displayed in various sort sequences in order to find the required function quickly and easily (either alphabetically, based on category or according to intended use). The function is transferred by clicking on **INSERT** in the formula palette selection. Here you can also add arguments. A click on the green checkmark then enters the formula in the requested position; a click on the red cross ("X") cancels formula editing (**Fig. 72** [p. 102]).
4.5 EXERCISE 4: AN INVOICE WITH THE SPREADSHEET

The previous section ☞ Preparation: Spreadsheet Basics [p. 93] provided you with the knowledge needed to be able to work with spreadsheets (and this exercise!). You have already become familiar with the most important elements in the spreadsheet (and their names), gained an overview of tools and the concepts of spreadsheet components and found out how you can move in spreadsheets as well as learning what you should pay attention to when carrying out selections. You now have the opportunity of having a go at filling in spreadsheets and making various calculations yourself.

If you have read the previous section carefully, you now know enough to edit your first very own spreadsheet. The aim is to create an invoice similar to that shown in ☞ Fig. 73 [p. 103].

<table>
<thead>
<tr>
<th></th>
<th>Item</th>
<th>No. of Batches</th>
<th>Unit Price</th>
<th>Overall Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Hazelnuts, whole, finest quality</td>
<td>2</td>
<td>10.00 EUR</td>
<td>20.00 EUR</td>
</tr>
<tr>
<td>3</td>
<td>Hazelnut kernels, roasted</td>
<td>3</td>
<td>5.00 EUR</td>
<td>15.00 EUR</td>
</tr>
<tr>
<td>4</td>
<td>Pistachios, whole, unsalted</td>
<td>2</td>
<td>2.00 EUR</td>
<td>4.00 EUR</td>
</tr>
<tr>
<td>5</td>
<td>Pistachios, roasted and salted</td>
<td>10</td>
<td>1.50 EUR</td>
<td>50.00 EUR</td>
</tr>
<tr>
<td>6</td>
<td>Pine nuts</td>
<td>4</td>
<td>10.00 EUR</td>
<td>40.00 EUR</td>
</tr>
<tr>
<td>7</td>
<td>Hazelnuts, roughly chopped</td>
<td>5</td>
<td>1.50 EUR</td>
<td>4.50 EUR</td>
</tr>
<tr>
<td>8</td>
<td>Delivery flat-rate</td>
<td>1</td>
<td>8.00 EUR</td>
<td>8.00 EUR</td>
</tr>
<tr>
<td>9</td>
<td>Taster range of nutty nibbles (free-of-charge)</td>
<td>1</td>
<td>0.00 EUR</td>
<td>0.00 EUR</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Subtotal</th>
<th>121.50 EUR</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>16 % VAT</td>
<td>23.81 EUR</td>
</tr>
<tr>
<td>11</td>
<td>Total Amount</td>
<td>145.31 EUR</td>
</tr>
<tr>
<td>12</td>
<td>Please transfer the amount due without deductions by</td>
<td>20/04/2006</td>
</tr>
</tbody>
</table>

Fig. 73: You will create an invoice like this in this exercise.

STEP BY STEP

Create Spreadsheet

Use the Foyer to create a new spreadsheet component and save the file straightaway with a clear name. You can then use it later to accurately enter spreadsheets in layouts (see ☞ Exercise 5: Turnover Evaluation in Spreadsheet [p. 118]).
**Shortcut to spreadsheet:** You simply have to convert the content type for the supplied default text container to SPREADSHEET in order to install a new spreadsheet in a new layout component. The spreadsheet functions are the same as in the component view.

**Fill and Format First Row**

Enter the texts, which should act as column headings, in the first row. Proceed as follows in order to reconstruct the sample spreadsheet (Fig. 73 [p. 103]):

- Cell A1 remains empty.
- Change over to B1 (by mouse click or →) to enter “Item”.
- Select C1 and enter “No. of Batches”.
- Enter “Unit Price” in D1.
- And add “Overall Price” to E1.

The first row in the spreadsheet represents the title row. The text is made bold in order to highlight this. A line underneath the title row creates a boundary to the remaining spreadsheet contents.

To completely select the first row in the spreadsheet, click on the small gray button with the row number “1”.

The font goes bold if you make a further click on button B in the typography palette. Leave the row highlighted so that you can enter the separator. The command SPREADSHEET → BORDERS accesses the dialog box, in which you can set the borders for cells, columns and rows (Fig. 74 [p. 105]).

**Selection prior to accessing the dialog box:** The settings in BORDERS always refer to the selected part of the spreadsheet. You have to select the cells before you access the cell border dialog box.

- You should first determine which border is to be changed (1 in Fig. 74 [p. 105]). Place the appropriate checkmark in the list to the top left in the dialog box. Click the BOTTOM BORDER for the sample spreadsheet so that a small checkmark can be seen.
- In the right section of the dialog box you can now change your settings for width, dashes, color and position of the line, potentially used fill style sheets and other properties 2. In EXAMPLE you will see a preview of the line 3. For the exercise you require a continuous black line set to 0.25 point width.
- Confirm your entries with APPLY in order to change more settings or with OK to close the dialog box.
Fill First Column

You should now fill column A with the numbers 1 to 8. There is a useful automatic feature in RagTime for the filling of such sequences. First, you should simply enter a “1” in cell A2 and a “2” in cell A3. Then select both of these cells by mousing over.

Use the bottom move handle to then drag down the selection until the highlighted range reaches cell A9. Numbering is automatically continued (Fig. 76 [p. 106] and Fig. 77 [p. 106]).

Alternative working procedure: You can also use the dialog box in Spreadsheet ➔ Fill Sequence.
Fig. 76: Automatic filling of cells is activated, when the mouse pointer takes on the shape of a double plus (small and large plus sign). A running numbers display (the picture currently shows the number 8) provides a preview.

Fig. 77: A completed numerical sequence.
**Filling Multiple Cells with the Same Contents**

“Fill Cells Automatically” also works if you want to enter the same contents in numerous neighboring cells. For this you have to enter the contents into a cell, then use the move handles to drag the selection marker over all further cells, which are to be filled (you should also pay attention to the shape of the mouse cursor here). Then you are finished!

---

**Entering Item Names**

You should now enter the individual entries, the names of goods, in the invoice. You should once again work your way through cell by cell and enter the texts. These are item names, which have already been used in the sample file (see also Fig. 78 [p. 107]):

- In cell B2: “hazelnuts, whole, finest quality”
- In cell B3: “Hazelnut kernels, roasted”
- In cell B4: “Pistachios, whole, unsalted”
- In cell B5: “Pistachios, roasted and salted”
- In cell B6: “Pine nuts”
- In cell B7: “Hazelnuts, roughly chopped”
- In cell B8: “Delivery flat-rate”
- In cell B9: “Tester range of nutty nibbles (free-of-charge!)”

You can, of course, think of a few sample items yourself, but you should then make sure that the texts are approximately the same length as the sample items. That makes it easier to understand the following explanations.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td><em>Item</em></td>
<td><em>No. of Batch</em></td>
<td><em>Unit Price</em></td>
<td></td>
<td><em>Overall Price</em></td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>Hazelnuts, whole, finest quality</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>Hazelnut kernels, roasted</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>3</td>
<td>Pistachios, whole, unsalted</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>4</td>
<td>Pistachios, roasted and salted</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>5</td>
<td>Pine nuts</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>6</td>
<td>Hazelnuts, roughly chopped</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>7</td>
<td>Delivery flat-rate</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>8</td>
<td>Tester range of nutty nibbles (free-of-charge!)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Fig. 78**: The finished item names.
Change Column Width

The spreadsheet with the default columns starts to become unclear due to the many long item names! The quickest way of changing the column width is by dragging the seam between the columns with the mouse. The row height can also be altered this way. For this you do not need to individually select the column or row that you want to change. Instead, simply move the mouse on the title bar to the column (or row), whose boundaries you would like to change. In this case it would be the “seam” between the columns B and C.

The mouse cursor changes its shape and becomes a small vertical line with a double arrow. The mouse cursor should not take on the shape of a plus sign and nothing needs to be highlighted in the spreadsheet due to your mouse movements – if this is the case you have probably slipped down a few millimeters or have not placed the mouse cursor exactly over the seam.

You can then click on the mouse and move the separation between the columns to another position, in this case further to the right, in order to extend the item column. You can also change the columns C, D, and E so that all column headings are easily legible. Column A with the numbers in it can be somewhat narrower (Fig. 79 [p. 108]).

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Item</td>
<td>No. of Batches</td>
<td>Unit Price</td>
<td>Overall Price</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Hazelnuts, whole, finest quality</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Hazelnut kernels, roasted</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Pistachios, whole, unshelled</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Pistachios, roasted and salted</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Pine nuts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Hazelnuts, roughly chopped</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Delivery histogram</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Tester range of nutty nibbles (free-of-charge)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Fig. 79: The finished columns – perfectly aligned. The columns C, D and E are all the same width.

Moving numerous columns or rows at once: You can also edit numerous columns or rows at once with the mouse. For this you should initially select the columns or rows you would like to edit by mousing over them.

- Overall size of all selected rows or columns maintained: If you drag on a column or row border, which is inside the selected range, you may move the proportions, but the overall size of the selected rows or columns doesn’t change at all.

- Proportionally distribute change to all rows or columns: If you drag on a column or row border, which is on the edges of the
selected range, the overall width of the columns or the overall height of the selected rows does change, but the proportions of the individual rows or columns to each other, however, remain the same.

**Exact Changes**

If you want to set column or row sizes to the millimeter and not according to visual judgment, you should access the information dialog box for the spreadsheet (Spreadsheet → Get Info or i button). In the ARRANGEMENT panel you can set column and row sizes. More detailed settings are also possible according to a sample cell, e. g. the distance of the cell contents to the borders or the decimal point position (Fig. 80 [p. 110]).

You could alternatively also use the OBJECT COORDINATES palette to set column or row dimensions.

---

**Rows for Total Price and Tax (VAT)**

You not only require a list with the individual items for an invoice, but also an overall price and tax (VAT) details. This data should be added further down in the spreadsheet. Proceed as follows to reconstruct the example:

- Enter the “Subtotal” in cell C23. The word should appear in boldface. For this you should select the whole cell by clicking on it or the word by mousing over it, then set the font style (via FORMAT → STYLE menu or tool bar button). A line should be added above the word “subtotal”. For this you need to select row 23 and then use the settings in BORDERS, as you have done previously with the title row.
- “16 % VAT” is entered in cell C24.
- “Total amount”, once again in boldface, should be found in cell C25. This row must be underlined. For this you should click on the BOTTOM MARGIN in BORDERS and then set the line settings again.
- The amounts in cells E23:E25 are calculated and added using a formula at a later date. You should not enter anything here.

---

**Note on Date of Payment – longer text in cell unions**

A payment due date is also important. For this purpose the sentence “Please transfer the amount due without deductions by” should be incorporated in row 27; an automatically generated date will later appear as
Fig. 80: The ARRANGEMENT panel in the spreadsheet information dialog box. Columns or rows have to have been previously selected before identical dimensions can be specified for these columns or rows. You can then set the requested HEIGHT or WIDTH. The width of 2.9 cm was selected for columns C : E in the sample spreadsheet.

the date of payment. But where should this long sentence go? If it is entered in the wide row of B27, it remains completely visible, because the neighboring cells, C27 and D27, are empty and it is thus able to project outwards. This is definitely not an elegant solution though! Furthermore, the sentence is still in danger of disappearing behind other cell contents during subsequent changes to the spreadsheet. The value type multiline text could be set for cell B27 (by using the button in the tool bar), but then the text would wrap. A long line without text wrapping would, however, be more attractive in regard to the intended overall layout of the spreadsheet.

RagTime has the function CREATE UNION for these and similar cases, with which you can combine numerous connected cells to create one cell. To use this feature, select all cells, which should be united, by diagonally mousing over them. For this exercise we will be using the cells B27 : D27. Then place the mouse over the selection and access the context menu. Here you should select the command CREATE UNION. The previously se-
Selected cells are connected. The spreadsheet grid is interrupted at this point. You can now enter the text.

Further commands for cell unions: The command REMOVE UNION restores the regular cell grid, if required.

By the way, you will also find commands for uniting cells in the menu item SPREADSHEET. It is, however, much quicker to work with the context menu!

Enter Quantity and Prices, Set Value Format

Now you still have to fill in columns C (“No. of Batches”) and D (“Price”). You can think of some numbers yourself. Only enter amounts, but no currency symbols! These will be created by the value format setting. For this you should select all cells containing euro amounts and also the cells further down, in which the euro amounts should be found at a later date. In the example it’s the cells D2:E9 and E23:E25 (Fig. 81 [p. 112]). Here’s a reminder: you should use `ctrl` or `z` and the mouse for selecting numerous non-connected ranges.

You can use the VALUE FORMAT panel in the spreadsheet information dialog box and the commands in FORMAT \(\rightarrow\) VALUE FORMAT to assign a specific value format to values in the selected ranges. Here you should select the setting for a currency format. The numerical values, which have already been entered, automatically assume the specified format. The value format is, however, now also assigned to the cells, which have up to now remained empty, and takes effect as soon as the values are entered here.

Alternative approach: You can also use the menu command FORMAT \(\rightarrow\) VALUE FORMAT.

Multiplication: From Unit Price to Overall Price

The column “Overall Price” should now be filled. The product of the amount and unit price therefore has to be generated for every item. You do not require any functions for the multiplication (and a few other operations), but just need to work in the formula palette. You should initially determine where the formula result should be output. You can do this in the spreadsheet by selecting the cell into which the result should be entered. In our case this is cell E2.

Then open the formula palette by clicking on the abacus button in the toolbar. You should now determine the values of the spreadsheet that should be used in the calculation. This is carried out by entering the cell address. You can enter the cell address in the formula palette.
Click on the entry field and write C2. Now you have to enter the operator, which determines which calculation is carried out. A * is required for the multiplication (use the key, labeled as × on some numeric key pads). Then add the second cell address (D2) and click on the green checkmark (or press ×) to complete the procedure. The result is entered in the cell, which you have previously selected.

You can leave the formula palette open to calculate the overall price of the next item. In this case you will proceed slightly differently to learn another method for transferring cell addresses to the formula palette. First you should once again select the cell, in which the result should be output (E3). Then click once on the entry field in the formula palette, so that the flashing cursor can be seen. This step is important in order to reselect the already open formula palette for the entry! You should then click on the first cell to be entered into the formula (C3). The address is
added to the formula palette. You should then once again add * and click on the second cell (D3). This address will also appear in the formula palette so that now C3*E3 can be seen in the formula palette. Complete the entry.

Use of small case letters is permitted in cell addresses: You should not make any typos when entering formulas and functions, but RagTime is actually tolerant when it comes to the using upper and lower case letters in cell addresses. You can enter either C2 or c2. Both entries are recognized, lower case letters are automatically corrected after entry.

Caution, this rule, however, only applies to cell addresses and functions. Any other text contained in formulas has to be entered exactly as intended.

Other Methods of Calculation

You can also use other methods of calculation, based on the same procedure, in the spreadsheet. Here you should pay attention to the special notation for the arithmetic operator.

- Use the minus sign (either from the numeric keypad or the standard keys) for subtractions. Such a formula could therefore, for example, look like this: E8–E9.
- Use the plus sign (either from the numeric keypad or the standard keys) to add cell contents (Example: E8+E9). There are also further entry possibilities for this frequent calculation method, which you will learn about below.
- Enter / for division like, for example: E8/E9. Use [ ] key (labeled as \(\div\) on some numeric keypads).
- Various spellings can be used for the power calculation. The cell, which contains the value for the base, is always labelled first, then the cell with the value for the exponent. ** or ^ can be used as operators (e.g. E8**E9 or E8^E9).

Please note: the circumflex character is an accent mark. To enter it on its own, you have to initially enter the [ ] key and then a space.
Spread Formulas to other Cells

It would now be very long-winded to repeat the same entry procedure for the cells E4:E9. But you don’t have to: in such cases, formulas can also simply be spread into further cells. For this you have to select the lower of the two cells, both of which are already filled and provided with a formula (e.g. E3) or both of the already finished cells (E2 and E3). You should then place the mouse cursor on the lower move handle of the marker and drag downwards on the selection range. You should again pay attention to the shape of the mouse cursor. The mouse becomes a plus sign with a further somewhat smaller plus sign underneath, as a reference to the fact that the selection range has now been extended (Fig. 82 [p. 114]). The formula is now transferred to all cells in the extended selection range as soon as you release the mouse; the results are automatically inserted. The “overall price” column is now completed.

<table>
<thead>
<tr>
<th>No. of Batches</th>
<th>Unit Price</th>
<th>Overall Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>10.00 EUR</td>
<td>20.00 EUR</td>
</tr>
<tr>
<td>3</td>
<td>5.00 EUR</td>
<td>15.00 EUR</td>
</tr>
<tr>
<td>2</td>
<td>2.00 EUR</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>3.00 EUR</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>10.00 EUR</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1.50 EUR</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0.00 EUR</td>
<td></td>
</tr>
</tbody>
</table>

Fig. 82: A formula has already been entered in the two uppermost cells. Drag the handle in the lower center of the selection to fill the cells below with the appropriate formulas. Pay attention to the shape of the mouse cursor (large and small plus sign) over the handle.

Generate Subtotal

Sums have to be calculated a great deal, so there is a shortcut: the sum button.

Place the mouse in cell E23, click on the button – the calculation is carried out.

What should be added? The sum button can only deliver correct results if it is clear from which cells a sum should be generated. If there are cells filled with the numerical values are, for example, located above and to the left next to the cell, in which the result should be entered, then is unclear which values should be added.
Fig. 83: Calculations begin as soon as you release the mouse button (default setting).

In such cases you should use another procedure or previously select the cells whose values should be added.

In Exercise 6: Mail Merge [p. 137] you will learn about further methods for generating sums, which provide increased control!

### Calculate VAT and Total

Now the VAT should be calculated. For this you should select cell E24, open the formula palette and click on the corresponding formula field. You can then once again work with a multiplication and enter \(E23 \times 0.16\). \(E23 \times 16\%\) will, however, also work. The amount that is inserted in both cases is 16% of the subtotal entered in E23.

You now have to calculate the total, the amount, which should appear after “Payable by”. For this, you could simply generate a total from the subtotal and VAT amount. This even works with the sum button, because there is sufficient distance to the item prices further up.

There is, however, another solution, which only references one cell. You should once again select the cell, in which the amount is to be entered (E25) and open the formula palette (or click on the corresponding formula field, if it is still open). Here you should enter: \(E23 + 16\%\). This formula calculates a percentage value of a referenced value (in this case 16% of the value found in cell E23) and adds it to this value.

### Time of Payment with Automatic Date Generation

The appropriate wording has already been entered for the payment due date; now you’re still only missing the date. It would lend itself to work with an automatic date generation feature here.

The date cannot be entered directly after the sentence (“Please transfer…”), because the calculated values do not tolerate value type Text.
in this cell. You should therefore select the neighboring cell E30 and then turn to the formula palette.

You require a function to generate an automatic date for the time of payment. One click on \( f \) symbol opens the FUNCTIONS window (\( \text{Fig. 84} \) [p. 116]). Arrange this next to the formula palette so that you are able to view both features.

**Fig. 84**: The FUNCTIONS window.

Set FUNCTION CATEGORIES 1 as the sorting type in the function window (\( \text{Fig. 84} \) [p. 116]) in the window below. To do this you should open the tree diagram for DATE FUNCTIONS. Select a suitable date function from this list. The day on which the document is generated and saved would be suitable. You should then click on DOCUMENT DATE 2 and then INSERT 3. The function is entered into the formula palette. This date alone is, of course, not sufficient; eventually you want a deadline to be calculated from this day onwards. For this you can simply add the number of days, which correspond with the payment deadline, using a plus sign. If the invoice should be paid in three weeks, use the formula Document Date+21.
A spreadsheet is extremely large: it comprises $16,000 \times 16,000$ cells. Even if all of them are not normally filled, special requirements do arise for the printing of spreadsheets – especially if they are not inserted in a layout component. These three functions will help you more:

- You can specifically determine **which range** of the spreadsheet should be printed. For this you should select the GENERAL panel in the spreadsheet information dialog box and then the setting **RANGE OF CELLS** in PRINTING. You can then continue by selecting and mousing over the ranges which should be printed.
- If you do not specifically determine the range to be printed, the spreadsheet range between cell A1 (top left) right down to the furthest cell used to the bottom right will be printed.
- In the GENERAL panel in the spreadsheet information dialog box you will also find the options for **Printing Spreadsheet Grid**. By default the light gray cells are not reproduced when printed. In **Cell Grid** you can determine whether the horizontal or vertical grid lines or the whole grid are printed.
- Spreadsheets grow quickly in size that they soon no longer fit on one page. In the layout you can regulate the distribution to multiple pages per pipeline. If you print a spreadsheet as a separate component, you can **manually change breaks**. Default breaks for the currently set paper format are displayed as a dashed line. To change this you should click on the row or column title exactly where the additional text wrap should be added or an existing break should be removed so that the hyphen between the cells is shown as being highlighted. You should then select the context menu option **INSERT PAGE BREAK** or **REMOVE PAGE BREAK**.
4.6 EXERCISE 5: TURNOVER FIGURES WITH EVALUATION: ADVANCED SPREADSHEET FUNCTIONS

In the fifth exercise you receive further, in-depth knowledge about working with spreadsheets. You will once again use some of the functions you learned about in the fourth exercise and get to know some new commands and functions as well. You will find out how to generate spreadsheets in layout components, how to create and use style sheets for formatting and depict spreadsheets as graphs.

STEP BY STEP

Create a Spreadsheet in the Layout

In this exercise a spreadsheet should be created and edited directly in a layout component. Create a layout component by using the command CREATE DOCUMENT WITH LAYOUT and set SPREADSHEET as the content type of the automatically supplied container. For this you should select the container; in the tool bar you should then use the drop-down menu to convert the content type from TEXT to SPREADSHEET. You will immediately see the gray spreadsheet grid.

Inserting Spreadsheets in Other Components

Already existing spreadsheet components can, of course, also be inserted in new layout components.

- Everything works quickly and you don’t have to make any acrobatic gestures with the mouse if you use the command SPREADSHEET → PLACE IN A NEW LAYOUT COMPONENT.
- You can drag spreadsheet components into the layout components with the help of Drag and Drop and the inventory. If you want to install the spreadsheet in a prepared container, then this should be labelled with the content type NO CONTENTS. You do not, however, have to create a container in order to enter a spreadsheet in a layout. If none is available, a suitable container is automatically created during installation.
- If you drag a spreadsheet component into a text component, the spreadsheet is installed in its own container and moves when the text is moved. Other components also act the same when dragged into a text.
- Integrated spreadsheets: as spreadsheet cells can also act as containers, it is possible to install a spreadsheet component in
Fig. 85: The result of the exercise should look something like this: a spreadsheet component in the layout represented as a graph, below.
the cell of another spreadsheet. For this you should drag the component from the inventory over the cell, in which it should be installed.

- To transfer just the contents of a spreadsheet to another spreadsheet, you should either work with Copy and Paste (you can find the suitable commands in Edit) or use the command Edit → Paste Special. You then have the choice as to whether you want to transfer values (e.g. the actual, visible cell contents), formats or formulas.

Name Columns, Adjust Column Width

Now the spreadsheet should be gradually filled. For this you should initially adjust the width of the columns. You can once again work with the Arrangement panel in the info dialog box. But there’s also an even quicker method, with which you can evenly distribute the columns to fit the width of a container. For this you should initially select the columns required for the spreadsheet. Place the mouse cursor on a spreadsheet cell of your choice in order to unhide the column bar with the numbers of the columns. Mouse over the column titles A to E in the column bar to select the first five columns. Then place the mouse on the seam between columns E and F and move the mouse while holding down the mouse button until it reaches the right side of the container where you should once again release the mouse (Fig. 86 [p. 120]). The columns are thus evenly distributed in such a way that they fill the container. The same procedure is also carried out for rows.

Fig. 86: Adjusting the spreadsheet width to the container width.

Operating alternative without the mouse: If you are not a fan of working with the mouse, you should use the commands Calculate Width to Fill Container with Selected Columns or Calculate Height to Fill Container with Selected Rows (in the Spreadsheet
INFORMATION dialog box on the ARRANGEMENT) panel. The prerequisite for ensuring that the commands work correctly is again a selection.

You should then enter the name of the representatives in the first line:

- Cell A1 remains empty. The months will be added to this column at a later date.
- Enter “Major, Mary” in cell B1.
- Enter the name “Public, Jane Q.” in C1.
- In cell D1 write “Roe, Richard”.
- In cell E1 “Ordinary, Joe”.

You can, of course, also use other names. It is important that the name is not alphabetically sorted at the outset – sorting will be automatically dealt with at a later date.

**Row with Currency Codes**

In a spreadsheet like the one planned here, it would be annoying to read if there was a currency sign before every turnover figure. Specifications on the currency should, however, still be present and are added in the second line underneath the name of the representative.

Just write “EUR” in cell B2. Use the mouse to approach the edge of the right move handle surrounding the presently edited cell, until the move handle appears. Drag on the frame until it covers cell E2. The currency code “EUR” is then automatically entered in cells C2 to E2 (Fig. 87 [p. 121]).

![Fig. 87](image)

**Adding Months**

Now the names of the months will be added in the first column. Write January in cell A3, followed by February in A4. You don’t have to do anymore writing. Select both cells and extend the select range to incorporate cell A14. The shape of the mouse cursor (double plus) is also important here! The names of the remaining months are automatically added.
**Enter Turnover Figures and Set Value Formats**

The next thing is to enter amounts underneath the names in the columns. Unfortunately, there’s no helpful automatic generation feature in this case, you have to type yourself (without commas, decimal points and currency codes). You can use any numbers. Each of the four imaginary representatives should have generated a certain amount of turnover in each calendar month (that means cells B3 to E14 have to be filled).

Commas and decimal places are automatically added if you allocate a certain value format: select cells B3 to E18 (the lower four cells are not manually filled, but will be filled with the help of functions at a later date – they do, however, require the same value format). In **Format → Value Format** you should set 1,234.50. Alternatively to the menu command you could use the **VALUE FORMAT** panel in the information dialog box.

**Formulas for Evaluating Turnover**

The lower rows of every column should provide some information on the statistical evaluation of the representatives’ turnover. The sum of the turnover entered should be calculated as well as the highest and lowest value and the average turnover for each representative.

You should start by writing the appropriate names in the first column as an orientation aid. Don’t format these rows yet; that will be done by means of style sheets at a later date!

- Enter “Sum” in cell A15.
- “Minimum Turnover” in cell A16.
- “Maximum Turnover” in cell A17.
- And “Average” in cell A18.

Then select the cell where the first result should be entered. In this case, cell B15 for the sum. This time you should not be working with the sum button, but with formulas and functions. Open the formula palette and then the **FUNCTIONS** window (ƒ button). The functions are best displayed in the **CATEGORIES** view, as this is laid out most clearly for this purpose. Click on the function **Sum** in the category **ARITHMETICAL FUNCTIONS**. **Sum (List)** will then appear in the preview field. Click **INSERT**.

⚠️ The function name has been inserted without arguments? You will see the option **INSERT WITH ARGUMENTS** in the window **FUNCTIONS**. This should be check marked so that on inserting the function in the formula palette not only the function name (e. g. **Sum**), but also the variable for the arguments (e. g. **List**) is added in order to jog your memory.
If you place the mouse over the entry field on the formula palette, you will now see that it has a special shape again: a cursor with a small formula $f$ with a curly small case letter $f$. This refers to the fact that you can use the mouse to directly select the contents of the brackets of the formula (the argument) from the spreadsheet.

The term `List` in a formula is always just a variable and a reference to the fact that a list of the cells to be calculated is still missing. Mouse over all cells to be totalled, i.e., cells B3:B14. The formula palette should now look like this: `Sum(B3:B14)`. The formula is added to the document with one click on the green check mark in the formula palette. The sum of the cells B3:B14 is entered into the spreadsheet.

### Other Ways of Entering Formulas

The sum function is not the only function that requires a list of cells. Selecting the cells by mouse allows you to avoid typos and quickly specify all spreadsheet ranges for calculations when entering a formula in the formula palette. There are, however, also other ways of determining these ranges.

- You can also enter cell ranges manually into the formula by typing cell address – colon – cell address (e.g. B3:B14). For this you should delete the word `List` and enter the cell addresses instead.

  Not only the rows or columns, but also larger spreadsheet ranges can be referred to in this way. You always write the address of the cell at the top left first and then that of the cell at the bottom right. Like, for example, B3:E14 to mark the range with the turnover figures in the sample spreadsheet. This works with all functions which have the argument `(List)`.

- To generate sums, you can also enter cell addresses connected with a plus sign: B3+B4+B5+B6...

Now you should determine the minimum turnover of “Mary Major”, the first representative in the spreadsheet. For this you should select cell B16 and then once again turn to the function window. In the category `Search Functions` you will find the function `Min`. It searches for the lowest value in a list. Insert the function into the formula palette (INSERT button in the function window) and mouse over cells B3 to E14 again. Make sure you don’t inadvertently also choose the cell, in which the sum
has already been entered! Confirm application of the formula by clicking on the checkmark.

The search for the best turnover month works on the same principle, too. In this case you should, however, use the function \texttt{Max}. The result should be entered in cell B17.

Now all you have to do is create the average value, which should be entered into B18. This is a real statistical function. In the functions window you will find the function \texttt{Average} in the \texttt{Statistical Functions} category. Continue as already described: enter the function, set the list of cells to be calculated by mouse, confirm formula entry – and you’re finished.

\textbf{Spread Formulas}

The finished formulas should now also be spread to the neighboring columns to evaluate the turnovers of the other representatives. To spread the formulas, proceed as already shown in \textit{Spread Formulas to other Cells\textsuperscript{p.114}}: select cells B15 to B18. Then extend the select range by dragging with the mouse (watch out for shape of mouse cursor!) so that it covers column E. The formulas are automatically transferred and the values added.

\textbf{Sort Columns}

The columns of the individual representatives should now be put into the correct alphabetical order. First, the spreadsheet ranges mentioned (in this case columns B to E) have to be selected. Then select \texttt{Spreadsheet \rightarrow Sort}. In the dialog box, which then opens, you have various choices for controlling the sorting procedure (\textit{Fig. 88 \textsuperscript{p.125}}).

Three settings are important here.

- \texttt{By Column} has to be active in \texttt{Sort}.
- The \texttt{Sort Keys} set which cells are significant for sorting. It is sufficient if a cell address from the column or row, which you want to use for sorting, is entered here. This is usually the cell in the top left corner of the select range; manual changes to the entry are possible, as shown, for example, in A3.
  
  You can also set a second and third sorting key; RagTime then accesses this, if no clear result can be gained when sorting with the first key.
- Next to the entry field for the sorting key you will find two buttons to set the sorting order. Press the left for sorting from A to Z. Confirm with \texttt{OK}.

The columns are re-sorted.
Fig. 88: The command Sort enables you to put the spreadsheet columns and rows into a different order.

**Insert Additional Rows**
The spreadsheet requires a title. For this you have to insert a new row. And some empty rows would also be useful to make the spreadsheet appear more clearly laid out.

There are various methods of entering rows or columns, the prerequisite being that either a row or a column next to which something should be inserted, or a separator between rows and columns, is selected.

- If multiple columns or rows are to be entered, then it is best to work with the menu commands in Spreadsheet (Insert Columns and Insert Rows). You can then specify the amount of elements to be inserted in a small dialog box.

In some cases queries will also be made as to where the existing contents of the spreadsheet should be moved, e.g. if only parts of rows or columns are selected.

- If you need to be quick and only want to insert single rows or columns, then use the context menu.

In the menu and the context menu you will also find commands to delete (previously selected!) columns or rows.

- The Spreadsheet Commands palette (to be accessed via Windows \(\rightarrow\) Palettes \(\rightarrow\) Spreadsheet Commands) contains a whole host of buttons for inserting and deleting columns and rows.

Now insert two rows at the top of the spreadsheet. In the first row you should add the title, the row below should remain empty. Add one
empty row after the name of the representative and one empty row before the evaluation of the turnover to make it easier to read the spreadsheet, so you should insert an empty row in each of these places as well. Try out different methods of inserting empty rows!

Don’t forget to enter a title for the spreadsheet in the new first row as well (for example, “Evaluation of Representatives’ Turnovers 2005”)

**Create Character Style Sheets for Formatting**

The method described here works similarly for all style sheet types and also in other components – not just for spreadsheets.

The names of the representatives and the statistics rows as well as the title of the spreadsheet should be highlighted in specific formats. Two different style sheets will be defined for this: the style sheet for highlighting representatives’ names and statistics rows should be dependent upon the Normal Character so that a change in the Normal Character also affects the highlights style sheet. The character style sheet for the title should be independent and not change with the Normal Character.

Now here’s a short overview of how character style sheet dialog boxes work. Click on **Windows → Auxiliaries → Character Style Sheet Editor** to access the window for editing the character style sheets ([Fig. 89](p. 127)) or you could also access **Auxiliaries** in the inventory and double click on **Character Style Sheets** to open the editing window.

The basic organization of the dialog box windows is the same for all style sheet types: you can change the settings on the right and on the left you’ll see a tree diagram with the already existing style sheets. This not only serves as information, but also to show the style sheet selection.

In **RagTime 6 Auxiliaries.rtd** you will find all style sheets, which are available on your desktop for all RagTime documents. Under the name of the current document you will be able to view those style sheets, which have been defined for this document. And even if you have not actually carried out any changes to the style sheets, the style sheet “Normal Character” will always appear here.

There are two ways of creating a new character style sheet for a document.

- Click on **Create** in the **Character Style Sheet Editor** window. In the tree diagram you will see that the new style sheet has been added underneath the character style sheets for the document in such a way that you can immediately enter a new name. The new style sheet is hierarchically arranged below the selected style sheet – not just in the illustration, but also for real. You can then change the required settings on the right.
You should first highlight the areas of the document, to which the new style sheet should be assigned, and set the properties with the help of the typography bar or the FORMATTING palette. Then access the CHARACTER STYLE SHEET EDITOR window and click on CREATE FROM SELECTION. Give your style sheet a name. This way of working makes it a little easier to control how the format changes in the document operate.

Now use one of these methods to create a style sheet named “Title” (for the title of the spreadsheet) and a style sheet “Emphasise”, with which the column titles (Name of Representative) and the statistical figures can be more clearly highlighted. The next steps deal with the properties of the style sheets!

Fig. 89: The window for character style sheets, which you can create, inspect and edit here.
Naming Style Sheets

For the subsequent usability of style sheets in day-to-day use it is essential that you use clear-cut names for their documentation. The lists of used style sheets will soon become very long once you have got used to working with them. If you differentiate between style sheets by using names like “my title”, “my new title”, “red title” and such like and are only able to identify them by trying them out, then their effectiveness soon goes out the window. You should therefore get used to using recognisable titles to name new style sheets.

It is usually more beneficial not to name style sheets according to their properties (like, for example, “Times capital bold”) – otherwise the style sheet titles will also have to be adapted to suit changes to the style sheet properties! It is better to name style sheets according to their purpose: “Title 1”, “Title 2”, “Quote” or “fax font” are suitable titles for style sheets.

Properties and Dependencies of Style Sheets

The style sheet “Title” should always have the properties ARIAL, 12 POINT, BOLD, the style sheet “Emphasise” should always provide a bold version of the Normal Character and also change, if the style sheet for the standard font is changed. How can you influence this?

When you have generated the style sheets and selected the style sheet names in the list, you will once again see a summary of the style sheet properties in the bottom section of the dialog box in DESCRIPTION. This summary also contains important information regarding the inheritance of properties, therefore about the dependency of subordinate style sheets on superordinated style sheets (in this case the Normal Character).

You should now check the properties for the style sheet “Emphasize” whereby NORMAL CHARACTER + STYLE: <BOLD> should be found in the description. This means that the style sheet “Emphasize” obtains most information from the style sheet “Normal Character” and amends these properties by adding BOLD.

Other entries may also be found here, depending on how you have generated the style sheet, for example: NORMAL CHARACTER + FONT TIMES NEW ROMAN BOLD; STYLE <BOLD>. This means that the style sheet “Emphasize” definitely uses the font TIMES NEW ROMAN, even if the font of the superordinated style sheet “Normal Character” has been changed.
To specify the inheritance of individual properties in more detail, there are many small, but extremely effective buttons in the style sheet dialog boxes. In the Font panel you will find these buttons above the settings for font, size, over the individual style buttons and next to the list for setting upper case/lower case letters. The buttons are switches, which means that you can switch between both inheritance modes if they are clicked on.

The small arrow signalises that a property, which has been labelled in such a way, is directly inherited from the superordinate style sheet and therefore also changes, if any changes are made to the superordinate style sheet.

Properties labeled with the small square symbol are not inherited by superordinate style sheets. They are independent of later changes to the superordinate style sheet. If required, such properties can, however, also be inherited to other subordinate style sheets at a later date.

In the case of the style sheet “Emphasize”, all properties should be inherited by the superordinate style sheet “Normal Character” with the exception of the style Bold. Almost all “Inheritance Switches” should therefore point to the arrow symbol. Only the button over B should show the square symbol. Change the settings for the style sheet “Emphasize” based on (Fig. 90 [p. 130]).

You should then check the settings of the style sheet “Title” and adapt them by clicking the inheritance buttons. The description should read: Normal Character + font Arial Bold; size 12 Pt; style <Bold>. This therefore guarantees that the font, font size and style (bold) stay the same in text sections formatted with “Title” if the style sheet “Normal Character” is changed (Fig. 91 [p. 131]).

Your style sheets are finished.

Rearranging Style Sheets and Making them Globally Available

Style sheets can simply be moved within the tree diagram using drag and drop. Character style sheets can, for example, therefore be completely removed from their dependency on the Normal Character or even made globally available by being dragged under RAGTIME 6 AUXILIARIES.RTD.

You can, however, also bring chaos to the complex inheritance arrangement with just one click so that one style sheet is no longer able to deliver the required results.
Fig. 90: Properties of the style sheet “Emphasize”. Pay attention to the “Inheritance Switches” in the various formatting settings.

**Use Style Sheets**

The newly defined style sheets not only appear in the style sheet table of the style sheet window and the inventory, but also in other parts of the program. You can find character style sheets, for example, in the typography bar (Fig. 92 [p. 132]), in the menu under **Format → Character Style Sheet** or in the **Formatting palette**.

**Effective formatting aid**: The **Formatting palette** unites various formatting commands and style sheets (not just character style sheets). Frequently used settings for the document display (Display scale, Display of non-printing elements etc.) are also found in the palette – there’s actually everything you need to quickly format documents.

You reach the palette by using the command **Windows → Palettes → Formatting** or with the “Penknife” button.

Now you have to format the appropriate sections of the document.
with the help of the style sheets if this hasn’t already happened when generating the style sheets (by using the command: CREATE FROM SELECTION). Select the title of the spreadsheet and then “Title” in the pop-up menu (Fig. 92 [p. 132]). Then select the row with the name of the representatives and “Emphasize” in the pop-up menu. This way you can also assign this style sheet to the statistical data.

**Make Space for Graphs**

A simple graph should now be generated underneath the spreadsheet, which displays the turnover value statistics of each individual representative in a diagram. For this you will initially require some space in the layout component. Shift the bottom container margin of the spreadsheet component upwards so that the spreadsheet component no longer fills the whole space.

![Character Style Sheet Editor](image)

**Fig. 91:** Properties of the style sheet **Title**.
Fig. 92: Once defined, style sheets are quickly assigned, for example, using the style sheet list in the Typography palette (picture) or the Formatting palette.

Create Graph Components
Now draw a container underneath the spreadsheet, which should be approximately the same size as the spreadsheet container. With the help of the Coordinates panel in the information dialog box or the Object Coordinates palette you can align the new container. Set Graph as the content type for the new container. The basic frame of the graph, two empty axes, can now be seen in the container.

Add Source Data to Graph, Select Graph Type
Now you have to determine which spreadsheet data should be represented in the graph. First you have to select cells B22 to E22 (Average Turnover) in the spreadsheet and click on Edit → Copy. Then click on the graph (not on the side of the container), so that the graph tools are unhidden in the tool bar. Then select Edit → Insert. The gallery appears (Fig. 94 [p. 134]), from which you can now select a chart type. The bar chart from the category Default Charts is ideal for the purpose you have planned.

The following dialog box New Category Series now only needs to be confirmed with OK. The graph is generated, but only with a row of bars at the outset.

Add more Data, Generate more Bars
You can also drag data directly into the graph from the spreadsheet. For this you should select all sum values in the spreadsheet (cells B19 to E19).

Place the mouse cursor over the border of the marker so that it forms an “X” shape with arrow tips. Then drag the mouse over the
graph and release the button. You can confirm the category row dialog box by simply pressing OK. New bars are added to the graph.

You can do the same with multiple spreadsheet rows (or columns) at one time. This way source data can be assigned to graphs even quicker. Now select the rows “Minimum Turnover” and “Maximum Turnover” (cell B20 to E21) and drag them into the chart in the same way.
Fig. 94: The bar chart is clearly laid out and also easy to edit.

**Insert Category Titles**

In the last task, the individual bar “groups”, the so-called categories, should be labeled with the names of the respective representatives. Access the information dialog box and the CATEGORIES panel. The entry field CATEGORY TITLES is what you are looking for here. Click on it once and you will notice that the mouse cursor takes on the shape of a small \( f \) – a sign indicating that formulas can be completed by mousing over spreadsheet ranges. You should now mouse over the cells with the names of the representatives (B3 to E3) and click APPLY or OK. The names are inserted into the graph underneath the bars. Your graph is now completed.

The method demonstrated here in the working procedures

- generate graph component,
- copy values from spreadsheet,
- select chart type,
- copy values
- and add graph

is always also applicable to much more complex graphs!
Fig. 95: The representation of the graph varies, depending on the size of the container you have created for the graph. Captioning and labelling of the value axes are automatically adapted to suit the available space.

Fig. 96: Your graph should look something like this after all the data has been entered: four categories (one per representative) with four bars respectively for the data series.
Customizing Graphs

There are countless options to further edit the appearance of graphs, which just cannot be described in more detail here. So here are just a few general tips:

- The well-known principle of “only selecting what you want to edit” usually also applies to graphs. There are countless graph elements that can be clicked on and selected.
- Almost all elements of graphs can be modified with the help of the many functions in the information dialog box.
- In more complex graphs it is sometimes difficult to point the mouse on the required element. That’s why there’s a special drop-down list in the graph tool bar, from which you can also select the various sections of the graph for editing.
In the sixth exercise you will find out how to generate a mail merge. A mail merge is an automatically generated letter addressed to multiple recipients with a personalized address and form of address (other elements of the letter can also be varied for various recipients). The basis of a mail merge is a letter document and a spreadsheet as sources of the data, which should be personalized. The letter goes into “Serial Production” on printout. Here you will learn about the controlled transfer of addresses and other elements into the letter so that they can be used for the mail merge function. There are also a few tips on printing.

**STEP BY STEP**

Preparations: Open Files, Arrange Windows

The basis of the mail merge is the business letter from Exercise 2. Delete the already entered address and also the form of address in the letter. You should save the document under a new name before doing this. Use an already prepared spreadsheet as the source for addresses and form of address. Open your sample business letter. You will find the file `Address List.rtd` in the Training folder, which you should also open. Both document windows have to be arranged on the interface so that you are able to look at all the important elements at the same time. The address field and the form of address are especially important in the letter. You definitely need the column title bar in the spreadsheet to select the required columns; you can view the required columns with the horizontal scroll bar.

---

**Working with Multiple Windows**

If you have opened multiple document windows in RagTime, partial or complete overlapping of windows usually cannot be prevented. Here are some tips as to how you can bring the appropriately required window to the fore and how windows can be activated.

- A click on the title bar brings a window completely to the front in the case of only partially overlapping windows.
- You can also use the inventory: a double click on the window or component title is sufficient to bring the window or component to the fore.
• In the Windows menu you will find a list of all currently opened windows. For improved orientation, titles are comprised of document and component names (Example ADDRESS LIST.RTD, SPREADSHEET 1). A click on the name brings the respective window to the fore.
• The command Windows → Tile Windows Vertically and Windows → Tile Windows Horizontally will help you to distribute multiple windows on the interface.

**Drag First Address Component into the Letter**

Drag and Drop is used to take information from a spreadsheet to the later mail merge. Spreadsheet ranges are selected and dragged into the letter with the mouse.

⚠️ **The correct content type for mail merge data:** You can only enter mail merge data into containers with the content type Text using the method described here. In all other cases the information is inserted as a spreadsheet together with its own container.

Select column A with the company names in the exercise spreadsheet and drag it over into the address field. Pay attention that the “X” mouse cursor with the arrow tips can be seen (as in (Fig. 100 [p. 140]) (no plus signs!). There is also significance to when you release the mouse. The mouse should actually be positioned exactly over the intended container (Fig. 97 [p. 138] and Fig. 98 [p. 139])

![Fig. 97](image)

**Fig. 97**: This is the correct position: the mouse is directly over the text container. Only sections of the frame, which symbolises the contents of the columns that have been dragged over, can be seen.

As soon as you release the mouse, a window with the options for inserting the spreadsheet data opens (Fig. 99 [p. 139]). Here you should select **As MAILMERGE FORMULA**. If the formats from the spreadsheet are
Fig. 98: The mouse is not positioned exactly over the container that is intended for the address. You can see the complete frame, which signifies that the contents of the column have been dragged over. If you release the mouse button now, the spreadsheet information is entered into a separate container.

to be used this also has to be check marked. The first address component is inserted as soon as you release the mouse.

Fig. 99: To generate mail merge addresses, you have to tick As MailMerge Formula.

**Insert Name and Street Names**

Click into the address field behind the newly inserted company name and press once in order to create a new line. The cursor must flash in the new line. Now the first name and surname and potential academic title of the addressees should be transferred to the address field – or the formulas, which ensure that the names (or other address components) are inserted into the letter on printing.

Show Mail Merge Elements: If you select **Windows → Show → Formula Borders in Text**, you are able to more easily differentiate between “normally” entered text and mail merge elements due to the dashed border.

In order to ensure proper combining of the three components that comprise the full name (title, first name and surname), with appropriate
spaces between components, you will select the three columns slightly differently than in previous exercises. The three columns or column titles are not moused over together. You should instead click on the column titles individually while holding down \[\text{ctrl} \] or \[\text{c} \]. You should first click on the column title for academic titles (column B), then on the column title for first names (column C) and surnames (column D). You will then see three adjoining selection markers, which are, however, clearly separated by frames and which slightly overlap (Fig. 100 [p. 140]). You should also drag the three selected columns over the address field.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AKB, Inc.</td>
<td>Ellisbach</td>
<td>Tom</td>
<td>4 Wine Street</td>
</tr>
<tr>
<td>2</td>
<td>ALFO Office Organization</td>
<td>Mochulski</td>
<td>Joan</td>
<td>89 Woodrow Street</td>
</tr>
<tr>
<td>3</td>
<td>Beck, Hansen &amp; Wood</td>
<td>Wood</td>
<td>Margret</td>
<td>408 Main St.</td>
</tr>
<tr>
<td>4</td>
<td>Business Consultants, Inc.</td>
<td>Hart</td>
<td>Max</td>
<td>1002 Hillcrest Ave.</td>
</tr>
<tr>
<td>5</td>
<td>C&amp;D Office Equipment</td>
<td>Muldoon</td>
<td>Geraldine</td>
<td>99 Dimbleby Drive</td>
</tr>
<tr>
<td>6</td>
<td>Darrowby, Inc.</td>
<td>Monday</td>
<td>Marthy</td>
<td>24 Church Rd.</td>
</tr>
<tr>
<td>7</td>
<td>DataMaster</td>
<td>Hooper</td>
<td>Mike</td>
<td>435 N 19th Street</td>
</tr>
<tr>
<td>8</td>
<td>Denny, Inc.</td>
<td>McFerrin</td>
<td>Andrew</td>
<td>78 Main St.</td>
</tr>
<tr>
<td>9</td>
<td>Dan's Sub Shop</td>
<td>Brennan</td>
<td>Dennis</td>
<td>198 8th St.</td>
</tr>
<tr>
<td>10</td>
<td>Drake's Print Shop</td>
<td>Smith</td>
<td>Bob</td>
<td>19 Dimity Cl.</td>
</tr>
<tr>
<td>11</td>
<td>ECP File Services</td>
<td>Webber</td>
<td>Anne</td>
<td>49 Bedford Rd.</td>
</tr>
<tr>
<td>12</td>
<td>Florida Construction</td>
<td>Sanchez</td>
<td>R.</td>
<td>300 5th St.</td>
</tr>
<tr>
<td>13</td>
<td>Freeware Dealers</td>
<td>Seward</td>
<td>Doug</td>
<td>1-5 Grapevine Alley</td>
</tr>
<tr>
<td>14</td>
<td>General Office Supply</td>
<td>Jones</td>
<td>John</td>
<td>23 Hillcrest Rd.</td>
</tr>
<tr>
<td>15</td>
<td>I &amp; Z Services</td>
<td>Walter</td>
<td>Fred</td>
<td>3609 Lancaster Ave.</td>
</tr>
<tr>
<td>16</td>
<td>Income Tax Service</td>
<td>Jackson</td>
<td>Kathy</td>
<td>3 Lakspur Ave.</td>
</tr>
<tr>
<td>17</td>
<td>K &amp; K Suppliers</td>
<td>McKnight</td>
<td>Larry</td>
<td>26 King's Arms Drive</td>
</tr>
</tbody>
</table>

Fig. 100: A separate select range has to be set for every address component on the spreadsheet so that spaces appear in the right places in the letter. The mouse cursor is in the correct position on the selection border, its shape indicates the function “Move”.

Now enter another new row here. You should deal with the street names in the same way as you dealt with the company names: create a new line in the letter, select the column (E) in the spreadsheet, drag over, set drop options — and you’re finished.

The address preview doesn’t always show all fields: In the letter each first entry of every column, which has been dragged over, is displayed for monitoring. In the sample file, there is no academic title in the first cell in column B, that’s why you won’t find one in the letter. The academic titles (if applicable) are, however, exported as intended when printing the mail merges.
**Insert ZIP Code and Town / City**

The columns for the ZIP code and town / city are arranged in the spreadsheet in such a way that the town / city is first followed by the ZIP code.

You should create a new line in the address field of the letter and then initially select the column with the town / city in the spreadsheet (column F) and then the ZIP code column (column G). Drag the double selection into the letter. Name and ZIP code are therefore added to the mail merge. If you prefer to use a different format with the ZIP code in front of the town / city name as it is used in some countries (e.g., Germany) that is not a problem either, because it is you who decides in which order the ZIP code and town / city name are entered into the address field.

**Insert Form of Address**

Now you still have to add the form of address. For this you will find a prepared column in the spreadsheet (column I). Place the mouse cursor on a suitable part of the body of the letter. Then change over to the spreadsheet. Here you should highlight the correct column and drag it over. The spreadsheet is then no longer required. You can close it.

---

**Data from Foreign Applications as Address Source**

You can also use files which do not derive from RagTime as address sources, e.g., Excel files (.xls). To ensure that these files are available for the mail merge, they have to be imported into a RagTime spreadsheet. For this you should click into the top left cell of an empty spreadsheet and select the command **IMPORT (in FILE)**. Then search for the required file in the IMPORT window. Depending on the file type, you can then choose between various import options. **CONVERT FORMATS** is the right choice for Excel conversions. The spreadsheet, which is then generated, can be used as described in the exercise.
Save and Print

You should save the letter file before printing. Then select the command FILE → PRINT.

Another panel has been added to the familiar print dialog box (Fig. 101 [p. 142]).

Fig. 101: The print dialog box for serial printing in Windows.

Prior to the familiar print dialog box another dialog box appears, in which you can set the serial printing settings (Fig. 102 [p. 142]).

Fig. 102: Settings for serial printing in Mac OS.

You can determine whether you want to print all letters in the series (PRINT ALL) or just parts of it. If you don’t want all the letters printed, enter the numbers of the first and last copies to be printed in the entry fields FROM...TO....

Proof prints with high print runs: Especially if you want to print an extensive series of prints, it is recommended that you first carry out a proof print of just a few copies to check whether all fields have been transferred correctly from the spreadsheet.
The option Separate Print Jobs specifies whether the mail merge should be dealt with as one large print job or as various different print jobs. For extensive serial printing, it may be sensible to use the latter option.
4.8 PREPARATION: DRAWING BASICS

Up to now you have only used the drawing tools to draw rectangles on layout pages, which you have inserted as containers. Here you will learn about more advanced drawing techniques, new tools and about drawing in the drawing component. This introductory section aims to familiarise you with the new tools you will use in the following exercise.

4.8.1 DIFFERENCES AND SIMILARITIES

You will already recognize a lot of the information provided in this exercise from the previous exercises. You will actually be using all the same tools and the same working techniques. Technically, there is no great difference between drawing in the drawing component and drawing in the layout component. RagTime just assumes that there are different reasons for utilization and that’s why there are different default settings.

When drawing in the layout, RagTime assumes that you want to generate a container, which will subsequently contain a component, such as a picture, spreadsheet, etc. That’s why the default style sheet CONTAINER BORDER is assigned to object outlines when you draw in the layout. This ensures that the outlines are displayed in blue on the screen, but that they do not actually appear in printing. Drawing in components usually serves to create drawings that illustrate examples. That’s why the standard style sheet for object outlines is NORMAL LINE when drawing in the drawing component. This creates a fine, black, printing line as an object outline. If required, other style sheets can, of course, also be assigned to drawing outlines (for individual drawing objects e.g. via the information dialog box or in FORMAT → LINE FORMATS).

There are also only a few differences when used in combination with other components: suitable drawing objects can be inserted as containers – no matter if they were generated in the drawing or in the layout component. Drawing components themselves can furthermore be installed into layout components (as has already been done with text, picture and spreadsheet components).

4.8.2 BEGIN WITH DRAWING COMPONENT

The best path to take to create a new drawing component would be via the Foyer where you should then select CREATE DOCUMENT WITH LAYOUT → DRAWING. While drawing in the layout is spatially restricted by the page format and printed page area, you are theoretically able to make use of countless square meters of space in a drawing component. You should,
of course, consider the dimensions, if the drawing component should be installed in a layout component at a later date.

**4.8.3 TOOLS FOR CLOSED SHAPES**

You have already gained a great deal of experience using the Rectangle tool in the previous exercises. RagTime also offers a range of further tools for various drawing objects.

The Rounded Rectangle tool, Oval tool, Sector tool ("piece of cake") and Polygon tool also work on the same principle as the Rectangle tool: you activate the tool and then drag the shape by holding down the mouse button. The drawn object comprises a certain area (and is thus a potential container). A running number next to the mouse cursor shows its current size during drawing. Editing opportunities and keyboard shortcuts for these drawing objects are similar to the ones used for the rectangle.

**4.8.4 TOOLS FOR LINES**

Not only closed objects, but also lines can be drawn with RagTime.

With the Arc and Straight Line tool you can create straight or curved lines – simply by dragging with the mouse again.

**4.8.5 POLYGON AND BÉZIER TOOL**

You will employ a completely different approach to working with the Rectangle, Oval tools etc., when you work with the Polygon or Bézier tool. The Bézier tool allows you to combine straight lines and curves, the polygon tool only draws straight lines. With both tools you can generate drawings point by point, click by click. This way you are able to draw closed or open objects with as many corners and connecting segments as you want. The shape of these drawings can still also be subsequently changed.
Turning Lines into Arrows

You can also make arrows out of non-closed drawing objects, e.g. lines, arcs, open polygons and Bézier curves. For this you require the Drawing Commands palette (in Windows → Palettes).

Clicking on the buttons adds an arrow tip to the front or rear end (or both ends) of a non-closed drawing object. Renewed clicking removes the arrow tips again.

The procedure is easy: one click starts the drawing and sets the first anchor point. Prior to every change of direction you have to re-click in order to create an anchor point. Then move the mouse to where the next anchor point should be created and click again (Fig. 103 [p. 147]). The connecting line appears automatically. It is not necessary to hold down the mouse button while drawing. The first (and last) polygon point is slightly magnetic, which makes it easier for you to close outlines properly. A polygon shape does not, however, necessarily have to have a completely closed outline to be finished (Fig. 104 [p. 147]).

Every movement with the mouse generates a line segment, every click anchors the last segment when you work with the Polygon tool. A polygon therefore has to be ended to ensure that it is not continued indefinitely in this manner – at least, if you want to draw multiple polygons in the same drawing component. To end a polygon it is sufficient to double click when drawing the last hold point or to change over to another tool. You can therefore also subsequently reactivate and edit a polygon that has been “closed” this way at all times.

Clear angles, straight lines: To be able to draw exact horizontal or vertical lines or clean angles when drawing with the Polygon tool, you have to hold down the ⌘ key. Angles are then only possible as multiples of 15°. This way frequently required angle dimensions such as 45° or 90° can be quickly generated.

The procedure when drawing Bézier objects is similar: clicking sets a point, dragging with the mouse creates connections. Here the connections can, however, also be curves. You control the direction in which the curve runs through the point by holding down the mouse and dragging it in the required direction to set the point.
Fig. 103: Drawing a polygon: you must make a click for every change of direction. The small squares on the corners symbolise the anchor points. They can also be subsequently changed.

Fig. 104: Even if the outline is not closed – RagTime always treats polygons (and Bézier curves) as closed objects which can be filled and also used as containers. A filling, as displayed here, shows that there is an imaginary boundary line.

4.8.6 EDIT DRAWING OBJECTS

The most important condition for changing a drawing object is its selection.

- If a drawing object acts as a container, then you always have to click on its outline in order to select it. With a simple drawing object you can also click into it in order to select it.
- Clicking while holding down the ⌘ key allows for the simultaneous selection of multiple objects.
• Clicking while holding down the key is also the fastest way of removing individual objects from a selection of multiple drawing objects again.

• Mousing over drawing objects is a further possible method of selection. This way, multiple objects can also be activated at once.

The objects selected in this manner can be moved, transformed, enlarged or reduced, rotated, mirrored or skewed. These methods can be used for drawing objects in the layout and in components. The most important tools are the “move handles” on the drawings (Fig. 105 [p. 148]) and the entry fields for carrying out precise work. You can use both the COORDINATES panel in the information dialog box and the OBJECT COORDINATES palette. It depends on your preference and the accuracy required as to whether you work with the mouse and handle or by entering numbers.

![Fig. 105](image)

Fig. 105: Three drawing objects, the two objects to the left and right are selected. The characterized handles (small squares) are not located directly on the outline in all shapes, but act in the same way as you are familiar with from working with the rectangle.

You have already learned about moving and duplicating a drawing object in earlier exercises and also about enlarging the size or proportions with the help of handles and precise entry.

In addition to the already well-known handles there are also two other “move handles”, which you can use to change the angle of the arc section (Fig. 106 [p. 149]) for arcs and sector shapes. Rectangles with rounded corners also have additional handles, which can be used to change the corners (Fig. 107 [p. 149]). Both tools can be used intuitively – why not have a try yourself.
Fig. 106: Change an arc by using the mouse (mouse cursor is shaped as a cross, as shown top left). For precise settings you should use the COORDINATES panel or palette.

Fig. 107: The “corners” of the rounded rectangle can be changed by using the mouse. For this you can also enter precise values in COORDINATES, if visual judgement is insufficient.
Changing Object Type to Change the Shape

Advanced changes can be carried out by using the command DRAWING → OBJECT TYPE. You can therefore, for example, make a rounded rectangle out of a normal one, a Bézier object out of a polygon and such like.

Rotating, mirroring or skewing drawing objects are transformations. They can – as with almost all editing procedures – be used for normal drawing objects and containers, are equally effective in the layout as when working in the drawing component. Their special characteristic: not just the object outline is changed, but potentially installed components are also reshaped during transformation.

Fig. 108: Transformations also affect the contents of drawing objects. The examples are clear enough: to the far left the original object. In the middle the drawing (which acts as a text container in this case) was simply enlarged using the move handle. On the right you can see the result of scaling. The text is clearly distorted.

Frequently required transformation commands can be found in DRAWING → TRANSFORMATION. It is, however, often quicker to work with the buttons on the DRAWING COMMANDS palette (to be found in WINDOWS → PALETTES as is the case with all palettes) or the mouse. If you have to work accurately, the transformation settings in the COORDINATES panel in the information dialog box or in the OBJECT COORDINATES palette will also help you.

- To rotate an object you should move the mouse into the center until it turns into a rounded double arrow (Fig. 109 [p. 151]). Click, hold
down the mouse button and drag it away from the center until a connecting line is displayed between the mouse cursor and the center of the object. You should now drag the mouse around the center of the object in order to rotate the object. The further you drag the mouse away from the center of the object, the more accurately you can determine the rotational angle. Simultaneously pressing \( \text{ctrl} \) also restricts the movement to \( 15^\circ \) steps here.

**Fig. 109**: Rotating a square with the mouse.

- You can now scale (enlarge) or skew an object (distort as parallelogram) by placing the mouse on one of the side handles (not on a corner handle!), pressing \( \text{ctrl} \) and \( \text{shift} \) or \( \approx \) and \( \text{shift} \) and then clicking the mouse button. The mouse cursor then turns into an eye-catching double arrow (\( \approx \) **Fig. 110** [p. 151]). You can now scale the object by moving the mouse or skewing.

**Fig. 110**: Skewing a square. Pay attention to the shape of the mouse cursor! A downward movement with the mouse would scale this square.
Unsuccessful transformations can be deleted with **Drawing \(\rightarrow\) Transformation \(\rightarrow\) Reset Transformation.**

⚠ **Similar sounding commands with the opposite effect:** Do not confuse the command **Reset Transformation** with its neighbor, the command **Remove Transformation.** The latter permanently “deforms” an object! This at first glance rather irritating nomenclature has come about as follows: a transformation doesn’t simply make the object (and its contents) larger, smaller or slanted. Transformed objects “remember” their original dimensions and coordinates. It is therefore really easy to reset a transformation. It’s only when you actually remove the transformation from the object that the new coordinates and dimensions are finally transferred to the object; the information on its original state is deleted. A potentially installed component is once again returned to its original state.

### 4.8.7 CHANGE POLYGONS AND BÉZIER OBJECTS

Polygons and also Bézier objects can also be changed in other ways than already described. The individual hold points can also be edited. For this the object must be active. You do, however, not need to select the object normally, but put the object into **edit mode.** There are various ways of doing this.

- Double click on the object. If a component is installed in the object, you will have to precisely double click on the outline.
- Select the object using one of the well-known methods and then click on the command **Drawing \(\rightarrow\) Edit Curve.**

You will find a switch in the tool bar and the palette **Curve Editing** to put curves into editing mode. The object has to be selected (normally) at first for the switch to work.

If the polygon is then in editing mode, the anchor points, represented by small squares, become visible. These anchor points can be selected and changed. For this you’ll need to use the already familiar Arrow tool from the tool bar. You can select one, numerous or all anchor points. The anchor points, which have not been selected – filled in black when displayed – remain fixed, those selected – displayed as a small square outline – are able to be moved by mouse or by entering new object coordinates (in the palette or in the information dialog box). There are therefore various different ways of giving a polygon a whole new shape or also just changing certain details (Example: ✤ **Fig. 111** [p. 153], ✤ **Fig. 112** [p. 153] and ✤ **Fig. 113** [p. 154]).
• Select an anchor point by clicking on it. The mouse cursor has to be exactly over the point to be clicked on and should take on the shape of a cross. The nearest segment with two anchor points is otherwise selected, if you do not precisely click on the anchor point.

• If you press \( \text{Alt} \) while clicking, you can either select or deselect numerous points.

• Clicking on a line segment selects this segment and also activates neighboring anchor points.

• Mousing over in a diagonal direction is a good method of selecting all anchor points at once or also simultaneously selecting numerous polygons.

Fig. 111: An anchor point has been selected here. It can now be repositioned by moving the mouse. The remaining points remain in place.

Fig. 112: The previously selected anchor point is moved. The shape of the polygon changes. Running numbers and a “guide” help you to find the new position.

Further Tools: The Curve Editing palette (Windows \( \rightarrow \) Palettes as usual) contains further tools, which can be used for editing polygon and Bézier objects. Here not only the Arrow tool is ready for quick access, but also a curve splitting tool, with which polygon and Bézier objects can be split, one tool for subsequently adding and one tool
**Fig. 113:** Two selected polygon anchor points: you can drag on the points or the line and move the polygon segment.

**Fig. 114:** Tangent lines are displayed for the selected anchor points (hollow squares) while editing Bézier curves. The shape of the curve can be changed by dragging on the tangent ends (filled circles).

for removing anchor points and the curve point kink tool, with which you can turn Bézier curves into corners. A switch for closing open shapes removes the last segment or adds one, the curve editing switch puts an already selected polygon or Bézier object into editing mode (Fig. 115 [p. 154]).

**Fig. 115:** Important tools are quickly available in the CURVES EDITING palette.
In the previous section you learned about the many versatile drawing methods in RagTime, which you can now use in this exercise to draw the design for a paper CD cover. For the lettering of the cover you will find out how to place a page from a multipage PDF in a rectangle and also learn about how to create a picture around which text is wrapped.

**STEP BY STEP**

### Create New Drawing, Adapt Format

Use the Foyer to create a new drawing (NEW BEGINNING WITH DRAWING). The drawing component is very large and offers almost unlimited space. You do, of course, have to take dimensions into consideration when dealing with possible paper formats (when a printout is planned) and in the layout, if the drawing component is to be integrated into a layout. Dashed lines signify the borders of the currently set paper format on the empty component.

A4 paper is sufficient for the planned CD cover. Landscape format is somewhat easier to edit than portrait format. Change the setting appropriately in FILE ➔ PAGE FORMAT.

### Draw First Rectangle

The first important drawing component is a square, the sides of which should each be 12.5 cm long. To generate this square, you should use the Rectangle tool. Remember: If you press ⌘ while drawing, the sides...
of the rectangle will be exactly the same length. To achieve the required dimensions of 12.5 cm, you can use the running number display next to the mouse cursor – for this you will, however, require a little “feeling for the mouse”. You could alternatively use the COORDINATES setting.

**Create and Position Second Rectangle**
The second rectangle is identical to the first, so you can therefore simply create a duplicate. For this you should use one of the methods of working illustrated in Exercise 1. Then move it directly next to the first square so that both are on the same level and almost adjoining. A small gap should remain between the two squares (0.1 cm or less) so that the paper can be folded at a later date. You can work with the mouse for a rough alignment of the square, the fine adjustments are, however, best carried out with the arrow keys (Fig. 117 [p. 156]).

> Duplicate and move in a straight line: If you press `ctrl` or `z` while moving an object, the object will be duplicated. The duplicate is moved in a straight line if you additionally press `s` while moving.

**Fig. 117:** Your drawing should now look something like this after drawing the two squares.

**Draw First Flap**
There are two flaps on the sides of a square for gluing together the protective paper cover at a later date. A third, somewhat larger flap serves
to close the cover. Slightly slanting sides allow for clean processing and usage of the flap as a closing flap. The glue flaps should measure $1.5 \text{ cm} \times 12.5 \text{ cm}$ in size, the closing flap should be $2.5 \times 12.5 \text{ cm}$ (the longer side corresponds with the side length of the squares respectively).

Exact dimensions and also the position of the drawn flaps are now secondary and can be subsequently adjusted with the help of the DRAWING INFORMATION dialog box (COORDINATES panel) or the OBJECT COORDINATES palette. Only the angles on the short sides have to be accurate. You should use the Polygon tool to draw, and use the “automatic angle generation” \(\uparrow\) while drawing for the slanting sides of the drawing objects.

The best thing would be to draw the flap in an empty space in the drawing. Two parallel guides will help you. You should then change over to the Polygon tool and click somewhere on the top guide to create the first hold point. Position the mouse once again on the guide, this time further right, and click to create a straight line while holding down the \(\uparrow\) key (\(\uparrow\) Fig. 118 [p. 157]).

\[\begin{center}
\text{Fig. 118: The first part of the trapezoid (section): line segment with two hold points. The right (displayed as a small square “outline”) is active.}
\end{center}\]

Continue drawing the short, slanting side. Hold down \(\uparrow\) to restrict the angle to $15^\circ$ (\(\uparrow\) Fig. 119 [p. 157]).

\[\begin{center}
\text{Fig. 119: Your drawing should now look something like this.}
\end{center}\]

You should then activate the first hold point so that you can continue drawing from this point (\(\uparrow\) Fig. 120 [p. 158]). If you do not position the mouse cursor exactly over the hold point when clicking then the polygon will close to a triangular shape. This is, however, not a problem:
\texttt{ctrl}+Z (_undo) or \texttt{Z} (redo) will undo the last working step. Create a short second side by clicking on a point below and slightly to the side of the hold point while once again holding down \texttt{S} (Fig. 121 [p. 158]) so that the angle locks at 15°.

\textbf{Fig. 120:} Activate the first hold point. It is extremely important to be accurate with the mouse!

\textbf{Fig. 121:} The third side of the flap is drawn.

Now close the open side. To generate a clean horizontal line, you should once again draw while holding down \texttt{S} (Fig. 122 [p. 158]).

\textbf{Fig. 122:} The finished flap.

To check and adjust the dimensions of the flap, you should access the \textsc{Object Coordinates} palette or the \textsc{Coordinates} panel in the info dialog box. In \textsc{Size} you should enter 12.5 cm for the width and 1.5 cm for the height of the object.

\textbf{Position Flap}

The flap should now be moved towards the right square so that its long side actually borders on the square, once again with a slight gap for the fold. To move drawing objects, you have to change over from edit mode to a normal selection. For this you simply have to click once on a free
space within the drawing component and then (once, no double click!) in the trapezoid or on its outline (Fig. 123 [p. 159]).

![Fig. 123: The positioned trapezoid. The move handles outside on the drawing object signalise that it has been selected and is not in edit mode.](image)

**Duplicate, Mirror and Move Flap**
Create a duplicate from the first flap for the opposite side of the square. The command **DRAWING** → **TRANSFORMATION** → **MIRROR ABOVE ↔ BELOW** horizontally mirrors the drawing object. Now you just have to move it so that it adjoins to the top of the square (Fig. 124 [p. 159]).

![Fig. 124: Your drawing should now look similar to this.](image)

**Generate Closing Flap**
One of the two glue flaps can act as a basis for the closing flap. Create a duplicate. The command **DRAWING** → **TRANSFORMATION** → **ROTATE 90° TO THE RIGHT** rotates it in such a way that it can be moved to the last free side of the square remaining (right). Adjust the size: the height of this object should be 2.5 cm, the width (12.5 cm) remains unchanged. The mouse is used to change its position and the arrow keys are responsible
for the fine adjustments. Don’t forget to leave a bit of space for the fold. The drawing is basically finished (Fig. 125 [p. 160]).

**Fig. 125**: The drawing is almost completed. Now you just need to add the information about the subsequent contents of the CD cover!

In the following steps you will learn about applying decorative and informative elements.

**Label CD Cover: Place One Page from a PDF**
Now you should add a reference to the contents of the CD to the cover. Lettering would be sufficient, but a picture is, however, more decorative. In this section you will learn about how to place an individual PDF page in a container.

One page should be inserted from the file `Entertainer.pdf`. You will find the file in the RagTime Training folder.

**Extend RagTime’s Scope of Function**: For RagTime to be able to process PDFs in Windows, you need an additional (free-of-charge!) software package entitled Ghostscript on your computer. RagTime is able to place, import and export PDFs with the help of Ghostscript. It is also extremely useful for dealing with EPS pictures. More information on where to obtain Ghostscript as well as on its installation can be found on the RagTime web site at [www.ragtime-online.com/go.cgi?info=Ghost](http://www.ragtime-online.com/go.cgi?info=Ghost).

Select the right rectangle in the drawing component. Then click on the command **Import** and search for the file `Entertainer.pdf` in the Training folder on your hard disk.
→ **Where is the training folder?** Descriptions are provided in Exercise 2: Formal business letter with automatic date generation [p. 68] as to how to navigate to the Training folder.

Click on **Open**. You can select the page that should be placed from a multi-page PDF document in a clearly laid-out dialog box with the preview function (Fig. 126 [p. 161]). It may take a few seconds till the preview pictures are completely uploaded.

**Fig. 126:** The arrows and the “slider” beneath the preview help you in selecting the correct page. You can, however, also use the entry field to navigate to a page. **PLACE** inserts the PDF page in the intended position.

**Version: Picture with Text Wrapped Around it**

Combinations of a picture with text are also suitable as a label for the CD cover. Pictures with text wrapped around them are extremely attractive features for many layouts and not just in this example. For this you will need two containers: one for the picture and one for the surrounding text. Draw a small square in the center of the already existing larger square.

→ To position the small square exactly in the center of the larger square, select both (with **Align Centers**). The **DRAWING COMMANDS** palette offers numerous buttons for the alignment of drawing objects to each other, which can be intuitively operated. Access the palette (via **WINDOWS → PALETTES**). One click on the button “Align Centers” (Picture) centers the small square in the large square.
Place a PDF page in the small square as described in the preceding step. Now a text should be entered in the larger square. You can enter, copy or import a text into this square yourself. If you want to work with Copy and Paste, you definitely have to set Text as the content type for the external square. You can use a text snippet from one of the already familiar dummy texts or from the \texttt{Lorem ipsum.txt} (also in the Training folder) (Fig. 128 [p. 162]).

Fine Adjustments for Text Wrapping: In the \\texttt{Drawing Information} dialog box you will find further settings for text wrapping in the Ob-
jects panel. Text Flows Around should definitely be active. Directly underneath this option you can also set a larger distance to the picture (Fig. 129 [p. 163]).

Fig. 129: The Distance setting regulates the distance of the text to the container border of the “embedded” picture. The Text Flows Around option has the effect that text is wrapped around pictures (active by default).
CHAPTER 5

The RagTime Stationery Pad: Style Sheets for Frequently Used Documents
5.1 WHAT CAN A STATIONERY PAD DO?

You have already learned about many RagTime tools, commands and components in the previous exercises, but up to now you have only worked with “simple documents”, i.e. files, which can be created and implemented relatively quickly without further planning. In the following exercises you will now learn about the stationery pad and the documents which can be “torn off” it.

A stationery pad is a document style sheet. It is worth using in all documents that you want to keep using again and again – like, for example, business letters, invoices, memos or minutes. You create the stationery pads in the same way as you create standard RagTime documents – it’s not until the Save Document process that you specify that the document should be saved as a stationery pad. You can then create as many independent copies of the stationery pad as you like, the so-called “tearing-off of documents”. You can then continue to edit documents torn-off from the stationery pad in the already familiar manner.

Stationery pads do, however, have a special feature – intelligent page management. If the first page is full, following pages are automatically appended as requested. It is possible to create stationery pads for documents with a differently designed first page. Different looking following pages can also be defined in the stationery pad. If requested, only a one-page document is initially created when being torn off from the stationery pad. The following page is only automatically appended to the document when the first page is full. And further following pages are likewise appended if required – the torn-off document therefore always has the exact capacity that you really require. And you don’t have to delete any empty pages you do not require.

For further reading: In the introductory chapter *Planning Expenditure and Editing Ease* [p. 22] you will find an overview of “simple documents”, stationery pads and master layouts – various types of organization for documents with varying amount of time and planning when creating and editing.
5.2 EXERCISE 8: A SIMPLE STATIONERY PAD FOR MINUTES

In this exercise you will learn the fundamentals required for dealing with stationery pads. You will create a custom document with all the tools known to you, then save this as a stationery pad and tear documents off it i.e. generate copies, which you can then further edit. You will also become adept in carrying out changes in the stationery pad.

Fig. 130: Such a document should become the basis of your first stationery pad.
**STEP BY STEP**

**For New Document, Create Container**
Create a new document beginning with a layout component. The rectangle, which is already on the new layout component, would get in the way in this exercise, because it already contains a special mechanism for creating new pages. Select the default container and delete.

Change over to the Rounded Rectangle tool. Draw a container in the upper quarter of the document, which almost encompasses the whole page width and move slightly towards the right margin – for the binding of printed pages at a later date – as shown in Fig. 130 [p. 167]. Leaving a slight gap, draw a second container underneath, which encompasses the rest of the page.

The exact size of the container is not so important for the exercise. If you want to work precisely, you should utilize the COORDINATES panel in the DRAWING INFORMATION dialog box or the OBJECT COORDINATES palette. The rectangles can be aligned to each other by using the command DRAWING → ARRANGE OBJECTS (Fig. 131 [p. 168]). You have to have previously selected both rectangles (Click while holding down).

![Arrange Objects](image)

**Fig. 131:** With these settings you can align numerous (previously selected) drawing objects to each other.

**For Set Properties for Container Borders**
The rectangles in this document should not just act as unobtrusive layout aids, but also as a design element: their outlines are made visible. Select both rectangles.
To ensure that the document is designed quickly, you should this time opt for the palette FORMATTING (which like all palettes can be found in WINDOWS → PALETTES. Access this feature. The FORMATTING palette is relatively large and therefore boasts numerous sections, which can be opened and shut in order to ensure that the palette does not take up too much room on the user interface. Click on the light gray FILL AND LINE STYLE SHEET switch in the palette to access the commands that will be required next. Then select the NORMAL LINE line style sheet instead of CONTAINER BORDER. The containers are therefore given a thin black border (printing).

![Fig. 132: Assignment of a line style sheet in the formatting palette.](image)

→ **Alternative to Style Sheets:** You can also work with the settings in FILLS AND LINES if none of the style sheets take your liking and you don’t fancy taking on the task of creating your own line style sheet. If you work with style sheets, subsequent changes to the format are usually implemented faster.

→ **For further reference:** Using font style sheets as an example, Exercise 5: Turnover Evaluation in Spreadsheet [p. 118] shows how style sheets are created and used (for more information see section on Create Character Style Sheets for Formatting [p. 126]).

→ **For further reading:** You can find out more about line style sheets in Exercise 11: A Spreadsheet as Stationery Pad [p. 192].

Now enter the container type as TEXT for both containers. The container border now serves as a visible text frame, so a larger distance has to be set between the text and container border. This can be set in DRAWING INFORMATION (using the I button or DRAWING → GET INFO) in
the Objects panel (the units used in the example can be seen in Fig. 133 [p. 170]).

**Fig. 133:** When a container border is used as a text frame, the distance between the text and the frame has to be extended (section from the Objects panel in the information dialog box, settings of the exercise file).

**Enter Text**

Type the text into the upper, smaller container, which should appear in every copy of the style sheet i.e. in every document torn off from the stationery pad –:

- In the first line you should write “Project Meeting – Minutes”.
- This should be followed by the date in the next line. You could use a formula, which can be best set up via Edit → Insert Special Text. Document Date has been used in this case.
- In the next line you should write “Keeper of the Minutes:”.
- Underneath “Present:”.
- And in the last line “Topics:”.
- There should be a blank line before each of the last three lines of text. You should also utilize the function Windows → Show → Special Characters for improved control!

**Format Text**

Access the Formatting palette again, if necessary, and click on the gray button Text to open the required section. Here you will find all the commands to set the font, styles, alignment and line spacing. You already know the buttons and commands from the tool bar and typography palette (see Exercise 2: Formal business letter with automatic date generation [p. 68]).

- **11-point Arial** is a suitable font for business documents like the already-mentioned minutes. Select the complete text and start converting the font and font size.
The first line serves as the title and should be highlighted. Enlarge the font to 14 POINT and change the text to bold.

The first few lines should be centered. Select both and then press the central alignment button on the palette.

Make the words “Keeper of the Minutes:”, “Present:” and “Topics:” at the beginning of the lines bold.

Set up an extended line space for a date line.

---

**Fig. 134:** The upper section of the subsequent stationery pad for the minutes. Non-printing special characters for the labeling of text wraps, spaces etc. are shown.

You should now also set the font for the larger container in order to ensure that you'll have as little work as possible when using the torn-off documents. For this you should position the cursor in the container (by clicking in the container once) and then set 11-POINT ARIAL as a font.

---

**Save Document as a Stationery Pad**

For further reference: Basic information on the saving of documents can be found in *Saving Files* [p. 45].

The document is now finished and can be saved as a stationery pad. With the command FILE → SAVE DOCUMENT you can access the already familiar save dialog box. Specify where to save and give the document a name, which is as significant as possible, for example “Minutes”.

Select RAGTIME 6 STATIONERY PAD (*.rtt) in the pop-up menu in FILE TYPE and click on SAVE (* Fig. 135 [p. 172]).

Activate the option AS STATIONERY and then click on SAVE (* Fig. 136 [p. 172]).

The document is saved as a stationery pad on your hard disk. You will recognize stationery pad files by the ending “*.rtt” (the abbreviation stands for “RagTime Template”).
Save Normal documents as Stationery Pad: Documents which have already been saved once as a normal RagTime document (with the file ending “.rtd”), can become a stationery pad. Select File → Save As and continue as described here. Previously adapt the document, if necessary, and ensure that all document components, which should not appear in all torn-off documents, are deleted.

Tear Off Copy from Stationery

For further reference: Basic information on the opening of documents can be found in Retrieving and Creating Files: The RagTime Foyer [p. 43].
Tearing off documents from the stationery pad is only slightly different to opening a “normal” document. With the command *File → Open Document* you can access the dialog box typically used by your system, by which you can then navigate to the requested stationery pad. If you select a stationery pad from the file list (e.g. the file you have just saved “minutes.rtt”), the typical *Open* button changes and reads *Tear Off*. If you click on *Tear Off*, a copy of the stationery pad will open as a new document. The name of the torn-off document is formed from the name of the stationery pad by adding the date. You can also tell the difference between the stationery pad and the torn-off document by the file ending “.rtd” for the torn-off documents (and for all other RagTime documents, too) and “*.rtt” for stationery pads.

--- **Tear Off Documents in the Foyer:** You can also use the Foyer to tear off stationery from stationery pads. More information about this can be found in the box “Effectively managing stationery in the Foyer” in a subsequent part of the text.

--- **Open Stationery to Carry Out Changes**

Sometimes it is necessary to modify finished stationery pads. You will not be able to access the stationery pad with the commands *Open Document* and *Tear Off* – by doing this you’ll only just continue creating stationery, i.e. copies of the stationery pad. Instead you need to make an additional click to open the stationery pad itself. In the *Open* dialog box you’ll find the option *Modify Stationery*. Here you have to click to place a tick in a checkbox. If you then select *Open*, the original stationery pad (i.e. “Minutes.rtt”) is opened. After carrying out your changes, you should save and close the stationery pad like a normal document.

--- **Open Stationery for Editing via the Foyer:** You can also use the Foyer to open stationery pads for editing. More information about this can be found in the box “Effectively managing stationery in the Foyer”.

---

**Effectively Managing Stationery in the Foyer**

You can easily manage stationery pads in the Foyer. Regardless of where they are actually saved, your most important stationery pads can be combined to a bundle here; you can arrange for a document to be torn off in the Foyer and also open stationery pads e.g. for changes (Fig. 137 [p. 174]).
Select the panel **FAVORITES** in the Foyer and scroll down a little more. You will then be able to view the section intended for stationery pads (in **TEAR OFF STATIONERY**).

Clicking on the yellow plus symbol accesses a dialog box, which you can use to navigate to your already finished stationery pads and link them to the Foyer. The dialog box is similar to the typical **OPEN DOCUMENT** dialog boxes – you should therefore experience no problems when operating it. The stationery pads should remain where they are saved now – a link is merely set up in the Foyer.

- Clicking on a stationery pad in the Foyer tears off a document (it therefore creates a copy of the stationery pad).
- The context menu provides further opportunities. You can, for example, open a stationery pad via the context menu (not: tear off a document), if changes have to be made within.

**Fig. 137**: In the **FAVORITES** panel in the Foyer you will also find functions for managing stationery pads in a time-saving manner.
In the last exercise you became familiar with the fundamentals of stationery pads on the basis of a one-page document. In Exercise 9 we will now be dealing with stationery pads with more than one page. You will use the business letter from Exercise 2: Formal business letter with automatic date generation [p. 68] as the basis of a multi-page stationery pad. A second, different looking page should also be automatically generated, if required i.e. when the first page is filled. Further following pages (with the same appearance as the second page) should be added if needed. You will learn all about a new kind of pipeline – the circular pipeline – which serves to append pages and you’ll learn about how you can manage the behavior of the torn-off document in the Document Settings.

Fig. 138: In Exercise 9 a stationery pad should be created for a business letter with a front and a following page. The following page is only appended to the torn-off document when the first page is full. It can be appended as often as you require (the representation in the picture is schematic, it does not correspond with the screen representation).
**STEP BY STEP**

**Prepare Business Letter**

Open the business letter created in ▶ Exercise 2: Formal business letter with automatic date generation [p. 68]. Delete all contents, which should not be transferred to the stationery pad and torn-off documents, i.e. the actual letter (dummy) text, recipient address and the entry in “date and reference of your letter” in the reference line.

--->

**Behaviour of Document Date formula in torn-off documents:** If you have executed Exercise 2 exactly as described, there should be a date function in the reference line under the entry “Nut Grove”, which inserts the document date (the date on which the document was created) in this exact position. If the document is saved as a stationery pad, the documents, which have been torn-off, no longer bear the document date of the stationery pad, but the date of the day they were torn off. In Extras → Document Settings → Document you are also able to manually set the document date at all times.

--->

**Add Second Page**

A second page is added to the document when the command Extras → Add Page is activated. As you can see, the second page has inherited the large text container from the first page. If you show the pipelines (Windows → Show → Pipelines) you will see that there’s a pipeline connecting both identical containers – although you haven’t actually installed any pipelines in this document yet. Both the rectangle inherited from the first page and the pipeline are managed by a mechanism for adding pages, which is found by default in every new document beginning with a layout.

--->

You are missing the rectangle on the appended page and there’s no pipeline! Then you probably didn’t carry out Exercise 2 exactly as planned. That is, however, not a problem. With a little bit of work, you’ll soon be able to create a replacement for the missing elements. Draw a rectangle on the second page, which has the width and position of the rectangle for the body of the letter on page 1. The height of the new rectangle can still be adapted in the following steps. Connect both rectangles intended for the body of the letter with a pipeline. Then continue as described in the following exercise steps.

For further reference: You can find out more on using drawing tools in ▶ Exercise 1: Greeting Card with Text and Pictures [p. 50] and ▶ Exercise 7: Working with the Drawing Component: CD Cover [p. 155],
and learn more about pipelines in Exercise 3: Quickly Designed Flyer: Text Container with Pipelines [p. 84].

**Set up Another Page**

Draw a 1 cm high rectangle at the top of the page. Width and distance from the left margin should correspond with the containers on the first page. The second (either inherited from the first page or subsequently added) rectangle should be extended so that it completely covers the page and directly connects to the narrow rectangle above. Use the mouse and move handle and the setting COORDINATES (in DRAWING INFORMATION or in the OBJECT COORDINATES) palette to precisely set the size and position of the containers.

⚠️ **Overflowing Inventory:** You should stop trying to incorporate small elements, which repeat themselves on every page (page numbers, date etc.), into separate containers in stationery pads, which are designed to be the basis for extensive documents. By doing this a considerable amount of components are amassed in the inventory in no time, thus quickly rendering it unusable. In such cases it is better to work with Graphical Text.

**For further reference and further reading:** You can find out more about the Text tool in Exercise 1: Greeting Card with Text and Pictures [p. 50] and more about the usage of Graphical Text in stationery pads in Exercise 10: A Stationery Pad with Different Following Pages [p. 184].

**Information for the Page Header**

Information on the sender and recipient of the letter and on the page numbering should be found in the upper small rectangle. An automatic counter is used for page numbers. Click on the small upper rectangle and write “Roderick S. Quirrel, Kernels, Fruits, Nuts” and below “Recipient:”. You are, of course, only able to insert a recipient’s name in this space once you’ve torn off documents from this stationery pad and are writing the letter.

Reposition the cursor in the first line in order to insert the page numbers and amount of pages. Write “Page” after the company name. Then select **Edit → Insert Special Text → Page Number.** Type “of” after the page number and then select **Edit → Insert Special Text → Amount of Pages.** The page numbering now reads “Page 2 of 2”.

→ **Create Page Numbering with a Formula:** You can also use the formula palette to generate formulas to integrate page numbers and such like into documents – the formulas used are exactly the same, INSERT
SPECIAL TEXT is just a more comfortable entry method for frequently used formulas.
Use the COLLECTIONS sorting feature in the function window. In LAYOUT FUNCTIONS you will find various functions for page references. The references in DESCRIPTION should also help you.

The references on page numbers still have to be aligned to the right. In this case it doesn’t work with default tabs and by repeatedly pressing →. The page references either wrap into a new line or they are not completely indented into the margin. To set a separate tab, use the mouse to click into the text before the page references and press →.

In the row with the tab buttons in the tool bar, click on the third from the left (once!) to select a tab for right alignment. The new tab should be positioned exactly over the right margin stop (the small black triangle). It is, however, not possible to position tabs exactly over the margin stop by mouse click. You should therefore first click in the gray bar to the left of the triangular margin stop, then drag the “Tab Checkmark” further to the right with the mouse until it is congruent with the triangular symbol and the page reference is aligned to the right (Fig. 139 [p. 178]).

Fig. 139: The tab for right alignment of the page numbering is initially set by clicking in the gray bar and then dragged accurately over the right margin stop arrow.
Aligning Tabs to Left or Right Margin

The position of a tab is usually determined by its distance from the left margin. This is characterized by a left-pointing angle under the tab symbol in the ruler. In the ▶ Text Margin Panel [RagTime Reference] the distances are positive figures.

Tabs can, however, also be determined by the distance to the right margin so that they are automatically moved correspondingly e. g. when changing a container width. Such tabs are characterized by a right-pointing angle in the ruler; the position information in the ▶ Text Margin Panel [RagTime Reference] is a negative figure.

Keep pressing $\text{ctrl}$ (Windows) or $\text{cmd}$ (Mac) when creating or moving the tab for changing the margin.

Create Circular Pipeline

Circular pipelines in cooperation with containers and layout components enable new pages to be automatically added to torn-off documents in stationery pads.

⇒ For further reading: Find out more about master layouts in ▶ The RagTime Master Layout: Complex Documents [p. 207].

A pipeline, which regulates the text flow within the two existing rectangles, should now be already included in the document. It should be connected to a circular pipeline, which results in pages being automatically appended. Activate the Vertical Pipeline tool in the tool bar and lay a pipeline. Make sure to remain within the large rectangle on the second page when doing this (▶ Fig. 140 [p. 180]). A small dialog box follows, in which you are asked if you really want to create a circular pipeline (▶ Fig. 141 [p. 181]). Answer the question with yes by clicking on Create.

⇒ Pipeline Representation: To find your way around complex layouts with pipelines and circular pipelines, it is helpful to know the different methods of representation (▶ Fig. 142 [p. 181]).

Settings for Tearing-off the Document

You now have a document, which will be become a stationery pad, with two pages, and a mechanism which automatically appends new pages, if the text containers on the first and second pages are filled.
**Fig. 140:** Installing the circular pipeline. Simply drag the mouse upwards a short distance within the same rectangle when the Pipeline tool is active. In the picture you can also recognize the incoming pipeline from the first page of the document.
Fig. 141: This question is asked in order to ensure that you really want to create a circular pipeline and to inform you that a circular pipeline would still not be effective in the current document.

Fig. 142: Various pipelines and their representation. Rectangle 1 shows an outgoing pipeline. Rectangle 2 comprises an incoming and an outgoing pipeline. In rectangle 3 you can see an incoming pipeline. Circular pipelines are shown as represented in rectangle 4. Circular pipelines can be recognized solely by a small ring symbol, an installed pipeline line, as you know from other pipelines, cannot be seen. In this case you therefore have to look carefully.

Now you can carry out the fine adjustments for the Automatic Page Generation. This can be done in the EXTRAS → DOCUMENT SETTINGS dialog box. In the DOCUMENT panel you will find the options for TEAR OFF FROM STATIONERY (Fig. 143 [p. 182]).

- Check whether the settings should have an effect on the current document only or all new documents in SETTINGS FOR. The setting DOCUMENT “(current document name)” is set as a default preference and should not be changed.
- The default option for the tearing off of documents is TORN OFF COMPLETELY. This means that a complete copy of the stationery pad is created when being torn off from the stationery pad – with all pages and their contents. In this case an important feature of the stationery pad concept still remains unused: the fact that pages are only added when needed. Pages, which would be superfluous in shorter letters,
Fig. 143: Settings for tearing-off the form. The names of the components comprised in the document are listed in Tear Off from Stationery. The contents of these lists can vary depending on whether you have named the components in your exercise document and how you have named them.

now have to be deleted manually from every torn-off document.
Remove tick from the Torn Off Completely checkbox in Tear Off from Stationery to set more differentiated torn-off properties and to specify that the torn-off document initially only comprises the first page.
• Then further options are made accessible for editing, i.e. the torn-off properties of individual components.
In almost all cases it is sufficient to leave the component list the way it is: by placing a tick in the checkbox for the layout component “Layout 1”, components installed in the document are automatically “picked up” when they are being torn-off and following pages are automatically added at a later date.

When does it make sense to activate individual components in the list by ticking the checkbox? Sometimes it can happen that a document comprises components that are not installed in a container, but which are still important. Non-installed components will there-
fore not be seen on the layout page, but definitely in the inventory and, for example, also in the component list in Tear-off Settings. Such components have to be specially activated in the list, if they are to be taken into consideration when the document is torn off. The consistent allocation of recognisable, concise component names is really worthwhile in this case, too!

**Saving the Stationery Pad**

Now the document is finished and can be saved as a stationery pad. The procedure is the same as demonstrated in Exercise 9. Select **Save Document** in File. Specify where to save and enter a file name for the stationery pad in the save dialog box. Specify that the document is not saved as a normal RagTime file, but as a stationery pad.

1. Select **RagTime 6 Stationery Pad (*.rtt)** as **File Type** and click **Save** (Fig. 135 [p. 172]).

2. Place a tick in the checkbox for the option **As Stationery Pad** and then click on **Save** (see Fig. 136 [p. 172]).

→ **Trial run:** If you now tear off a document from this stationery pad, it should comprise a page, the first page of the business letter. Put the rule to the test and fill in the container intended for the body of the text with a text of your choice – use, for example, one of the dummy texts from the training folder (Dummy Text.txt, Long Dummy Text.txt or Lorem ipsum.txt). After the first page is full, a different looking page should be created. If even more text is added, further following pages should be generated. If this doesn’t work, you’ll have to open the stationery pad for editing again and check for the causes. If necessary, repeat the installation of the circular pipeline and check the tear off settings in Extras → **Document Settings** → **Document**.
5.4 EXERCISE 10: A STATIONERY PAD WITH TWO DIFFERENT FOLLOWING PAGES

In the last exercise a stationery pad was created with a first page and a following page. The following page is automatically added, if required, and, if required, repeated numerous times. Sometimes differently designed following pages are, however, also required, which are alternately added to the document. This is almost always the case when a document should be printed and bound double-sided.

Based on the example of a stationery pad, which is suitable as a template for a simple memo, scientific essays and such like, you will learn how to create such double-sided layouts. The stationery pad has three source pages: a front page and two different following pages (designed as mirror images).

Fig. 144: stationery pads also facilitate double-sided layouts where different right and left pages are alternately added (schematic picture, does not reflect the situation on the the RagTime interface).

STEP BY STEP

Create Document and Required Pages

Helpful Shortcut: In the first step of the exercise you will utilize the mechanism that documents beginning with a layout component are provided with by default. It ensures, among others, that the rectangle on the first page is “inherited” to all following pages. Thus all
three pages you have created already comprise a rectangle with the required content type Text. You save having to draw the rectangles by hand and only have to carry out minor adjustments.

You can, however, also delete the supplied rectangle in the new layout component, then add the new pages and draw all the rectangles yourself.

Begin a new document with a layout component. Add two new pages by activating the command EXTRAS \(\rightarrow\) ADD PAGE so that the document now comprises three pages in total. Now let the pipelines be displayed (WINDOWS \(\rightarrow\) SHOW \(\rightarrow\) PIPELINES. Access the Cut Pipeline tool and cut all existing, automatically installed pipelines. A pipeline is in any case not required between the subsequent front page and the following pages. You also have better control when installing the circular pipeline, if you take care of everything manually.

**Fit and Fill First Container**

The first page should be the front page, which deviates from all other content pages. You only need a very small rectangle which is designed to receive the title information. Reduce the size of the existing rectangle and position it centrally in the upper third of the page (\(\uparrow\) Fig. 144 [p. 184]). You can once again use the COORDINATES panel in the DRAWING INFORMATION dialog box or the OBJECT COORDINATES palette in order to arrange the rectangle exactly on the central axis of the page. Click the middle button in the row of buttons for horizontal alignment, then enter the value “10.5” in the entry field below – in case of A4 pages (format: 21 cm \(\times\) 29.7 cm) this is exactly the middle of the short side (\(\uparrow\) Fig. 145 [p. 186]).

You should, of course, not enter a concrete title in the stationery pad for the memo just yet, as this would then be repeated in every torn-off document. It may, however, be sensible to incorporate small notes into stationery pads to jog your memory – especially in the case of more complex documents, which could be used by various users. You should therefore write the following in the title rectangle: “Attention: please delete this text and enter the complete title here!”.

**Set Up Second and Third Page**

The existing containers have to be slightly reduced in size and moved downwards in order to make space for the planned page header (page number and short title). You should first of all change the height of the rectangle on the second page. The height should be 24.88 cm (default value: 26.88 cm). The distance from the top margin has to be raised from
Fig. 145: Alignment of title rectangle. Click on the CENTER button (see mouse position in the picture) and enter “10.5 cm” in the entry field below. You can determine the height of the rectangle according to your visual judgement.

1.41 cm to 3.41 cm (for entry see ▶ Fig. 146 [p. 187]). Carry out the same procedure for the third document page.

**Enter Page Number and Short Title**

The following pages should contain a page number and short title of the memo above the actual contents. The page number should always be aligned outwards (on the margin), the short title should always be aligned inwards (where the fold is after printing and binding). Dummy texts are inserted in the stationery pad for the short title, the page numbers should be added as SPECIAL TEXT (Formula).

Both of these elements should not be placed in the already existing container – after all, the subsequently entered text should flow here. It is also not a good idea to insert the page numbers and short title in a separate container. Every new page would cause the document to unnecessarily expand by yet another component, which would thus soon make the inventory extremely inconvenient. For this reason, recurring elements should be entered as Graphical Text. Graphical Text doesn’t require any containers and is not an individual component.

Guides can be of assistance when aligning Graphical Text. To position guides precisely, you should utilize the guide palette (WINDOWS → PALETTES → GUIDES). A click on NEW (HORIZONTAL) or NEW (VERTICAL) creates a new guide. To change their position, click on the numerical position value of the respective guide in the palette, then you can enter a new
5.4: Exercise 10: A Stationery Pad with Different Following Pages

Fig. 146: The interplay between the entries regarding the size and position of a drawing object is slightly difficult to comprehend at the beginning. You should first of all enter the required size and then the position.

value (Fig. 147 [p. 187]). For the sample document you will require:

- First vertical guide: “1.41 cm”
- Second vertical guide: “19.59 cm”
- Horizontal guide: “2 cm”

Fig. 147: The guide palette. The horizontal guide is currently in edit mode. If you click on one of the small arrows (where you can see the mouse cursor), you will, by the way, also be able to change the guide color.

Now change over to the Text tool in the tool bar. Click in the top left corner on the second document page so that the text entry cursor starts flashing here. You can use the guides to help you. Select the menu command **Edit ➔ Enter Special Text ➔ Page Number.** Then select
the recently entered page number in order to be able to use it for further editing.

⚠ Selection with Graphical Text: Remember that you can select both the text itself for editing and also the whole Graphical Text object with Graphical Text. See also the pictures at the end of Exercise 1: Greeting Card with Text and Pictures [p. 50] for the difference.

For this you should click exactly on the number. It may be somewhat fiddly due to its the rather small size. Increase the display scale of the document (with the symbols on the bottom margin or by activating the menu command WINDOWS → DISPLAY SCALE. Adjust the style to BOLD and align the page number exactly to the guides by using the arrow keys (as shown here: Fig. 148 [p. 188]) Repeat the whole procedure for the top right corner of the third page.)

Fig. 148: Increasing the display scale makes it easier to edit smaller objects like, for example, a page number (Graphical Text).

A short text should be entered opposite each of the page numbers as a dummy text for the subsequent page title. For this you should once again use the Text tool. Click in the top right corner of the second page. Write a short note, e. g. “Please enter the short title here!” Align the text to the guides. Continue analogously with the top left corner of the third page so that the second and the third page are designed to be exact mirror images of each other.
Set up Double-sided Layout

You should utilize the information dialog box to create a double-sided layout. You have probably already noticed that the information dialog box is always adjusted to suit the respectively active component. You therefore have to select the layout component in order to be able to access the Layout Information dialog box. For this you should click on one of the numbered tags. The page, on whose tag you have clicked, is highlighted in color. In the menu you can then select Layout → Get Info. In the Layout Information dialog box you need the panel General. Here you should tick the checkbox for the option Double-Sided (Fig. 149 [p. 189]).

Fig. 149: You require just one click to turn a single-sided layout into a double-sided layout. Double-sided layouts allow you to specify various properties for right and left pages.

You will see that the representation of the pages has shifted on your interface (Fig. 150 [p. 190]). They are no longer one below each other, but offset. And the position of the tags has changed, too.

Install Pipeline, Save Document

Reduce the display scale to ensure that you have a simultaneous view of the second and third document page. The pipeline display should still be active. Click on the Vertical Pipeline tool. Drag a pipeline from the rectangle on the second page to the rectangle on the third page. The
Fig. 150: You recognize a double-sided layout by the arrangement of the pages on the interface and by the tags, which are positioned alternately right and left.
circular pipeline is now not only installed on the last page – as was the case in the previous exercise. Lay a pipeline back from page 3 to page 2. The circular pipeline symbol appears.

You do not require any special settings for tearing off documents as it can be assumed from the first that a longer document of at least three pages is required after the form has been torn off. The document can be completely torn off from the stationery pad.

The memo template is now finished! Save the document as a stationery pad according to the already familiar saving procedure.

---

### Double-sided Document with Two-column Page Layout

The pipeline in a double-sided, one-column document like the memo from Exercise 10 is still quite clearly laid out. It becomes more complicated when a second column is introduced – this is not uncommon in books, brochures and such like.

The individual columns are once again realized as containers. All rectangles first of all have to be connected with a pipeline of the text to flow without any hitches and to ensure that pages can also be added, then you can lay a pipeline back from the last to the first rectangle. In Fig. 151 [p. 191] you will find a schematic representation of the course of the pipeline.)

![Diagram of double-sided two-column document](image)

**Fig. 151:** This is how pipelines are installed for a two-column, double-sided stationery pad (the page arrangement in this figure is schematic and does not correspond with the normal situation on the RagTime interface).
5.5 EXERCISE 11: A SPREADSHEET AS STATIONERY PAD

Your previous stationery pads were based on layout and text components. In this exercise you will be editing a spreadsheet. You will create a spreadsheet for an invoice. Many of the working methods shown here can also be applied to other contexts. They are not exclusively for stationery pads. You will find out how to properly prepare a spreadsheet to be used as a stationery pad and learn many tricks about how to work effectively and save time. By the way, this stationery pad is a fantastic example of how tabular composition can be handled when using spreadsheets.

STEP BY STEP

Begin Document, Set Font
Open the Foyer. In the FAVORITES panel under NEW DOCUMENT BEGINNING WITH COMPONENT you should click on SPREADSHEET.

You should change the default font to ensure that you can get as much onto the spreadsheet as possible, but that it still remains legible. This is best done by changing the character style sheet. For this, select WINDOWS → AUXILIARIES → CHARACTER STYLE SHEET EDITOR. Click on DEFAULT FONT in the tree diagram under the current document name. You can set the font to ARIAL and the size to 9 point. The font also fits in well with the businesslike character of the document. Leave the dialog box by clicking on the button CLOSE.

Add Contents to Document
Contents should be initially added to the document in the following sections and it should be superficially designed, any details in the layout are dealt with when the entries are complete. Below you will once again find all the information needed including the respective cell addresses.

⚠️ Stick to Exact Cell Address: It can be rather tiring to enter the contents cell by cell and you may feel the urge to work “carelessly”. It is, however, essential that the cell addresses correspond exactly with the specifications in the exercise for the formulas in this exercise otherwise they won’t work. It is worth making the effort, because you will once again gain an exact insight into the workings of formulas and cell referencing.

• Write “Roderick S. Quirrel” in cell A1.
• Underneath in cell A2 you should then write “Kernels, Fruits, Nuts – Wholesalers & Retailers”. The neighboring cells, A1 and A2, remain
Fig. 152: An invoice like this can be generated from the spreadsheet without requiring the use of a text component (view without the non-printing elements).
empty so that longer lines of text can be easily shown. It is not necessary to join cells beforehand.

- Cell A6 incorporates the sender information. Enter “R.S. Quirrel, Nut Tree Avenue 12, 34567 PublicVille”. This row can be minimised immediately and set to UNDERLINE WITH ONE LINE.

--- Required font size or unit is not on the selection list? The example shows a 6 POINT font. The size is not provided in the font size lists in the TYPOGRAPHY palette or the FORMATTING palette – here you’ll only find the most popular units. Other sizes can be entered manually (Fig. 153 [p. 194] and tip Font Sizes and Units [p. 195]).

In DOCUMENT SETTINGS you will find the option DEFAULT UNITS in the DOCUMENT panel. Here you can specify whether text sizes are displayed in the typographical unit of points (pt), in pixels (px) or in other units. This setting has an effect on all other font sizes in the program, but only applies to the respective document.

![Fig. 153: Manually enter font size in two steps (here based on the example of the FORMATTING) palette: 1 Select and delete the previous value, 2 Enter a separate font size.](image)

- In the cells A8, A9, A10 and A11, which are located underneath each other, the respective receiver of the invoice should be subsequently entered. You are once again working with dummy texts here – as a tip for subsequent usage, as a layout aid and for testing formulas used. You should therefore enter any sample address of your choice here, for example, (each in their own line) “Mrs.”, “Janet Q. Public”, “17 Heather Street” and “London 12345”.
- Enter “INVOICE” in cell A18.
- In cell A20 you should enter “Always quote in case of payments and correspondence:” and behind that in cell E20 “Customer No.”. In cell F20 you should add a number of your choice as a dummy text. The dummy texts are then highlighted in color in the next step so that there is no way of missing them.
• Now all you need to add are the details regarding the invoice date. Enter “invoice date” in cell E21, in the neighboring cell, F21, add a date, which is automatically updated when the document is torn off. You can do this by using Edit → INSERT SPECIAL TEXT → DOCUMENT DATE (SHORT).
• Now enter “VAT” in cell E23, and next to it in F23 “16%”. Observe how RagTime is able to individually recognize this value format and can convert this entry to “16.0 %”!

**Font Sizes and Units**

If you manually enter the font size, you do not necessarily have to enter your preferred unit as well. You can set the default unit for TEXT SIZES in the EXTRAS → DOCUMENT SETTINGS dialog box in the DOCUMENT panel under DEFAULT DISPLAY UNITS.

If you happen to need another unit, which is different to the default unit, you are able to enter it manually at all times – and RagTime is relatively fault-tolerant in this respect, accepting upper and lower case letters and tolerating if you forget to enter a space.

**Set Up and Use Character Style Sheets**

For further reference: Exercise 5 shows how style sheets are created and used on the basis of character style sheets (see section Create Character Style Sheets for Formatting [p. 126]) for more info on this topic.

You now still require a larger font as a heading and highlighting for the dummy texts – to ensure that these are not inadvertently left instead of the correct information in the document – because the default character style sheet for this document has already been changed.

Select the contents of cell A1, the company name “Roderick S. Quirrel”, to create a template for the headings. Increase the font to 12 POINT and set the font to BOLD. Then select WINDOWS → AUXILIARIES → CHARACTER STYLE SHEET EDITOR and click there on the button CREATE FROM SELECTION. Give the new character style sheet a sensible name, for example “heading”. The font in cell A1 is allocated to the style sheet. The dialog box window can remain open.

You could try out the procedure to create a character style sheet for the dummy text with the FORMATTING palette. Simply open the palette
by clicking on the “Pen Knife” symbol. Select a text, which should serve as a dummy text, e. g. the customer number. Change the font color in the Formatting palette in Text. Set, for example, magenta as the font color. Do not deselect the text. Change to the section CHARACTER AND PARAGRAPH STYLE SHEET in the Formatting palette. A click on the yellow plus symbol (Fig. 154 [p. 196]) accesses a small dialog box (Fig. 155 [p. 196]), in which you can create a name for the new style sheet.

**Fig. 154:** You can also change the font properties by activating the FORMATTING palette and setting it as a style sheet. By clicking on the yellow plus symbol you can access a dialog box ...

**Fig. 155:** ... where you can name the new style sheet.

Both new character style sheets will now appear in the character style sheet selection lists. The character style sheet “dummy text” should be assigned to the dummy text and the address (the customer number is already in this format). For this, all you have to do is select the respective cells and click on the style sheet in the list (in the TYPOGRAPHY or FORMATTING palette). Do the same for the heading “Invoice” using the style
sheet “heading”.

**Label and format the “table heading”**

Even if the whole document is a table and the following line is strictly speaking an interim heading at best – the line is perceived as a table heading in the printout.

Consecutively enter the following into the cells beginning with A25 and ending at F25:

- “Pos.”
- “Quantity”
- “Item No.”
- “Name”
- “Unit Price”
- “Amount”

Then select the cells from A25 to G25. To highlight the cells in gray, you have to once again create a style sheet – a separate fill style sheet. First of all, you will need to set a new color for the selected cells, e.g. light gray, in FORMAT → COLOR. Access the FILL STYLE SHEET EDITOR (WINDOWS → AUXILIARIES). Here you should click once on the document name in the style sheet list to properly integrate the new style sheet and then click the CREATE FROM SELECTION button. Call the new selection “Highlighted Cells”. Close the window and keep the cells selected: here you can also set the font to bold.

**Combine Style Sheets:** It is also absolutely possible to combine various style sheets to therefore, for example, specify a character style sheet for making the table interim heading bold and then to use this for cells, which have just been assigned the fill style sheet. This would, however, constitute an unreasonably high amount of time and effort in this case – especially as button B is so easy to operate.

**Enter Items and Prices, Set up Columns**

Now we have to start entering the items and prices. As we are definitely dealing with dummy text in this case, you can make your own choices. You can utilize the automatic row filling system for the sequential numbers in “Pos.” (as described in Exercise 4 in Spread Formulas to other Cells [p. 114]). The entries in “Amount” are calculated using a formula.

Formulas and value formats are assigned in the next step, that’s why you do not need to enter any commas, currency symbols or such like here.

You should now assign the “dummy texts” style sheet to the dummy texts again. The contents of column F (“Amount”), which will be calcu-
lated by means of a formula and added at a later date, are, however, not dummy texts.

---

**Inserting Symbols**

If you have had a good look at the example (Fig. 152 [p. 193]), you have maybe noticed a special feature in the list of articles: the product “Squirrel DeLuxe®”. Such symbols and many other symbols, too, can be inserted using the command Edit → INSERT SYMBOL. The symbols that are available to you depend on the fonts available on your computer. The SYMBOLS dialog box has three panels:

- **Unicode** is a norm, which arranges the characters of most script systems throughout the world (modern and ancient script systems) in a uniform code. The UNICODE CHARACTERS panel shows all symbols, which are available in installed fonts on your computer (provided that the file containing the font has a modern layout conforming to norms).
- **The panel Glyphs** offers a selection of all available characters sorted according to font.


- **In Favorites** you can store frequently required symbols and also specify keyboard shortcuts for them.

To insert a symbol you have to select it in one of the three panels. Then click INSERT SYMBOL. The command ADD TO FAVORITES adds a symbol to the Favorites panel.

---

**Adjust Columns, Align Cell Contents**

→ For further reference: change column or row size You can find out more about the procedure in Exercise 4, section → Change Column Width [p. 108].

If you haven’t done so already, now’s the time to adjust the width of the columns. You can adjust the width of the columns to suit the contents of the columns by dragging on the markers for the column borders.
in the gray column title bar. Exact details can be entered in the ARRANGE-
MENT panel in the SPREADSHEET INFORMATION dialog box or also in the
OBJECT COORDINATES palette. The following measurements were used in
the sample document:

- Column A: 1.9 cm
- Column B: 1.9 cm
- Column C: 1.9 cm
- Column D: 4.6 cm
- Column E: 2.0 cm
- Column F: 2.0 cm
- Column G: 3.6 cm
- In addition, the row height in row 26 has been manually enlarged
  slightly to create a slight gap between the row and the “headline”.

Automatically Split Columns or Rows: Apart from manual adjust-
ments, there is also another procedure for splitting columns or rows:
Select the columns or rows to be changed and click SPREADSHEET →
OPTIMISE COLUMN WIDTH / ROW height. Or use the buttons AVER-
AGE WIDTH TO FILL CONTAINER WITH SELECTED COLUMNS OR AVERAGE
HEIGHT TO FILL CONTAINER WITH SELECTED ROWS in the SPREADSHEET
INFORMATION dialog box in the ARRANGEMENT panel. The results are,
however, difficult to predict in both methods – you will have to do
the work by hand in case of special layout requirements.

Invoice Amount and Time of Payment
You still need to add information on the time of payment and invoice
amount, which should be entered in the lower section of the table.

- Underneath (E57) “10 % Discount”.
- Then (E58) “Net Amount”.
- In cell E59 “VAT”.
- In cell E60 “Sum” (bold).
- Write “Payable by:” in cell E65.
- Add the term of payment in cell F65. For this you should use a for-
mula. Select the cell, open the formula palette and click into the
entry field so that the entry marker starts flashing. Enter the address
of the cell with the date (F21) or click on the cell in order to insert the
address into the formula. Enter + 30 for a thirty-day payment term.
Close the entry by clicking on the green checkmark. Make both en-
tries bold.

The fields behind the entry amounts are subsequently filled using a
formula.
Align Cell Contents

Now the contents of the cells still have to be aligned within the cells. The description seems to take longer to read than it actually takes to carry out the alignment. The spreadsheet benefits from this alignment; it becomes more legible and looks even better!

You may have already noticed, but the tool bar always displays the typical table tools and control fields when you’re working in a spreadsheet. The functions, which you were able to use for paragraph design in text components, are not displayed. You can benefit here by using the FORMATTING palette. There is, however, a special setting opportunity for spreadsheets, which can be found in the ARRANGEMENT panel in the SPREADSHEET INFORMATION dialog box. Here you are not only able to center the cell contents, but also adapt the position relatively to the cell height. It is also possible to set the spaces between the cell contents and the cell borders in this panel. You should always make use of this opportunity if you are working with printing cell borders. That way you'll stop the cell contents from coming too close to the cell borders.

You do not use the same alignment everywhere for the present document; you therefore have to set various different selections one after the other and respectively implement the correct settings in the ARRANGEMENT panel.

- Select the whole spreadsheet (e.g. with the command EDIT → SELECT ALL). Activate vertical alignment and set the gap to the cell border in the ARRANGEMENT panel (as shown in Fig. 156 [p. 201]).
- Select the cells, whose contents are to be centered (horizontally). Mouse over cells A25 through to F53 diagonally to create a larger selection block. Then press ctrl (Z) or c (Z) in order to select additional sections. Select cells E25 and E24 (“Unit Price” and “Amount”), the cells F20 and F21 (“Customer Number” and “Date” and the cells with the information on VAT (E23, F23).

You should then once again access SPREADSHEET INFORMATION and the ARRANGEMENT panel and then center the cell contents (Fig. 156 [p. 201]).

Enter and Copy Formula

Now you still need to enter the formulas. The details have to be calculated in “Amount”.

- Click in the cell underneath “Amount” (F26) and open the formula palette. Here you should click once into the entry field. Required is a multiplication of the value specified under “Quantity” with the value “Unit Price”. You therefore have to enter B26*E26 and confirm.
This formula is copied into the cells below, and in fact not just into the cells, which you have already filled with dummy texts, but into all cells, which will possibly be filled in the torn-off document. Longer calculations may also be necessary. Select the cell with the result, F26, and extend the selection area over the whole column right down to cell F53. Pay careful attention to the shape of the mouse cursor, the double plus symbol.

From now on only the formulas required for each cell will be provided, as you should already know how to handle the formula palette by now (if in doubt turn to Preparation: Spreadsheet Basics [p. 93]). A formula, which forms the sum of all values of the cells above (F26:F56), has to be added in the cell to the right of “Gross Value of Goods”. The formula \( \text{Sum(F26:F53)} \) will help you.

⚠️ Do all cell addresses correspond with each other? The formulas contain cell addresses and these only work if you have up to now fastidiously stuck to all details for entry. If necessary, you will have to correct the cell addresses in the formulas, if the table construction in your example deviates somewhat from the descriptions above.
### INVOICE

Always quote in case of payments or correspondence.

<table>
<thead>
<tr>
<th>Item No.</th>
<th>Name</th>
<th>Unit Price</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>12345</td>
<td>Hazelnuts, finest quality</td>
<td>1.6</td>
<td>2.5</td>
</tr>
<tr>
<td>34289</td>
<td>Pistachios, whole, unsalted</td>
<td>2</td>
<td>3.2</td>
</tr>
<tr>
<td>98765</td>
<td>Hazelnuts, roasted</td>
<td>2.6</td>
<td>3.1</td>
</tr>
<tr>
<td>98121</td>
<td>Pine nuts</td>
<td>2.8</td>
<td>3.1</td>
</tr>
<tr>
<td>11256</td>
<td>Hazelnuts, roughly chopped</td>
<td>3.3</td>
<td>3.3</td>
</tr>
</tbody>
</table>

The formula for the discount is:

\[ F56 \times \frac{10}{100} \]

The net amount is, for example, calculated using:

\[ F56 - F57 \] (Gross Value of Goods minus Discount).

The VAT refers to the above-mentioned tax rate. In case of alterations, you have to then only correct a number in the stationery pad. The formula is:

\[ F58 \times F23 \] (16% of the net amount).

To calculate the sum add the net amount and VAT by means of the formula:

\[ F58 + F59 \]

---

**Set Value Format, Hide Zeros and Set Precision**

A somewhat more complex selection is once again required. You can use

> [Fig. 159](p. 204) [p. 204] for improved orientation.

You should therefore set the value format to **EURO – €**.

The entry “€0.00” may now appear in some cells. In these cells a formula has been copied, its reference cells (details in “quantity” and “unit price”) are, however, still empty. These zeros would naturally interfere in torn-off documents. You do not, however, have to manually delete the formulas in every torn-off document to get rid of the zeros – after all, you did add them to save you a procedure (namely transferring the formulas).
when using the document. Select the cells with superfluous zeros and access the Spreadsheet Information dialog box. In the Cell Contents panel you should tick the checkbox for ZERO VALUES HIDDEN. In the same panel you can also specify that the invoice should be commercially rounded. For this you should use the option PRECISION AS FORMATTED.

**Business Details and Logo**

Select the lower three rows and combine them to form one cell (e.g. by using the Context menu command CREATE UNION). The business details from the letter in the second exercise can be simply copied to save time. Access the document, select the text and use the menu command EDIT → COPY. Close the letter document. Insert the copied text into the combined cell using EDIT → INSERT. Set the cell to the value type MULTILINE TEXT to ensure that the multiline text is correctly displayed (with the appropriate button in the tool bar).

As already mentioned, spreadsheet cells can also act as containers and therefore incorporate other components like, for example, pictures. Select cells G1:G9 and unite them. Here the picture Logo 2.png should be inserted. You will find it in the training folder.
### Fig. 159: The cells are selected, the value format can be changed.

#### Design Cell Borders

Some cell borders in the spreadsheet should be given a printing border for improved clarity. For this you should initially define a line style sheet. This procedure is not much different to that known to you in character and fill style sheets. Select **Windows → Auxiliaries → Line Style Sheet Editor**. Here you should quickly click on the document name and then on the button **Create**. Give the new style sheet a significant name, e. g. “invoice borders”, then change the settings. The sample document shows changes in the **dashes**, a dotted line should appear instead of a continuous line. Close the dialog box with **Close**. The new style sheet should now appear in all dialog boxes which provide access to line style sheets.

**Borders** (in **Spreadsheet**) is such a dialog box. You already know the function (**Fill and Format First Row** [p. 104]). Now set the borders as shown in **Fig. 152** [p. 193].

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td></td>
<td>E</td>
<td>F</td>
</tr>
<tr>
<td>22</td>
<td></td>
<td>VAT</td>
<td>0.16%</td>
</tr>
<tr>
<td>24</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td><strong>Name</strong></td>
<td><strong>Unit Price</strong></td>
<td><strong>Amount</strong></td>
</tr>
<tr>
<td>26</td>
<td>Hazelnuts, finest quality</td>
<td>2.5</td>
<td>25</td>
</tr>
<tr>
<td>27</td>
<td>Hazelnut kernels, roasted</td>
<td>1.5</td>
<td>4.5</td>
</tr>
<tr>
<td>28</td>
<td>Pistachios, whole, unsalted</td>
<td>2</td>
<td>10</td>
</tr>
<tr>
<td>29</td>
<td>Pistachios, roasted and salted</td>
<td>2.6</td>
<td>31.2</td>
</tr>
<tr>
<td>30</td>
<td>Pine nuts</td>
<td>2.8</td>
<td>14</td>
</tr>
<tr>
<td>31</td>
<td>Hazelnuts, roughly chopped</td>
<td>3.8</td>
<td>3.8</td>
</tr>
<tr>
<td>32</td>
<td>Squire Deluxe®</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>34</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>49</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>52</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>53</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>54</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td>Gross Value of Goods</td>
<td></td>
<td></td>
</tr>
<tr>
<td>56</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>10% Discount</td>
<td>9.25</td>
<td></td>
</tr>
<tr>
<td>58</td>
<td>Net Amount</td>
<td>83.25</td>
<td></td>
</tr>
<tr>
<td>59</td>
<td>VAT</td>
<td>13.32</td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>Sum</td>
<td>96.57</td>
<td></td>
</tr>
</tbody>
</table>
Hide Cell Grid Lines: If the cell grid lines interfere when creating the lines or if you want to permanently hide them within the document, then you can do this in the General panel in the Spreadsheet Information dialog box. Use the options in Cell Grid Lines. In contrast to the complete hiding of non-printing elements (Windows → Show → Non-printing Elements), you are able to differentiate here whether you would like to hide vertical or horizontal cell grid lines (or both).

By the way: the settings Lines in Front, which you will find there, are only interesting if horizontal and vertical lines are highlighted in different colors. They do not have an effect on black or finer lines.

Save Stationery Pad

Save the document as a stationery pad, according to the already familiar saving procedure. Cell contents entered as a test, which should not be transferred to the stationery pad, have to be deleted prior to saving.

Library: Transferring Pages from Existing Documents

Prepared pages can be automatically added in stationery pads and master layouts. RagTime furthermore provides an opportunity of manually adding finished pages to a document using the so-called library. Every RagTime document can be a library for another RagTime document. You can set any document of your choice up to be a library for another document – this way pages from already existing documents, which have already been designed, can be reused.

The procedure is quite simple: your main document has to be open. With the command File → Select Library you can access a dialog box, which is similar to the well-known Open dialog box. You can then navigate to the document you want to use as a library. A click on Open sets it up as the library for the main document. The library document is then opened in a separate window – extremely minimized. From here you will be able to drag and drop individual pages into the main document ( Fig. 160 [p. 206]).

The connection between the main document and the library remains in existence until another document is specified as being the library. If the added library page has got a pipeline to another page of the library document, this will also work in the main document.
and automatically add following pages from the library document to the main document.

⚠️ **“Drop” precisely**: It is important that you aim accurately when transferring the library page to the main document: you have to aim to drop the library pages exactly above the light gray area next to or between the pages of the main document. This area is shown to be darker in color when the mouse is in the correct position. The added page from the library can then be edited as per normal.

If it is in the way, you can also close the library window. The command **File → Open Current Library** reaccesses it again.

**Fig. 160**: A page is just being transferred from the library to the main document.
CHAPTER 6

The RagTime Master
Layout: Complex
Documents
6.1 WHAT ARE MASTER LAYOUTS ABLE TO DO?

The tasks that the stationery pad and the master layout fulfill are, at first glance, extremely similar. Both are supposed to easily prepare pages in a layout, which you have previously defined, and automatically append new pages to the gradually expanding document. The functional principle of both instruments is, however, extremely different – thus resulting in different areas of application.

A document torn-off from a stationery pad may be a copy of this stationery pad, but it is otherwise a completely separate document. If the torn-off document boasts “automatic” page appending settings, then a link to the stationery pad is retained: and the torn-off document gets information on the pages to be appended from the stationery pad. Otherwise stationery pads and the torn-off documents are completely unrelated: alterations to the stationery pad no longer influence the previously torn-off documents.

The relationship between the master layout and the document, whose appearance it forms, is completely different. The master layout is a component and as such it is an inherent part of the document. While you are able to generate as many copies as you like from a stationery pad, master layout components only ever work on the document, which they are a part of. Master layouts can, however, as with other components, be copied into further documents. A document can have either no, one or numerous master layout components.

Documents with master layouts in the form of a stationery pad: The master layout and the stationery pad are not completely incompatible concepts. It is also possible to save a document with master layout as a stationery pad, if you want to make use of the features of the stationery pad (e. g. creating a copy by double clicking in the Windows Explorer or finder or initializing the date of the document).

A multitude of differently designed pages can be generated in master layout components – far more than is possible with stationery pads. These master layout pages (often described as “master pages”) shape the appearance of the slave layout pages. The sequence, in which pages are appended, can be explicitly controlled.

You then effectively use two different approaches at once to edit a document: the master layout component consists of the layout frame and presets for appending the differently designed pages. In the layout component you then amend this layout frame and fill it gradually with contents.
6.1: What are master layouts able to do?

Fig. 161: The master layout shapes the appearance of the layout pages. You can explicitly control how the various master layout page types are used in the layout. Master layout and layout pages can comprise various components. Containers with master pages appear fixed in layout pages.

Master layout components and layout components remain connected to each other. Changes to the master layout have an immediate effect on all slave layout pages.

Master layout components can be used profitably in all the following situations due to this multitude of properties.

- **For documents whose design is developed step-by-step:** While a stationery pad should be completely finished before documents are torn off, master layout components permit the step-by-step development of layouts. Alterations in the draft phase are especially easy with the help of the master layout component and the design of an expanding document can be continually amended. Subsequent changes to finished layouts are also easily made.

- **For extensive documents, in which numerous different page types are required:** Master layout components permit the definition of as many different page types as required by users and provide commands, which determine their sophisticated usage.
• **For sophisticated layouts, which should be managed and used effectively:** You can also create extensive documents with elaborate layouts with simple documents and stationery pads. The time spent is possibly, however, disproportionately greater than when using master layout components. Well-planned work with master layouts saves you many unnecessary procedures and mouse clicks and therefore a lot of time. The management of layout information in master layout components also helps prevent errors: if the same detail has to be altered in 30 document pages, it can easily be overlooked somewhere. When working with master layouts, changes are made in a central location and automatically passed on to all pages based on the master layout.
In the first practical master layout exercise you will be creating a comparatively simple document with just two different master pages. Nevertheless, you will still get to know all the most important steps for working with master layouts here.

**Fig. 162:** You will generate a document like this with a front and simple following page in your first master layout exercise.

**STEP BY STEP**

**Start Document with Master Layout**

Open the Foyer and start a new document with the component **Master Layout**. The new master pages are completely empty without a rectangle. The tag is in the center – an important tip for you to differentiate between the normal layout pages and master layout pages in documents, which have both. The usual layout tools can be seen in the tool bar.

**Summarized in Short: The Steps to Achieving a Master Layout**

Regardless of how complex your document should be or how sophisticated the (master) layout is: the steps are basically always the same.

- **Begin new document with Master Layout Component.** Though it is possible to add a master layout component to existing documents, it is rather elaborate to subsequently link existing layout components to the newly added master layout. It is therefore more advantageous to start with the master layout component.
Decide how many differently designed pages you require and generate the required amount of pages. You do not have to specially generate a right and a left page, if your layout should be double-sided, – the master layout does this automatically, if required. It is sufficient if you generate and design half of the double page (see Exercise 13: Double-sided Master Layout with Front and Back Page [p. 226]).

Structure the pages according to your personal requirements. Containers and guides for the page splitting, design elements like lines, page numbers (as graphical text [p. 216]) and texts and other elements, which should not longer be changed, can be sensibly placed here.

Specify the usage rules for the master layout components.

Specify which pages should be double-sided, if required.

Install pipelines, to regulate the flow of the contents from container to container.

Generate a layout component by using the master layout component.

Specify the Content type for the available container.

Edit layout pages. Install components in the container, amend further containers, append pages (the sequence of the appended pages is carried out as laid down in the usage rules) and insert the contents into the document.

Draw Rectangles

The document should contain two different page types – the front page and the following page – so the master layout component requires two pages. You can generate a second page in the master layout component with the already well-known command EXTRAS → ADD PAGE.

Three rectangles should now be drawn on these pages. It lends itself to work with guides, for the fine adjustments you can also use the palette OBJECT COORDINATES or the Info dialog box.

For further reading: Find out more about the palette GUIDES in the section Enter Page Number and Short Title [p. 186] in exercise 10.

The necessary guides are easily created in the palette GUIDES: you simply need to click on the appropriate NEW button in the palette, adjust the measurements – then you are ready. The guides used on the first
page in the sample document (Label in Tag: STANDARD) have been given the following positions:

- Vertical: 2 cm
- Vertical: 10.5 cm
- Vertical: 19 cm
- Horizontal: 1.5 cm
- Horizontal: 5.5 cm
- Horizontal: 6.5 cm
- Horizontal: 27.7 cm
- Horizontal: 28.7 cm

And on the second page (MASTER PAGE 1 – more on the function of this labelling later on) the following guides are available:

- Vertical: 2 cm
- Vertical: 10.5 cm
- Vertical: 19 cm
- Horizontal: 1.5 cm
- Horizontal: 27.7 cm
- Horizontal: 28.7 cm

Guides in Master Layout: Guides are naturally not only a good layout aid in the master layout. Guides of a master layout component also appear in all slave layout components. This way you can, for example, highlight the print space, columns etc. in the master layout. It is especially helpful if you are planning to also insert containers and other elements into the layout itself.

Now you can activate the rectangle tool and draw two rectangles (one narrow one above and one larger one below) on the first page and draw a large rectangle on the second page within the guide grid (Fig. 163 [p. 214]).

Container Content Type in Master Layout: If the content type for a container has been determined in the master layout, then it can no longer be simply changed on the slave layout pages. It is therefore often better to wait and specify the content type in the layout pages. Containers in the layout may also subsequently be made to be independent of the master layout, but you then lose the most important advantage of the master layout concept: the respective element is now completely disconnected from the master layout and changes in the master layout no longer have an impact on this element.
Enter Title Information
The smaller rectangle on the first page should contain title information. Select the rectangle and convert the content type with the help of the tool bar or command DRAWING → CONTENT TYPE → TEXT. Enter a title for the planned item list. This text is used in the sample document:

- First line: “Major & John Q. Public Fruit Production”
- Below: “Item list”.
- Both lines have been written and centered in a 20 point font; the lower line is additionally bold.

Place Picture Behind Text
Containers can be stacked on top of each other and the “stacking sequence” can be altered. This way it is, for example possible to add pictures to the text as shown in the exercise document in the title section. The procedure is quite easy, the only difficulty being that containers located lower down in the stack cannot be selected as well, if they are smaller than or the same size as the container above.
6.2: Exercise 12: Illustrated Item List with Master Layout

**The procedure in five easy steps**

1. Draw a container, which should accommodate the picture. At present it doesn’t matter what the position the document is in, because it can be moved at any time. If you make the container for the picture slightly higher or wider than the container, under which it will subsequently be stacked, then this will help when selecting the picture container for any subsequent changes (the picture container in the exercise document is $4 \text{ cm} \times 4.5 \text{ cm}$ in size).

2. Put the picture inside. Use the graphic `Logo 3.eps` from the training folder.

3. Move the picture container to the required position, ideally so that it projects somewhat over the text container in one place (Fig. 164 [p. 215]).

4. The commands for container stacking can be found in the menu under **Drawing → Stacking** and in the context menu (mouse click close to container borders). Here you should select the command **Send Backward** or **Send to the Back**.

   *→* **Send One Step or Completely to the Back**: Both commands have the same effect, because only two containers are involved here. They are, however, by all means different in stacks with more than two containers. **Send Backward** sends the container selected only one step back, i.e. below the next lower container in the stack. **Send to the Back** sends a container to the lowest position in a container stack. The commands to bring containers to the front work in a similar manner.

5. You will now see that the picture has been mainly hidden by the text container. Select the text container. Instead of the default fill, you should now assign a transparent fill by using **Format → Fill Style Sheet → Transparency**.

---

**Fig. 164**: Containers can also be stacked on top of each other. In this case a picture container has been moved underneath a text container.
The picture now becomes visible again.

**Install Pipeline**

You can manage without circular pipelines in master layouts, because appending the various pages is dealt with in a completely different way (see below for more information on this topic). Pipelines are, however, still required to regulate the text flow between the individual containers. You should therefore select the Vertical Pipeline tool and connect the up-to-now empty rectangle on the first page to the empty rectangle on the second page by means of a pipeline.

**Add Page Numbers**

→ For further reading: Adding page numbers is described in detail in Exercise 10: A Stationery Pad with Different Following Pages [p. 184].

It is recommended that you use the Graphical Text tool for page numbers in the stationery pad; in master layouts it is mandatory for the page numbers to be created as Graphical Text so that the automatic numbering can work. Change over to the Graphic Text tool and use the commands Edit → Insert Special Text → Page Number and Amount of Pages to add the page numbering. You can use the guides to help you make alignments.

→ Quickly Get Rid of Guides: The guides are no longer required. The quickest way of deleting them is to use the button DELETE ALL in the palette GUIDES. This command deletes all guides on the active page.

**Set Rules for Using Pages**

The master layout has been generated. Now you still have to determine when to use which master layout page type in the layout component pages. The first master page (tag GENERAL) should be used as the front page in the layout, the second master page (tag MASTER PAGE 1) should act as the template for all further pages.

Select the first master page (tag GENERAL) by clicking on the tag. Access the information dialog box by using the i button or via Layout → Get Info. Change over to the panel MASTER PAGES (Fig. 165 [p. 217]).

Activate the option This Master Page Will Be Used for Pages Whose Index Counted from the Start Is Specified in Utilization and type a “1” into the entry field below.

→ First Page: You can select the setting This Master Page Will Be Used for Pages Whose Number Is Specified and then type “1” –
Fig. 165: Specifying utilization of a master page. Formulas and functions can also be entered – as indicated by the Abacus button and the $f$. The shape of the mouse pointer shows that you can also enter references to spreadsheet cells in the formulas by means of clicking or dragging across them with the pointer. A simple “1” is, however, sufficient for the exercise document.

this option would have the same effect as *Whose Index Counted from the Start Is Specified* for the current sample document.

In documents with numerous layout components deriving from the same master layout, e.g. numerous chapters in a book, the layout components do not always start with page 1. For a layout you can determine on which page number the layout should begin in the panel **General** in **Layout Information**. In such cases, the options **This Master Page Will Be Used for Pages Whose Number Is Specified** and **Whose Index Counted from the Start Is Specified** have a different effect.

You can also still change the page title if you enter another description instead of the “General” description, in the small entry field. The new title then also appears in the tag. This is especially helpful when working with documents which contain various master pages. Confirm the procedure by clicking **OK**.

Select the second page and access the dialog box again. Activate the
setting This Master Page Will Be Used for Pages To Which No Special Rule Applies. You can also change the title (e. g. to “Other Pages”) and confirm by clicking OK.

Change Name of Master Layout Component: The names of the master layout components are also used in various parts of the program, e. g. if you add a new layout component to the document. If only one master layout exists for the document, then the default name “Master Layout 1” is sufficient. If a document, however, contains various master layouts, then clear names are helpful.

You can change the name of a master layout – as with all other components, too – in the inventory. This change has an effect on the display in all other parts of the program. Why not check it out and rename the master layout to “Master Layout Item List”. For this you have to click on the component name in the inventory twice in succession (not a double click!). The name then changes into a small entry field.

Master Page Usage at a Glance

Alongside the two methods of usage for master pages, which are used in this exercise, you are also provided with a whole host of other options, with which you can specify the usage of individual master pages as a template for layout pages in detail.

- The setting To Which No Special Rule Applies should be used to define a default page, a document page, which is always used if none of the cases determined by other options apply. Exactly one page of the master layout should always utilize this setting. If pipelines are used, one container with the pipeline should be on the page with this usage rule.

- You can specify an absolute page number by using the option Whose Number Is Specified, which you can then enter into the entry field. If the specified page number is reached in the document, then the page defined in this case is used. If the page number in the document is not reached, then the page defined as a master page is not used.

- The setting Whose Index Counted from the End Is Specified works similarly, although pages are counted from the front within the layout and absolute page numbers are not considered.
• Use the option *Whose Index Counted from the End Is Specified* to append pages to a layout as last pages. Properties are otherwise the same as in *Whose Index Counted from the Start Is Specified*.

• With formulas and functions it is well-known that you can do a whole lot more than just issue page numbers. The option *If the Specified Formula Returns True* is always applied if you want to use more complex formulas. The pages so labeled as such are always applied, if the formula used returns the truth value `TRUE` as a result.

If more than one page meets the specified conditions, RagTime utilizes the first page found. Pages with the setting *Whose Index Counted from the Start Is Specified* and *Whose Index Counted from the End Is Specified* are prioritized.

⚠️ **Only enter the same index counted from the front or back for one page respectively:** if you enter the same index counted from the front or back (i.e. the same number) for numerous pages, then only one of these pages will show up later on in the document. You are therefore not able to, for example, enter *Whose Index Counted from the End Is Specified*: “1” for more than one page.

If a layout derived from a master layout doesn’t work as expected, it is always worthwhile checking whether potential contradictions can be found in the usage rules! A second frequent cause of malfunctions is incorrectly installed pipelines.

**Add Layout Component**

Up to now the document only contains the master pages. Click on **Windows → New Component → Layout**, in order to add a layout component to the document. A dialog box appears, in which you are asked whether the new layout component should be dependent upon a master layout component and which one it should be dependent upon(*Fig. 166 [p. 220]*).

Activate the name of the master layout component and click on **Select**. If you open the inventory, you’ll see that the document now also has a layout component. It is also easily recognizable when viewing the tags: you now no longer have the master pages, but layout pages in front of
Chapter 6: Master Layout Components

Fig. 166: If the document contains master layout components, you can specify which master layout component it should be dependent upon when creating new layout components.

you. If you have done everything right when specifying the usage conditions of the pages in the master layout, the layout component will initially appear with one page – the front page.

Create and Adjust Spreadsheet Component

You continue working on the recently generated first layout page. Activate the empty rectangle and change the content type (with the command DRAWING → CONTENT TYPE → SPREADSHEET or the select list in the tool bar). The characteristic grid network immediately appears. The standard cell grid is too narrow for the purpose planned, but this can all be changed with just a couple of clicks.

Change Spreadsheet: Due to the construction of the master layout – two rectangles connected by a pipeline, the spreadsheet is continued in the rectangle over onto the second page, as soon as you append it to the layout. The representation in two different rectangles and on two different pages leads to the incorrect impression that these must be two separate spreadsheets. This is, of course, not the case – instead it is the continuation of just one spreadsheet over numerous containers.

You have to consider this when you carry out the settings for the spreadsheet. It is not enough to simply select the cells, which are to be seen in the rectangle, for changes, which should affect the whole spreadsheet! Use menu commands like, for example EDIT → SELECT ALL and the column and row title bars for selections within the spreadsheet.
Now select the complete table in order to specify the cell height and alignment of the contents. Access the panel **ARRANGEMENT** in **SPREADSHEET INFORMATION**. The height of the cells should be **4.9 cm**, the cell contents should be positioned in the center of the cell (centered) ([Fig. 167](p. 221)). Leave the table selected and click on **SPREADSHEET BORDERS**. Then place a tick in the checkboxes **OUTER BORDERS** and **INNER VERTICALS**.

![Spreadsheet Information Panel](image)

**Fig. 167**: Change Cell Height and Position of Cell Contents.

The height of the first row should now be manually reduced. For this you should drag the “Seam” between row titles 1 and 2 until row 1 is exactly **1.5 cm** high or select the row and utilize the panel **ARRANGEMENT**.

The column width also has to be manually specified for every column, the widths of which do vary. In detail:

- Select column **A** by clicking on the column title bar and set the width to **1.6 cm**.
- Select columns **B, D, and E** (by clicking on the column titles while holding down the **Ctrl** key) and set the width to **3.5 cm**.
- Column **C** becomes **4.9 cm** wide (the cells are then square-shaped).

**Working Faster**: You can also use the palette **OBJECT COORDINATES** to change table columns. It can remain open on the interface, while you successively select the columns and adjust their width.
Create Title Row
You should now fill the title row. Write in the first five cells in the upper row from left to right:
- “Item No.”
- “Item Description”
- “Item Illustration”
- “Batch”
- “Price”

The value type still has to be set to MULTILINE so that longer entries are also able to wrap correctly.

Make the font bold and highlight it in light gray. For this you can use the command FORMAT → COLOR and select a light gray shade from the color table. It is naturally also possible to work with a fill style sheet here.

Row 1 is almost completed and already fulfilling its function as a title row very well – albeit only on the first page of the document. For this row to be able to appear automatically on the following pages of the document, you have to also provide it with the status of a title row in RagTime – it is not sufficient for it to simply be designed like a title row. Select the whole row and place the mouse on the row. Access the context menu and select the command USE AS TITLE ROWS/ COLUMNS. A fine line appears under the row (it is not printed), the lettering in the row button changes.

Moving Fill Style Sheets to Other Documents
You have already created and saved a light gray highlight for table cells in Exercise 11. This lends itself to be utilized again here. For this there are two very different possibilities.

- **Moving Fill Style Sheet to Another Document:** Open the document containing the fill style sheet and the document, into which the fill style sheet should be inserted. You will find all fill style sheets in the inventory (under AUXILIARIES). With the mouse you can easily drag the fill style sheet into the inventory of the second document. The fill style sheet is copied and it therefore does not disappear from the first document!

- **Globally Utilize Fill Style Sheet:** To utilize a fill style sheet in all RagTime documents you must open the document that contains the style sheet and the FILL STYLE SHEET EDITOR (in WINDOWS → AUXILIARIES). In the overview list you will see that the style sheet is listed under the document name. Click on the
style sheet and drag it to the style sheets in `RagTime 6 Auxilliaries.rtd` (Fig. 168 [p. 223]). The position of the fill style sheet once again defines hierarchical dependencies.

**Fig. 168:** Style sheets, which are initially only set for a custom document, can be easily made globally available (excerpt from the Fill Style Sheet Editor window).
Is Everything Working?
New pages are only appended to documents torn off from stationery pads when the containers of the current page are filled and “overflowing”. Here you can, however, simply use the command EXTRAS → APPEND PAGE to append new pages. Check out whether pages can be appended and the spreadsheet title row inserted according to plan. For further editing your document should then comprise a total of three pages: the front and two following pages.

→ Delete Pages: Non-required pages are quickly removed by clicking on the tag to select them and then choosing EDIT → CLEAR. or also work for deleting pages.

Filling Cells
You can now fill cells with contents. You can basically do what you want here. You should once again utilize the default cell contents type MULTILINE for longer entries and a suitable value format for the last column with the prices. Depending on the length of the texts inserted, it may also be advisable to change the text alignment – longer entries look better when set to left alignment and are more legible – or change the distance between the cell contents and the cell border (Panel ARRANGEMENT in the dialog box SPREADSHEET INFORMATION).

In the training folder there are various JPG files with pictures of fruit, which you can use for the column “Item Illustration” (You will easily recognize them by their file names: Strawberry.jpg, Lemon.jpg etc.). You should once again use the Drag and Drop technique from the Explorer, Finder or, for example, a picture editing program to drag and drop the pictures into the document.

Changes to Master Layout
Change back over to the master layout pages in order to make a change. Double click on the master layout component title in the inventory. You can also utilize the menu WINDOWS if the master layout component is still open in the background. All currently open windows are listed in the bottom margin of this menu.

As you can see, nothing in the master layout has changed despite the many changes you have carried out in the layout component. Now a diagonal line of text should be added to the “general” pages, i.e. the second page of the master layout – this is, for example, useful if you want to highlight a document as a draft, copy or such like.

Set to work with the Graphical Text tool. Click approximately into the middle of the second page and enter the required term. Keep the
text object highlighted. Enlarge the font and change COLOR, OPACITY or TINT (all settings can be found in FORMAT) — the font should be a light gray shade so that it doesn't completely dominate (for differences see Fig. 169 [p. 225]). Decide for yourself which setting is the best for you.

![Fig. 169: The effect of the settings COLOR, OPACITY and TINT: 1 Here the color has been changed, opacity and tint 100%. 2 The letter color is black, opacity 40%, tint 100%. 3 Black lettering, opacity 100%, tint 40.]

To make the text diagonal, you either require the panel COORDINATES in the drawing dialog box or the palette OBJECT COORDINATES. Specify a rotation of -45° to tilt the text in the way that it can be seen in Fig. 162 [p. 211]. You can, of course, also work according to your own visual judgment and rotate the text by placing the mouse near the point of rotation — the mouse pointer turns into a rotational symbol — and dragging.

→ Exact Rotations by Mouse: Pressing while you drag the mouse on the rotation point, restricts the rotation to 15° steps, 45° can therefore be attained quickly and precisely.

The last step is to align the text to the center of the rectangle. For this, select both objects (hold down while clicking). The dialog box ALIGN OBJECTS (via DRAWING → ALIGN) or the CENTRAL ALIGNMENT button (picture) in the palette DRAWING COMMANDS will further help you.

Change over once again to the layout component. The recently inserted text now appears on all pages deriving from the second master layout page.

Your first document with master layout is finished and can be saved.
6.3 EXERCISE 13: DOUBLE-SIDED MASTER LAYOUT WITH FRONT AND BACK PAGE

In this exercise you will be creating a document with its own front page and a back page, which each appear only once, and a double-sided page which can be repeated as often as you request for the continuous text (Fig. 170 [p. 226]). Seminar documents for the catering academy serve as an example. Documents of this type are, however, used frequently in

Fig. 170: A document like this should be created in Exercise 13 (schematic representation): front page, double-sided layout, back page.
day-to-day business, so you will soon be able to put everything you have learned into practice for other documents.

**STEP BY STEP**

**Begin and Prepare New Document**

Begin a new document with the component MASTER LAYOUT. Three different pages are required for the planned layout. The second page of the master layout should be a double-sided page. You do not, however, have to construct two mirror-image pages. Double-sided pages can be automatically generated from one page in the master layout. Add two further pages to the master layout component (with EXTRAS → ADD PAGE).

In the following steps you will initially learn about how to construct the basic master layout frame. For this you should use Fig. 171 [p. 228] as an example. All the important elements of the master layout are depicted in this exercise.

**Create Guides**

Guides are quickly created and they help you in splitting up the pages. The planned page borders and therefore also the guides for the first and second page are the same; the middle master layout page (the second in the document) is a variation.

**Determining Guide Positions**

You have to know the page setup and be able to carry out some small calculations in order to specify the position of the containers and also the size of the margins with guides, because the position of the guides is always stated as starting from the top or left margin in the palette GUIDES and all other dialog boxes. In the dialog box PAPER FORMAT (_CURRENT PAGE SETUP_), PAGE SETUP (_CURRENT PAGE SETUP_) you can view the measurement of your current page setup.

An A4 sheet is 29.7 cm × 21 cm in size. If you would now like to, for example, position a guide on A4 portrait paper 4 cm from the bottom margin, you must calculate as follows:

\[
29.7 \text{ cm} - 4 \text{ cm} = 25.7 \text{ cm}
\]

The horizontal guide has to be positioned at 25.7 cm in order to be 4 cm from the bottom margin.
Fig. 171: The basic master layout frame. Use this picture as an orientation guide for the master page layout (Representation with especially highlighted container borders and design elements).
The following guides are required for the first and third page of the master layout:

- First horizontal guide 4.2 cm from the top margin, i.e. at 4.2 cm. This line marks the position of the dashed line on the page header.
- Second horizontal guide 4 cm from the bottom margin, i.e. at 25.7 cm. These and the following lines are intended as an orientation guide for the large rectangle, which will subsequently contain the text.
- First vertical guide 2.5 cm from the left margin, i.e. at 2.5 cm.
- Second vertical guide 2.5 cm from the right margin, i.e. in the position of 18.5 cm.

The second page should form the basis for a double-sided layout whereby the right and left pages are designed as mirror images. The page elements should be moved somewhat outwards in order to find space for the subsequent binding or stapling of the printed document – this can thus be seen in the arrangement of the guides.

- First horizontal guide 2.5 cm from top margin, i.e. at 2.5 cm. This line marks the position of the dashed line on the page header, which is normally higher in normal text pages than in the front and back page.
- Second horizontal guide 4 cm from bottom margin, i.e. at 25.7 cm.
- First vertical guide 2 cm from the left margin, i.e. at 2 cm.
- Second vertical guide 3 cm from the right margin, i.e. in the position of 18 cm.

Now use the palette GUIDES again to work quickly and precisely.

**Draw Subsequent Text Containers**

Change over to the Rectangle tool and draw the containers required for the subsequent text. Do not specify the content type yet – this way work on the remaining layout pages remains more flexible. Use the recently created guides and *Fig. 171* [p. 228] again. The measurements from the sample file are as follows:

- The large rectangle on the first page is 16 cm wide and 15.7 cm high. The position is marked by the guides.
- The large rectangle on the second page is 16 cm wide and 21 cm high.
- The large rectangle on the third page is 16 cm wide and 18.8 cm high.
When developing a layout, the measurements and position of the subsequent text blocks should be adjusted to suit the remaining elements on the page. During the development phase it can be extremely helpful to fill the container with dummy text in order to check its impact in the master layout. You can then set Content Type: None again.

The measurements mentioned here can be transferred to your document the way they are. In day-to-day business you will, however, have to come to terms with the fact that you won’t always succeed in specifying final container measurements and guide positions, which will result in a harmonious, attractive layout, in this early draft stage.

**Draw lines for the page header**
The next task is to draw the lines, which structure and accentuate the pages. Less attention may be initially paid to the design of the lines; it is carried out over the next few steps.

Each of the upper horizontal guides marks the requested position of the line on the page. Change over to the Line tool. Place it on the left margin of the first page on the same level as the upper guide and use the mouse to drag to the right. Press `<Spacebar>` to draw an exact, horizontal line. Carry out the same procedure for the second and third page.

**Design lines: Color Style Sheet**

![Fig. 172](image)

*Fig. 172*: Dotted green line as design element (detailed view of finished document).

The lines should appear as dotted lines, in a green shade, which corresponds with the green in the logo (as seen in Fig. 172 [p. 230]).
Two working procedures are necessary for this: first, you have to define a color as being exactly this green (it is not available on the default color palette) and then you have to set line properties like width, dots and color (the green you have just set!).

If you are already going to the trouble of defining a special color, then you should also make it available for other elements, e.g. as a font color or line color for borders of drawing elements and such like. So you don’t just change the color of a line, but create a fill style sheet with this color. Because green dotted lines are a recurring design element in this document – and who knows, perhaps the “catering academy” will soon need other documents? –, it is worth defining a separate line style sheet as well. This will then be able to access the previously created fill style sheet for the line color.

Select Windows → Auxiliaries → Fill Style Sheet Editor to access the already well-known window for creating fill style sheets. Because the fill style sheet you are creating should also be made available for other potential documents from “catering academy”, click on the fill style sheet overview in the dialog box on RAGTIME 6 AUXILIARIES.rtd to ensure that this term is highlighted. The new style sheet is then stored in such a way that it is also accessible to other documents. Click on CREATE and name the style sheet, for example, “Green Catering Academy”. Open up the list with the color fields (Fig. 173 [p. 232]). Click on OTHER in the list.

**Set Color:** The window COLOR opens. Here you can specify the new colors. If you cannot find certain setting opportunities in your version of the COLOR dialog box, then click on the button DEFINE CUSTOM COLORS to expand the dialog box. You now have various opportunities for setting a new color (Fig. 174 [p. 232]):

- You can move the mouse over the spectrum of colors. In a small preview window you will be able to see the current color. Select by clicking on the color of your choice.
- You can exactly specify colors by entering numbers whereby you have the choice between two different color (description) systems: you can either specify the values with the help of the entry fields HUE, SAT. and LUM. (i.e. shade of color, saturation and luminosity) or by carrying out entries in RED, GREEN and BLUE (RGB System).
Fig. 173: Click on **OTHER**, if you want to specify a color, which is not contained in the default color palette, as a fill style sheet.

Fig. 174: The dialog box for specifying a custom color depends on your system. This is the Windows version.
The RGB values are known for “Catering Academy” green, enter them in the appropriate entry fields:

- R(ed): 152
- G(reen): 203
- B(lue): 0

Click OK to return to the window FILL STYLE SHEET EDITOR. In COLOR the recently set green is now displayed as a property of the new fill style sheet.

Set Color: It opens the window COLORS where you are able to specify new colors. Change over to COLOR SLIDERS view and then to the RGB color control (Fig. 175 [p. 233]). Here you can type the required value directly into the entry fields or change the color by moving the slider.

The following values should be entered in the appropriate entry fields for “Catering Academy” green:

- R(ed): 152
- G(reen): 203
- B(lue): 0

Click OK to return to the window FILL STYLE SHEET EDITOR. In COLOR the recently set green is then displayed as a property of the new fill style sheet.

Fig. 175: The dialog box for specifying custom colors depends on your system. This is the Mac OS version. In this version you first have to set the correct view 1 and color system 2 to be able to enter the RGB values.
Designing Lines: Line Style Sheet

You now need a line style sheet, which makes use of the recently specified color and creates dotting. Access the window LINE STYLE SHEET EDITOR (via WINDOWS → AUXILIARIES or with the help of the inventory). The line style sheet should also be available to other documents, so click on RAGTIME 6 AUXILIARIES.rtd in the line style sheet overview in the dialog box to ensure that this term is highlighted. Click CREATE and name the style sheet, for example, “Catering Academy Layout Line”. Specify the WIDTH, FILL STYLE SHEET (the recently defined green!) and the DASHING (Fig. 176 [p. 234]).

Assign Line Style Sheet

You now have to assign the new line style sheet to the lines in the document in order to change their appearance. Select the first of the lines and click FORMAT → LINE STYLE SHEET. You now have to also find your new line style sheet in the list displayed and click on its name.

Other Ways of Allocating Line Style Sheets: You can alternatively use the palette FORMATTING (Section FILL AND LINE STYLE SHEET) or the command FORMAT → LINE FORMATS. It is especially worthwhile working with the dialog box LINE FORMATS if you specify new line properties, i.e. if you want to modify the properties of existing style sheets for individual lines. In this case you don’t, however, change the style sheet itself, but just the properties of a line.
**Remaining Containers on First Page**

The rectangles for the text block have already been drawn; the remaining containers in the upper section of the page still have to be added.

![Fig. 177](image)

**Fig. 177**: A chart and two text elements still have to be accommodated for on the first page (excerpt from the finished document).

You can already install the text and picture components in the master layout as these elements definitely will not be changed again. You can work according to Fig. 177 [p. 235] and your own visual judgement.

If you want to exactly recreate the style sheet, you need to use the following measurements and coordinates:

- **Container for Picture Component**: 2.85 cm wide, 3.5 cm high. Distance from left margin 2.35 cm, distance from top margin 1.5 cm.
- **Container for Company Name** (“The Catering Academy...”): 7 cm wide, 1.46 cm high. Distance from left margin 11 cm, distance from top margin 2.5 cm.
- **Container for Seminar Title** (“Seafood...”): 8 cm wide, 3.28 cm high. Distance from left margin 10 cm, distance from top margin 5.52 cm.

The text components are set to right alignment (select both and set in DRAWING → ARRANGE OBJECTS).

Fill the containers as depicted in the style sheet. The required picture can be found in the training folder (BoiledEgg.jpg). ARIAL has been used as a font in the point sizes 14 and 18 and made partially bold.

**Add Second Page**

Some elements are also still missing on the second page, namely the page number – which you can, of course, once again incorporate by using
a formula – and a short seminar title. Both elements should be inserted as Graphical Text. Use **Fig. 178** [p. 236] as a style sheet.

**Fig. 178**: The title row and page number are indented 0.5 cm to the right in relation to the subsequent text block to ensure that the design grid does not appear too rigid.

### Add Third Page

Some text elements still have to be added to the third page of the master layout, which is intended as the back page of the document. Graphical text is once again suitable due to the conciseness of the text. In **Fig. 178** [p. 236] you can see how this task has been solved on the style sheet.

**Fig. 179**: Centered Graphical Text on Third Page.

The “General Business Conditions” of the Catering Academy should be added on the subsequent back page of the document. This can be carried out at the present time in the master layout, because this text block should remain separate from the remaining text (no pipeline con-
connection!). Insert a dummy text by, for example, using one of the dummy text files in the training folder.

The design of the master pages is now complete.

Specify Usage of Master Pages
In the next step the usage rules for master pages have to be determined. For this you should carry on as already described in the previous exercise.

- Select the first master page by clicking on the tag and access the dialog box LAYOUT INFORMATION. Now name the master page, for example, “Title”. Activate the option WHOSE INDEX COUNTED FROM THE START IS SPECIFIED and enter a “1” in the entry field.
- Select the second master page by clicking on the tag and open the dialog box LAYOUT INFORMATION. Provide a name, for example “Seminar Text”. In USAGE you should now determine that the master page in the layout is used for pages TO WHICH NO SPECIAL RULE APPLIES.
- The same applies for the third master page: select, open info dialog box, provide title (for example “GT&Cs”). Select WHOSE INDEX COUNTED FROM THE END IS SPECIFIED as a usage rule and type “1” in the entry field. This master page is then always used as the last page in the document – no matter how many pages the document comprises.

Define Master Page as Double-sided
The layout of the second master page “Seminar Text” should be double-sided. Select it and choose the command LAYOUT → DOUBLE-SIDED MASTER PAGE – and voilà! The page arrangement will shift on your interface – the second master layout page is now available in duplicate in a mirror-image version. Both halves of the double page follow the previously defined usage rules.

Install Pipelines
Now pipelines have to be installed to organize the text flow in the document. The last page (“GT&Cs”) should not be connected; for the other pages you should arrange the pipelines as shown in Fig. 180 [p. 238].

Creating Layout Component
The command WINDOWS → NEW COMPONENT → LAYOUT allows you to create a layout component. Ensure that you select the recently generated master layout as “Template”. The command ADD PAGE allows you to create some new pages in order to check whether everything’s working to plan. Fill the container with a dummy text to test the pipelines.
Here you’ll learn about how to incorporate a picture into a text so that the text wraps around the picture outline, as shown on the last document page (Fig. 170 [p. 226]). It is not much more complicated than the procedure already described in Exercise 7: Working with the Drawing Component: CD Cover [p. 155], although for this you will need a specially prepared picture file, which is provided with a clipping path specifying which outlines the text should follow. The file BoiledEgg.jpg al-
ready contains such a path.

First of all, fill the rectangle with text. You can use one of the dummy text files from the training folder. Then draw a rectangle in the location of your choice on the page. Open the inventory and drag the picture component “BoiledEgg” into the rectangle. Position the rectangle, as requested, in the text container and adjust the size of the container, if necessary. Select the picture (not the container – the picture has to be wrapped by the typical “Ant Line”). Hold the mouse near the picture component and access the context menu. Now select the command Fit Container to Picture. A dialog window appears (~ Fig. 181 [p. 239]):

![Fig. 181: Dialog Box Fit Container to Picture: Details for Text Wrap.](image)

- The option Clipping Path has to be active.
- The command Fit Container to Picture causes the previous, rectangle container outline to be transformed into a polygon or Bézier object and fitted to the shape of the clipping path prepared in the picture. The option Distance from Container determines the distance of the changed container to the outlines in the clipping path. You can leave this value as it is, because the clipping path in the template file already maintains a certain distance to the picture object.
- Text Wrap Distance sets the distance between the text wrap and picture container. In extremely detailed objects it may be necessary to increase this value in order to ensure that the text, if aligned to a twisted outline, does not become too illegible.
- Subsequently Set Distances: You can also align these distances in Drawing Information (Objects panel). Here you will also
find further options for text wrapping, which you can use, if the
text is excessively torn by the embedded picture.

The document is complete and you've finished the last practical ex-
ercise in this book!
RagTime Documents as PDF or HTML File
7.1 EXPORT AS PDF

The PDF file format is the ideal for exchanging completed documents. The PDF format works platform-independently: documents are displayed on every computer in the original layout, unwanted deviations do not occur. In addition, software for viewing the PDF documents is installed on almost every computer. If required, PDF files can also be designed to be extremely “slim”, so that they can be easily shared on the internet. PDF documents are suitable for relaying digital product sheets, brochures and such like, but can also be used to quickly exchange data in ongoing projects – for example, if not all participants are able to open original RagTime files.

RagTime offers a PDF export function with numerous setting options, so that you are also able to create PDF formats for all your RagTime documents. This requires further software, which RagTime is partly able to access directly, including, for example, Adobe Distiller (Acrobat).

In Windows, RagTime is able to access Ghostscript or Adobe Distiller. On the RagTime site you will be able to find up-to-date information on and links to Ghostscript: [http://www.ragtime-online.com/go.cgi?info=Ghost](http://www.ragtime-online.com/go.cgi?info=Ghost)

In Mac OS, RagTime is able to access Adobe Distiller and the PDF converter belonging to the system. The path using the Mac-OS print command is equally possible, but not advisable.

<table>
<thead>
<tr>
<th>Which PDF Properties are Implemented?</th>
</tr>
</thead>
<tbody>
<tr>
<td>The PDF file format is extremely versatile and facilitates, for example, links (Hyperlinks). Some generation methods also support the automatic reduction in the resolution of pictures.</td>
</tr>
<tr>
<td>Here you can see which method supports which property.</td>
</tr>
<tr>
<td>Adobe</td>
</tr>
<tr>
<td>Distiller</td>
</tr>
<tr>
<td>Retains hyperlinks</td>
</tr>
<tr>
<td>Reduces resolution in pictures</td>
</tr>
</tbody>
</table>

You can access the Export to PDF dialog box via File → Export to PDF.
The settings for the PDF export can be specified in the four panels of the PDF Export dialog box. Some details and options depend on how your document is structured, which component was active, or whether there was a selection when the command Export as PDF was chosen and which software is installed on the computer for the creation of PDFs.

- In the General panel you can specify whether you want to export either the complete document or just sections as a PDF. In addition, you will find a Summary of all settings which have been set in the four dialog box panels (Fig. 182 [p. 243]).
- In Job (Fig. 183 [p. 244]) and then Method you can select which software should be used for generating a PDF. Various methods are available, depending on which PDF generators are installed on your computer. With the Prepare PostScript File for Deferred Distillation method you are additionally able to prepare a RagTime file in

![PDF Export dialog box](image)

**Fig. 182**: PDF export can take some time when dealing with extensive documents. That’s why you should definitely check out the Summary at least once before starting to export the document.
Fig. 183: The Method selected is the most important option. The contents of the pop-up menu vary depending on which PDF tools are available on your computer. The options under Job Settings depend on the Method selected.

such a way that it can also be processed by a PDF tool which is not directly supported by RagTime.

In Notification you determine what should happen after the PDF has been exported: you can be notified or informed about errors which may have occurred, or have the new PDF document opened.

Display PDF Files: RagTime can import PDF files into RagTime documents (see Exercise 7: Working with the Drawing Component: CD Cover [p. 155]) or export RagTime documents as PDFs. You require special software to view PDF files. You could, for example, download a program for viewing PDF documents from http://www.adobe.com/acrobat if nothing like this has been installed on your computer yet.

Further options in the Job panel vary according to the Method se-
• The **Page Setup** panel for **layout or master layout components** (Fig. 184 [p. 245], see below for other components)

Here you are able to adjust the size of the layout pages of the document to the paper sizes of the printer you are subsequently going to use with the help of a chart and various options – the layout page size does not necessarily have to correspond with the paper formats of your printer.

If the setting **Automatic** is active, RagTime generates one PDF page per layout page, the size of which complies with potential single page formats and possibly active **Extras**.

If you select the option **As Set in Layout Page Setup**, the paper format settings of the layout are accepted. If necessary, more PDF pages are then also created per layout page.

**EXTRAS**, especially **Cutmarks** become extremely useful when the

---

**Fig. 184**: **Page Setup** for layout and master layout components: which paper format should the layout page be printed on? The chart helps when making adjustments.
PDF files should be reproduced with professional four-color printing presses.

**PDF Export**

- **As Set in Page Setup**

  **Paper Size**
  - As Needed
  - 2.26 cm, 0.76 cm
  - Portrait, Landscape

- **Margins**
  - 0 cm

- **Extras**
  - Flip Horizontal, Flip Vertical, Inverse, Cutmarks

**Fig. 185**: PAGE SETUP for components other than layout and master layout components: The chart clarifies how your settings work.

- The PAGE SETUP panel for other components (not layout, see above for layout components)
  - If the option As Set in PAGE SETUP is active, all information on the size of the PDF pages is accepted from the page format settings of the document. All remaining options are then blocked.
  - You have to remove the checkmark in As Set in PAGE SETUP before you can set further settings regarding SHEET SIZE, MARGINS and EXTRAS. The setting SHEET SIZE → AS REQUIRED establishes that RagTime specifies the PDF page size according to the objects contained in the document. OTHER SIZE allows you to make your own specifications.
- You establish how document colors are handled in the COLORS panel. In most cases the color option COMPOSITE COLOR is the best
choice. This setting enables you to circulate generated PDF documents as digital flyers or brochures, publish them on the internet or pass them on to a professional printing company.

⚠️ **Working in the Correct Color Space from the Outset:** If your document is to be printed on a professional printing press, you must clarify with your service provider beforehand, in which color space the colors of the PDF should be available. It is usually CMYK (Cyan, Magenta, Yellow and Key (black)), as the chroma of a document is generated by printing these colors on top of each other in four-color print. You have to create the RagTime document appropriately from the outset, because the color space of the RagTime document is not converted in PDF composite export. This means:

- All pictures, which are used in the document, have to be CMYK pictures. Pictures from digital cameras and from many scanners usually exist in RGB color space and have to be prepared with a picture editing software, if necessary.
- All colors, which you use in your RagTime document for fonts, fills, lines etc., also have to be CMYK colors from the outset

![Color Editor](image)

**Fig. 186:** In *Windows ➔ Auxiliaries ➔ Color Editor* you can also specify CMYK colors for usage in the document.

If you want to print your document in one color on a color printer, you can activate **Gray**. It is not necessary to activate the option in order
to print colored documents on a grayscale printer – as the printer software usually deals with the conversion. If you work with color profiles during your production process, you can select an appropriate color profile in Colors. If the option Color Separation is active, a PDF is generated where the previous document colors are separated into four (or more) colors for output. You can then also carry out changes to the screening of the individual plates for printing and determine how to handle spot colors. For this you definitely require a PPD file, which describes the printer properties of your service provider. In any case, you should definitely find out whether your printing company is able to process color-separated PDFs BEFORE you create the PDF!

<table>
<thead>
<tr>
<th>Why Color Management?</th>
</tr>
</thead>
<tbody>
<tr>
<td>The colors in a document pass through numerous stages: photos are taken digitally or scanned, perhaps edited and then imported into RagTime. Then there are the colors, which you yourself specify in RagTime and use in documents. All this should then look the same on paper as it does on the monitor wherever possible, but it's not that simple. Reproducing colors with only the smallest possible deviation is one of the greatest challenges in the publishing process.</td>
</tr>
<tr>
<td>On a monitor – your most important controller and tool – colors are generated completely differently than on paper. A monitor works with RGB (Red-Green-Blue) colors based on the primary colors (light colors). Printer's ink comprises material color pigments (so-called “object colors”) and is made up of Cyan, Magenta, Yellow and Key (black). Light colors can, of course, not be reproduced in object colors and appear true. The color spectrum (color space) represented by printing colors is smaller than the color space of the light colors. And, don't forget that every individual device interprets the color instructions occurring in a file slightly differently. You know the effect, if you've seen the same picture on various different monitors lined up next to each other. It's a similar scenario for printers – whereby different ink and paper properties are also involved in this case.</td>
</tr>
<tr>
<td>Color profiles have been developed in order to correct system-related and device-related differences in color representation and to provide a more consistent color representation in all stages of the publishing process. Color profiles contain information on the color representation of participating devices.</td>
</tr>
</tbody>
</table>
The “ICC” (International Color Consortium) has successfully established standards for color management. ICC color profiles are often delivered with devices and software; valid color profiles can also be found on the web sites of printing companies and, of course, at the ICC.
7.2 RagTime Documents as HTML Files

You can export RagTime documents as HTML/CSS files. Brochures, flyers or other similar documents can therefore be integrated into your web presence in absolutely no time.

RagTime generates a combination of HTML and CSS files from your document. Pictures in the document are alternatively printed in original format or printed in optimized quality for web sites, spreadsheets are converted into real HTML tables and graphs and drawings are converted into pictures. Thus, the perfect agreement between the printed picture and the web view is guaranteed without generating unnecessarily large files for the web due to the general conversion.

The following tips will assist you in even further improving the match between the printed document and the web view:

- **Fonts**: You should use the default fonts available on all computers such as, for example, Arial, Times New Roman or Verdana. If you use other fonts, the appearance of the HTML page may deviate greatly from the original document when displayed on other computers than the computer used for “production”, because the fonts may not be available on other computers.

- **Line Wrapping**: Line wrapping in a browser is different to that in RagTime. It is especially due to the lack of hyphens that the text in the browser may need more lines. The HTML Export Settings allow for the font size to be reduced and you can therefore counteract this effect.

- **Paragraph Properties**: Not all paragraph properties, which are possible in RagTime, can be accepted in a HTML document. Documents with multiple columns always have to be realized with numerous containers, if they are intended for HTML Export.

- **Rotated (Text) Objects**: Rotated objects can only be exported as a picture. Thus their appearance can greatly deviate from that of a normal text. Especially long texts should not be edited in this manner if HTML Export is planned at a later date.

You can find the command in File → Export as HTML.

- You can either export a whole layout component or simply a selection.

- Your export strategy is mainly directed at the contents of the document and your objective. Convert Everything to Images quickly creates rather large files, which are not necessarily suitable to be exchanged on the internet, but which do provide a very exact image of the original RagTime document. You could make use of this
Fig. 187: Settings for the export of a RagTime file as a HTML file.

option for intranet or other paths of distribution where the transmission time is of no importance. Convert to image as rarely as possible produces slimmer files, but it can also lead to deviations from the original layout. When in doubt, convert to image is the happy medium. You'll just have to experiment a bit to find out the best strategy for you!

- If Export JPEG and PNG Pictures in Original Format is active, then the conversion to the web-friendly picture resolution of 72 ppi is omitted. Files could possibly therefore be extremely large.
- Export Everything to a Single HTML Page also integrates documents with numerous layout pages into one HTML file.
- You only require hyperlinks to navigate back and forth in multi-page HTML files if you are working with multi-page HTML files. You can determine the position of the hyperlinks in Page Navigation.
• The font size can be reduced by activating REDUCE FONT BY ... PIXELS in order to compensate for the more awkward line breaks in the browser. You should, however, not select screen font sizes which are too small.

Clicking on CONTINUE takes you to a dialog box where you can specify where to save your HTML Export. You have to specify a folder, in which these files can be stored, because a whole group of files is always created in this case.
Checklist — When To Use Which Document Type?
A.1 WHEN TO USE WHICH DOCUMENT TYPE?

Depending on the intended use and potential time available to users, RagTime documents can be generated in the following very different ways: as a “Simple Document” which is ready in no time; (see exercises in chapter ▶ Quick Introduction: Tools, Functions, Working Methods [p. 49]), as a Stationery Pad for uncomplicated multiple usage (see exercises in ▶ The RagTime Stationery Pad: Style Sheets for Frequently Used Documents [p. 165]) or with a Master Layout Component, which is especially suitable for more complex procedures (▶ The RagTime Master Layout: Complex Documents [p. 207]).

The following overview once again summarizes the most important information of features, typical application areas and working procedures for the three types of RagTime documents.

▶ Combine and Vary Document Types: RagTime is a flexible working tool, which often offers you various ways of attaining your objective. You can therefore vary the work routines shown here.

Furthermore, the boundaries between the three “document types” are not absolute. A tried-and-tested “simple document” can usually be saved as a stationery pad with only few alterations, a master layout component can also be subsequently added to existing documents and in most cases it is even sensible to integrate a master layout component into a stationery pad.
This page is purposefully empty so that you can study the following overview on pages facing each other without having to turn over.
Appendix A: Checklist — When To Use Which Document Type?

---

**Properties**

**“Simple” Document**

- Automatic page generation (with default text container) is provided with layout component at the beginning of a document
- Every page has to be designed by hand
- Designed for one-time usage

**Expenditure**

Document can be immediately created and used without further planning, changes can be time-consuming.

---

**Stationery Pad**

- The stationery pad has to be created once, then copies can be “torn off”
- If required, stationery pads can be equipped with intelligent management for subsequent pages, which automatically generates pages in the previously specified layout
- Various page types possible per document, i.e. front page, right and left following page
- Document date is updated when torn off

**Expenditure**

One-time creation of stationery pad slightly more time-consuming, very easy to create copies.

---

**Master Layout Component**

- Master layout components facilitate the automatic appending of numerous page types to documents
- You determine when to use which previously created page type by means of detailed rules
- Layout changes are easily made at a central location
- In the master layout component you specify the basic structure of the document, in the layout component, which depends on the master layout, you can add contents and amend the layout

**Expenditure**

A high planning expenditure is compensated for by intelligent mechanisms for the appending of new, prepared document pages and quick changes.
### A.1: When To Use Which Document Type?

<table>
<thead>
<tr>
<th>Application</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Custom documents with a minimum size</strong>, which are created quickly and should only be used once for example</td>
<td>• Create a layout component (beginning new document with layout)</td>
</tr>
<tr>
<td>• Memos</td>
<td>• Design a page (using rectangles and other drawing objects as containers)</td>
</tr>
<tr>
<td>• Urgent letters</td>
<td>• Specify the content types</td>
</tr>
<tr>
<td>• Quotations, bids</td>
<td>• Fill containers</td>
</tr>
<tr>
<td>• Statistics with graphic representation for, e.g., presentations</td>
<td>• Save the document, output</td>
</tr>
<tr>
<td>One-page and more extensive documents are <strong>used again and again with the same basic setup</strong> and minimum amount of work (&quot;Forms&quot;), e.g.</td>
<td>• Create the layout component</td>
</tr>
<tr>
<td>• Letter template with a specific letterhead</td>
<td>• Append the pages</td>
</tr>
<tr>
<td>• Invoices</td>
<td>• Design the pages</td>
</tr>
<tr>
<td>• Minutes</td>
<td>• Specify the content types</td>
</tr>
<tr>
<td>• Standardized documents i.e. contracts, payment requests and such like</td>
<td>• Install pipelines</td>
</tr>
<tr>
<td>• Catalogues</td>
<td>• Saving as a stationery pad (.rtt format)</td>
</tr>
<tr>
<td>• Training manuscripts</td>
<td>• &quot;Tear off&quot;, use, save, output the documents from stationery pads</td>
</tr>
<tr>
<td>• Brochures</td>
<td></td>
</tr>
<tr>
<td>• Customer service documentation</td>
<td></td>
</tr>
<tr>
<td>• Price lists</td>
<td></td>
</tr>
<tr>
<td>• Academic publications</td>
<td></td>
</tr>
<tr>
<td>• Books</td>
<td></td>
</tr>
<tr>
<td>Documents with master layout components can be as complex as you like and extremely extensive. Especially suited to documents which are frequently extended or revised i.e.</td>
<td>• Create the master layout component</td>
</tr>
<tr>
<td>• Catalogues</td>
<td>• Append and designing the pages</td>
</tr>
<tr>
<td>• Training manuscripts</td>
<td>• Install pipelines</td>
</tr>
<tr>
<td>• Brochures</td>
<td>• Specify use of master pages</td>
</tr>
<tr>
<td>• Customer service documentation</td>
<td>• Create the layout component by using the master layout</td>
</tr>
<tr>
<td>• Price lists</td>
<td>• Specify the content types</td>
</tr>
<tr>
<td>• Academic publications</td>
<td>• Use a document (fill), append master layout or generate further master layout and layout components, if necessary</td>
</tr>
<tr>
<td>• Books</td>
<td>• Save the document, output</td>
</tr>
</tbody>
</table>
Frequently Asked Questions – and Answers

This chapter provides you with the answers to questions you may have often asked when working with RagTime.

Thank You! We would especially like to express our thanks to the participants of the RagTime mailing list on http://www.macnews.de whose discussions, which included many typical questions and tips, have provided us with many suggestions for this list!
B.1 EMERGENCY SERVICE

I have connected numerous text containers to a pipeline, but the text does not continue to flow from the first container into the following containers.

Have you used the correct pipeline tool? First click to display pipelines (Windows \(\rightarrow\) Show \(\rightarrow\) Pipelines). A small, black square, the pipeline symbol, appears in the middle of the connected container. Do the connecting lines run from the sides of the square or from the top or bottom?

If the pipelines run from the sides of the small pipeline symbol then you have used the tool for horizontal pipelines. This tool only works on spreadsheets. Text containers always have to be connected with the tool for vertical pipelines.

Help! The pages of my document have disappeared!

Take a detailed look at the list in the inventory. If the inventory is not open, click on the “Squirrel” button in the tool bar. There should be an entry in the inventory, which has a small page as a symbol (the name is usually “Layout 1”). Open the window with the pages by double-clicking on this entry in the inventory.

I would like to export a text in MSWord format, but am only able to select picture formats in the export dialog box. Why is this the case?

You have probably selected a container in your document. First of all you should click directly into the text and then access the export dialog box. RagTime adjusts to the current selection in the document in order to determine which file formats are preferably offered for export.

I would like to set the letter color of the spreadsheet cells to red, but instead only the cell background keeps going red.

Use the FORMAT palette (click on the “Pen Knife” button in the tool bar). Select the color there in the section “Text”.

Or open the color palette in Windows \(\rightarrow\) Palettes \(\rightarrow\) Color. In the upper section of the palette you can use a menu to select whether your color settings should have an effect on the fill, the text or the lines.

I would like a picture to show through behind a table. Why is nothing happening when I select “Transparency”?

Both the container and the individual cells of a spreadsheet are filled in white by default. You have to switch both to transparency.
• Click on the container and access Format → Color → Transparency.
• Click in the table and first of all access Edit → Select All. Then reaccess Format → Color → Transparency.

I have written a text in English. RagTime, however, always uses the wrong (e. g. German) dictionary.

Has the text been set in English? The language of a text is a property of words, as is color or font in RagTime. Click somewhere in the text and open the Format → Language menu. Have you really ticked the checkbox alongside English (UK) or English (US)? To switch the text over to English, you first have to select it, for example, by using Edit → Select All. Then once again open the menu Format → Language and tick the checkbox for the required English version.

If the text is typed in the setting “German”, all potential words are hyphenated according to the German rules of grammar. You should therefore also access Extras → Hyphenate after resetting the language in order to utilize the English rules of hyphenation.

### B.2 WORKING MORE SMOOTHLY

The Foyer only always shows the six most recent documents used. Can I change that?

Use the info button in the Foyer. In the dialog box which appears you can then determine how many recently used documents should be remembered by RagTime in the General panel. Increase the amount in the field Maximum Number of Documents to Remember. In future, more documents will then be displayed in the Recently Used Foyer panel.

Take note that favorite panels have an additional setting specifying how many of the remembered documents set in General are displayed in the appropriate panel.

Why do some commands e. g. Tile Windows Vertically have no keyboard shortcuts?

RagTime knows a great many more commands than there are keys available for. So RagTime has provided users with the opportunity of creating their own keyboard shortcuts, because all users require different shortcuts to correspond to their own individual way of working.
Open EXTRAS → KEYBOARD SHORTCUTS. In the list to the left you will see the groups of commands available in RagTime. e. g. open WINDOW COMMANDS. Here you will also find TILE WINDOWS VERTICALLY. Click on the command and then to the right on CREATE under KEYBOARD SHORTCUTS. Then simply type the combination of keys you want to use for the command.

How can I, for example, type a Copyright symbol and other symbols?

How can I manage frequently used set phrases?

Such symbols can be entered via the keyboard in both Mac OS and Windows – but you have to take a slight detour:

1. Type the number 0169 into the number pad on your keyboard while holding down the alt-key in order to create a Copyright symbol.

2. Type alt-G in order to create a Copyright symbol.

It is, however, difficult to remember the keyboard shortcuts for all symbols – so RagTime also offers a further possibility:

3. Press F3 to start the entry of AUTOTEXT.

4. Press c-' to start the entry of AUTOTEXT.

Then type “(C)” and a space. The Copyright symbol will appear in the text.

This also works for “(R)” and “(TM)”, which are trademark symbols, or for Greek letters of the alphabet such as “alpha”, “beta”, “gamma”....

You can also set up your own “abbreviations” for frequently used symbols. For this simply open EDIT → AUTOTEXT SETTINGS. You can then view the predefined list of these entries and set up your own abbreviations.

The AUTOTEXT function can also be used to set up abbreviations for standard set phrases. Some text modules are also predefined, e. g. “br” for “Best Regards”.

I would like to copy a text from a document and paste it into another position without the style of the original text being transferred. Is that possible?

Yes. Use EDIT → PASTE SPECIAL. You can then determine whether style information should be transferred or not.
How can I change the default font and other default preferences in RagTime?

There are three sections that are important for preferences: predefined style sheets, the RagTime settings and the document settings for new documents.

**Change Style Sheets** based on the example of character style sheets (you can proceed analogously for other style sheet types): the default font, which RagTime uses for new documents, is set according to the “Normal Character” style sheet. Carry out the following steps to change this font:

- Open the **Windows → Auxiliaries → Character Style Sheet Editor** window.
- Open **RagTime 6 Auxiliaries.rtd** in the list of style sheets.
- Select **Normal Character**.
- Click on the **Font** panel.
- Set the font and size you require. If you also want to change hyphenation rules, change over to the panel **LINGUISTICS** and carry out the required changes here.

⚠️ The changes to the style sheets do not affect already existing documents or forms! Only new documents use these changed style sheets.

Alongside the format style sheets, documents have a whole host of **settings which are saved with the documents.** You will find them in the **EXTRAS → Document Settings** dialog box. In the dialog box there is a pop-up menu entitled **Settings for.** Here you can select **New Documents.** Then you can change the default settings for newly created documents. Here are some examples:

- **Document panel,** **Default Rulers for New Windows** option: Here you can select the window ruler, which you can best work with.
- **Pictures panel,** **Picture Import via Drag and Drop** setting: pictures can be imported by dragging them from the Explorer (Ctrl) or Finder (Cmd) into a RagTime container. You can now determine whether the picture data should be completely imported into the document (results in larger files) or whether RagTime only imports the screen representation (in this case the picture files have to remain available at a later date).
- **Hyperlinks panel:** Here you are able to specify how hyperlinks should appear on the screen and in print in the RagTime document.

⚠️ Changes made in **Document Settings** do not affect existing documents. By doing this only presets for new documents are changed.
“General Program Settings” for your work with RagTime can be found in Extras → Settings. The settings which can be carried out here, are not document-specific, but apply to all documents in RagTime. Some points which are of special interest for carrying out day-to-day work with RagTime:

- The “quotation marks” that you find on your keyboard are in reality inch symbols ("). RagTime can convert these signs into typographically correct quotation marks during entry (“”). You have to specify in the Application panel of Settings which Smart Quote Pairs are correct for your language (e.g. “” or »«).

- Application panel, File Compacting When Closing option: If elements are constantly added to or removed from a RagTime document during work, then there are “gaps” in the stored data of the document which contain unused data and inflate the file. RagTime can compact such documents again when closing, i.e. remove the gaps. Here you have to specify above which threshold RagTime should automatically carry out this process.

### B.3 BECOMING FAMILIAR WITH PAGES

**How can pages be moved to a different place in the document?**

A small “Tag” is located at the top left of every page of a layout. Click on it to select the whole page. You can now copy the page using Edit → Copy or cut it out using Edit → Cut.

First click in the gray area above or below a page in order to paste a copied or cut-out page into another position. If the area is highlighted as dark you can paste in the page using Edit → Paste.

Pages can also be directly moved by using the mouse. This is practical if you are editing the layout in an extremely small representation (10% for example) for the purpose of an overview. Position the mouse over the index card tag on one page, hold it down and at the same time drag it between two other pages.

Multiple pages can also be cut out or copied at the same time: Click the tag on a page and then the tag on a further page by holding down the control key. This way also everything in between is selected, not only both pages. The commands Copy and Paste enable you to bring together complete page sequences.
Can I view numerous, non-connected pages in an extensive document (e. g. page 1 and page 10) at the same time?

Yes. Use the window splitters! There is a small rectangle over the vertical scroll bar (Fig. 188 [p. 265]) just above the small up arrow for backwards scrolling. Click and hold this rectangle with the mouse and drag downwards. The window is thus separated into two sections, in which you can independently scroll.

Fig. 188: Splitting a window so that non-connected areas of a document are viewed at the same time.

A rectangle with a similar function, which you can use to vertically separate the window, is located beneath the lower scroll bar to the left – especially useful in spreadsheets when you need the first and the hundredth column at the same time.

Can I add empty pages in the middle of the layout?

No problem. Click in the gray area between two pages. It is then highlighted as being dark. The command EXTRAS → ADD PAGE now results in an empty page being added to this interim page space.

Can components in the inventory be duplicated?

Yes. Click on the component and drag it into the inventory by holding down **ctrl** (§) or **Alt** (©).
Can I actually print the container borders?
Yes. It is only a style property of the container borders that they are not printed as well. Open WINDOWS → AUXILIARIES → FILL STYLE SHEET EDITOR. Select “Non-printing Fill” in the list to the left. The PRINTING checkbox is located in the settings area of the dialog box. When you tick this checkbox, all container borders are set for printing.

How can I change the gray border on the page borders (non-printable area of the page)?
In RagTime: you can’t. But perhaps you can in the printer settings. This gray border only provides information about the non-printable area of the page. This way RagTime presents a graphical representation of what the print driver is conveying in figures. If your printer is able to print an area larger than the one displayed in the RagTime page representation, please consult the printer documentation to find out how to change this setting.
Appendix C: Legend

C.1 CONVENTIONS

Fonts and Styles

Commands, button names and all other names that appear in menus, dialog boxes, windows, palettes, etc. are written in this font.

Formulas, value formats and similar entries are written in this font.

Various Symbols

Windows

Mac OS X

These symbols identify sections that refer to differences between RagTime variants for Windows and Macintosh operating systems.

Remark

The indented dotted arrow marks tips or additional information ready to be applied in the every-day use of RagTime.

Warning

The little warning sign marks information needing your close attention. It points to typical sources of error or practical details which can go wrong.

Action Steps

Headlines of step-by-step guides are decorated with this symbol.

Tip

This symbol marks advanced tips for readers already somewhat familiar with RagTime. Tips are often enclosed in a box and can be skipped, especially when reading the Training Manual for the first time.

References, Links and Hyperlinks

Whenever possible, references to other sections within the documentation are highlighted by underlined and/or colored text.

If you read the documentation on-screen, you are taken to the reference by clicking the highlighted text. Of course, this applies to the on-screen documentation, but it works with PDF documents as well.

Reference [p. 999]

In print material and PDF documents, this symbol appears before the reference, while the corresponding page number or document is indicated after the reference. References without a page number or a document refer to terms explained in the Glossary.
Formulas and Functions

\( f \)  Function
This symbol identifies the names of arithmetic functions.

**Argument**  Required Argument of a Function
This style is used in the description of functions to identify arguments which must be supplied.

**Argument**  Optional Argument of a Function
This style is used in the description of functions to identify arguments which may be omitted.

" "  Primitive (straight) quotation marks
These quotation marks are only used to identify text within formulas.

Spaces
Spaces that are of special importance are represented by this symbol.

C.2 KEYBOARD SYMBOLS

\textarrow{\textleftarrow{\textrightarrow{}} \ Return, carriage return}
\textbullet{\texttimes{} \ Enter}
Please note that return and enter serve different purposes in RagTime.

\textarrow{\textrightarrow{\textdownarrow{}} \ Tabulator}
\textcircled{\textcup{\textcap{}} \ Escape}
\textleftarrow{\textuparrow{}} \ Up arrow
\textrightarrow{\textdownarrow{}} \ Down arrow
\textleftarrow{\textleftarrow{}} \ Left arrow
\textrightarrow{\textrightarrow{}} \ Right arrow
\textuparrow{\textuparrow{}} \ Page up or PgUp
\textdownarrow{\textdownarrow{}} \ Page down or PgDn

**Modifier Keys**
Modifier keys only work in combination with other keys or mouse clicks.

\textless{\textleftarrow{\textrightarrow{}} Alt}
\textless{\textleftarrow{\textrightarrow{}\textuparrow{}} AltGr}
Not available on US keyboards.
\textcup{\textcap{}} \ Command or Apple
\textcup{\textcap{}} \ Option or alt
\textgreater{} \ Control or ctrl
\textdownarrow{\textdownarrow{}} \ Shift
C.3 USER INTERFACE ELEMENTS

- **Button or push button**
  Identifies buttons that trigger immediate action.

- **Radio button**
  Identifies a group of switches, of which only one can be turned on at a time.

- **Checkbox**
  Identifies a switch that can only be on or off.

- **Menu**
  Identifies a common menu (pull-down menu).

- **Submenu**
  Identifies a hierarchical menu.

- **Submenu title**
  Identifies the title of a hierarchical menu.

- **Menu command**
  Identifies an ordinary menu command.

- **Checkmark**
  The checkmark identifies the menu's or palette’s effective setting.

- **Menu**
  Identifies menus that are coupled to tool buttons.

- **Pop-up menu**
  Identifies a menu that pops up.

- **Display field**
  Identifies display fields containing information that cannot be altered directly.

- **Entry field**
  Identifies a field in which an entry can be made.

- **Entry field with a menu, combo box**
  Identifies an entry field in which you can quickly enter frequently used values from a pop-up menu.

- **More/less**
  Identifies a switch you can use to specify whether more rarely used elements should appear in a dialog box or window.
Glossary

The glossary provides definitions of the terms frequently used in RagTime and the associated documentation.
Add-on
An Add-on is an external file which extends the functionality of RagTime. An Add-on might provide, for example, functions, additional capability to a component or even a new component type.

Alt key
\texttt{\textasciitilde t}  The Alt key.

AltGr key
\texttt{\textasciitilde t\textasciigrave}  The AltGr key.

Argument
An argument is a value which is passed to a function and is the basis for its calculation. Arguments follow the name of a function and must be enclosed in parentheses. If a function requires two or more arguments, they must be separated by semicolons: \texttt{Sum (2; 3; 4)}. An argument can be, for example, a number, a constant, a reference or a formula.

Auxiliary
An auxiliary is a part of a RagTime document which appears in the inventory and which acts on other elements in various ways. You can create, modify and delete auxiliaries in editing dialog boxes.

Bézier Curve
A Bézier curve consists of line segments defined by end points and control points which define the tangent of a line segment on the end points.

Bit Depth
The bit depth is the number of bits used to define the color of a single pixel. A larger bit depth allows more colors but uses more memory and makes the file larger.

Border
A border is the line defining the edges of a drawing object.

Bounding Box
A bounding box is a rectangle with selecting handles enclosing curves and curved, transformed or irregular shapes. When you move or resize a bounding box, the object is moved or resized accordingly.
CIRC! (Error Value)
A formula contains a reference to itself or is in a chain of formulas which
refers to itself at the “end”. This error value does not appear when iteration
is turned on. (error value)

Circular Reference
A circular reference in a formula is one that directly or indirectly refers to
the cell in which the formula containing the reference is located.

Command key
₄ The Macintosh Command key, which is also labeled with an Apple on
some keyboards.

COMPLEX! (Error Value)
The formula is too complex; it contains too many embedded parentheses
or calls to subfunctions. (error value)

Component
Components include layouts, master layouts, text, spreadsheets, graphs,
drawings, pictures, sound, movies and buttons. The components of a
document are listed in the inventory and can be displayed in windows or
installed in various objects.

Container
A container is an area, for example a drawing object, in which a compo-
nent, for example, a text, may be installed, viewed and edited.

Contents
The term “contents” refers to a component installed in a container.

Control key
₄ The Control key. It is labeled as “Ctrl” on some keyboards.

Converter
A converter (also called filter or translator) is a document containing spe-
cial information needed to import documents created with other applica-
tions. Converters cannot be opened.

Data
Data is information which you enter into your computer. Data may be, for
example, words, numbers, dates, pictures, graphics and so on.
**Date**

A date is a specific point in time. In RagTime, a date consists of a year, month day, hour, minute, and second. A date can be formatted so that only some of these parts are displayed (4/3/1995 9:30:04; April 3, 1995; 04/03/95; 9:30; 9:30:04).

Dates in the range from 1/1/0001 to 12/31/29999 are valid. An error value is displayed when you use dates outside this range.

Because the Gregorian calendar, which is the basis for RagTime’s date functions, was introduced in 1582, calculations with earlier dates have limited meaning. Please be also be aware that some countries introduced the Gregorian calendar significantly later.

**DATE! (Error Value)**

A date is outside the supported range, or a part of a date has an invalid value, for example 13 as month. (• error value)

**Default Value**

A default value is a value, action or setting that RagTime assumes until you give it a different instruction. A default value is also called a pre-set value. You can set default values in the “document settings” or “settings” dialog boxes.

**Discontinuous Cell Range**

A discontinuous range consists of two or more cells or ranges not sharing a common boundary.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**DIV/0! (Error Value)**

Division by zero was attempted. (• error value)

**Down arrow key**

The key with the arrow pointing down.

**Enter key**

The Enter key is often shortened to simply “Enter”. It is frequently confused with the Return key (↵). In RagTime however, these two keys frequently have different functions.
Error Value
An error value is the result of an erroneous, undefined or impermissible calculation. Error values propagate themselves in the results of all formulas in which an error value is used as an argument or operator. Error values are always displayed in upper case letters followed by an exclamation mark.

ERROR! (Error Value)
An error which does not fit in any other category. (error value)

Escape key
The Escape key.

EVAL! (Error Value)
The formula uses the result of a calculation which returned the error value CIRC!. (error value)

Export
To export means to save a selection in the form of an exchange format file, such as plain text, to make it available to other programs.

File
A file is any named collection of information stored on a disk. For example, documents created with RagTime are files.

Fill
The fill is the area of a drawing object, spreadsheet cell or graph label or title. A fill may have a color, a pattern or a gradient or be transparent.

Formula
A “formula” is a rule for calculating a value. Formulas, which you can enter in the formulas palette, can be used in various components. A formula may be complex or as simple as a cell reference or “1+1”. Formulas can, but need not, include functions.

Function
A function is a predefined set of actions that perform a calculation using values you specify or supply.

Functions can be inserted in formulas to do mathematical, text, date, search, print and other operations.
ILLEGAL! (Error Value)
The formula uses a function which is not installed. (« error value)

Import
To import material means to insert the data from one document into a second document.

Insertion Marker
The insertion marker is a blinking line indicating where text will be inserted in a document. You can position the insertion marker by clicking the pointer over text.

Interval
An interval describes a limited set of values. The lower and upper limits are given in square brackets: [−1; +1].

If the bracket opens away from the value, it is not included in the interval. For example, [0; 1[ includes all numbers equal to or greater than 0 to and less than 1.

Inventory
The inventory is a list of components, style sheets and certain other elements, such as rulers and units, contained in a document. You can open components and style sheet editors by double-clicking the name in the inventory list or drag items onto document pages or to other documents.

Left and Right of Axes and Lines
Because lines and axes may be rotated, “left” and “right” are defined in terms of the “direction of motion.” For lines, the direction is defined to be from the starting point to the end point. For value axes, the direction is defined to be in the direction of ascending values; for category axes, the sequence of the categories.

For closed drawing objects, left is the equivalent of outside and right, inside. Consequently, when you open or close a polygon or Bézier curve, the line may be drawn in a different position.

Left arrow key
← The key with the arrow pointing left.
**Line**
Straight lines and arcs are lines. Lines cannot contain components. Open polygons and Bézier curves are lines in the sense that they can have arrowheads, but unlike lines, they can contain components.

**Line Spacing**
Line spacing is the vertical space between lines of text measured from baseline to baseline.

**List**
A list consists of one or more values (constants or references, including references to ranges). In formulas, the elements in a list are separated with semicolons (for example, \(47; 11; 8; 15\) or \(A1; B7; C1:D3\) or \(Z1S1; Z7S2; Z1S3:Z3S4\)).

**Magnetic Grid**
The magnetic grid helps size and align objects precisely on the page. When you drag or create an object, its borders snap to the nearest grid lines. You can use the magnetic grid whether or not the grid is visible.

**Mixed**
If the selection includes more than one variation for a single attribute, the setting for that attribute is “mixed.” For example, if a single text selection includes Chicago and Geneva fonts, the setting for fonts is “mixed.”

**Multiline Text**
Multiline text is broken at the end of a line in a spreadsheet cell.

**NA! (Error Value)**
A value is not available because, for example, it could not be found in a spreadsheet, or an operand or argument has the constant value “NA”. (► error value)

**NAME! (Error Value)**
This error is never caused by RagTime and can only occur in spreadsheets imported from Excel. The error is supported to provide compatibility with Excel. (► error value)
**NULL! (Error Value)**

This error is never caused by RagTime and can occur in spreadsheets imported from Excel. The error is supported to provide compatibility with Excel. The Address Book functions or RagTime Connect return this error value for database fields containing no data. (► error value)

**NUM! (Error Value)**

An undefined operation was attempted, or the result is outside the range of numbers possible in RagTime. (► error value)

**Number**

A number is a numerical amount. RagTime can work with positive and negative integers and decimal fractions. In addition to the common forms of notations, RagTime supports exponential notation and thousands separators (42; -4711; 123.45; -2,987.65; 1.41e8).

**Object**

In the most general sense, an object is any element that you can select. Often, the term “object” is used as a short form of “drawing objects,” for example, lines, rectangles and so on.

**Operand**

An operand is a value acted on to perform a calculation in a formula. In the equation “1+2=3” “1” and “2” are operands.

**Operators**

Operators are symbols used in a formula to define the action to be performed, for example “+” for addition.

**Option key**

 валют The Option key.

**Page Down key**

ï‡š The Page Down key.

**Page Gap**

A page gap is the space above the first page, between pages and after the last page of a document.
Click anywhere in this gap to select it. A new page may then be inserted in or appended at that particular place, or a copied page may be pasted.

You can also drag pages from other documents to the page gap.

**Page Size**
The page size is the area defined for each page of the document. Document pages larger than the available paper size can be printed on several sheets of paper.

**Page Tag**
A page tag is a small extension at the top of a page displaying the page number and name, if any. Click this tag to select the entire page and activate the layout component.

**Page Up key**
† The Page Up key.

**Palette**
A palette is a window which is always in front of other windows. Tool palettes make frequently used commands quickly accessible. You can tear off some submenus to create palettes which stay open while you are working on a document. In the submenu of the command “Palettes” in the Windows menu, you can find a number of tool palettes.

**Panel**
Panels are subdivisions of extensive dialog boxes or windows in which related settings are grouped.

- Panel names are displayed on tabs above the current panel.
- Panel names appear in a list on the left side of the dialog box.

**Range**
A range is a contiguous, rectangular group of spreadsheet cells. In formulas, a range is defined by its upper left and lower right cells separated with a colon (for example B2:C4, Z2S2:Z4S3 or [1]A1:[3]D4).
RANGE! (Error Value)
A value is outside the permitted range. (error value)

REF! (Error Value)
A formula uses a reference to a nonexistant object. Generally, the referenced object has been deleted after the formula was entered. (error value)

Return
Calculating a function or a formula results in a value. The function or formula “returns” this value, which may then appear, for example, in a spreadsheet, or be used in calculating another function or a formula.

Return key
The Return key is also known as the carriage return. It is often confused with the Enter key (Enter). In RagTime however, these two keys frequently have different functions. Only use this key at the end of a paragraph not at the end of lines.

Right arrow key
The key with the arrow pointing right.

Rotation Point
The rotation point is a small circle which appears in the center of a selected drawing object. When the pointer moves over it, it changes to the rotation tool pointer.

Scope
The scope is the region in which certain operations, for example, search and replace or checking spelling, are performed. Possible scopes are components, layouts, windows, all open documents and so on.
Screening
Screening is a process for printing pictures on a black-and-white printer in which gray tones are reproduced by a pattern of black dots or lines on white paper. If the dots are small enough, they will seem gray from a normal viewing distance.

Script
A script is a set of commands which you can activate with a single command. You can use scripts to automate repetitive tasks. Scripts allow numerous programs to work together.

Search Expression
A search expression is understood as the characters, words or special characters that should be found using the command SEARCH. It is also possible to consider the format when searching.

Selection Handles
Selection handles are black squares appearing on the border of a drawing object, a bounding box or the ends of a line when an object is selected. Drag them to change the size or form of the object.

Shift key
The Shift key.

Special Character
Special characters are not normally visible in text, but influence the appearance of text, for example, blank spaces, tabs and paragraph ends.

Tab key
The Tab key.

Tearing Off Menus
To create a palette by tearing off a submenu, move the pointer up, down or to the right through the submenu.

Text
A text is a sequence of letters and other characters.
In formulas, text must be enclosed in single or double quotation marks (for example, 'This is a text' or "Oh no!*2$%&@")
**Time Span**
A time span is a period of time.

In formulas, a time span can be given in the units day [d], hour [h], minute [m], and second [s] (for example 3d 5h 2m 28s).

At least two units must be given in order for a time span to be recognized. If necessary, use a 0 as the second value: 5h 0m.

**Transform**
To transform a drawing object means to modify it by rotating, skewing or scaling.

**Transformation**
The transformation of a drawing object is defined by the combination of all rotations, scalings and skewings applied to that object. It affects both the shape of the object and the representation of components installed in the object.

**Truth Value**
A truth value is either True or False.

When converted to numerical values, False has the value 0 and True, 1. If numbers are converted to truth values, 0 has the value False and all numbers ≠ 0 are True.

**Up arrow key**
↑ The key with the arrow pointing up.

**Value**
A value is a number, a text, a reference, a date, a truth value, or an error value. In other words, this expression includes all possible sorts of arguments for functions that RagTime supports.

**VALUE! (Error Value)**
An operator or argument has the wrong type, for example, a date instead of a number. (► error value)
Index
General index entries usually refer to a section of text, i.e. the page number refers to a section’s header (light typeface against a dark background). If a section carries over onto the subsequent page, the entry may also appear on the subsequent page.

Many key words are listed alphabetically as well as under the following categories: commands, definitions, document settings, entry fields, functions, basic settings, buttons, menus, palettes, panels, overviews, style sheets, tools and tool bars.

**SYMBOLS**

- .rtd ........................................ 22, 172
- .rtt ........................................ 22, 171

**A**

Abacus
  Tool Bar .................................. 101
Abacus Symbol ................................ 100
Add Anchor Points (Tool) .................. 153
Add-on (Definition) ......................... 272
☞ ADD PAGE ............................... 176, 185, 212, 227, 237, 265
☞ ADD TO FAVORITES ..................... 198
Adding source data (Graph) ............... 132
Address Field ............................... 68
Addresses (Spreadsheet) ................. 93, 111
Adjust Foyer (Tip) ......................... 44
Adobe Distiller (PDF) ..................... 242
☞ ALIGN ..................................... 225
ALIGN OBJECTS (Dialog Box) ........... 225
Aligning Tabs to Left or Right Margin (Tip) 179
Alignment
  Duplicates ............................... 60
Alt key (Definition) ....................... 272
Alternative to Tabs (Spreadsheet) ....... 80
AltGr key (Definition) .................... 272
☞ AMOUNT OF PAGES ................. 80, 177, 216
Anchor Points
  Curves .................................... 152
  select .................................... 152
Angles

exact .......................................... 146
Ant Line ..................................... 64
☞ APPEND PAGE ........................... 224
Apple key (Definition) ................... 273
APPLICATION (Panel) ..................... 264
☞ APPLY .................................... 104, 134
Arcs .......................................... 148
Argument (Definition) ................... 272
Arguments ................................... 101
Arithmetic Operator ...................... 113
Arrange Objects
  Drawing ................................... 61
☞ ARRANGE OBJECTS .................... 61, 168, 235
ARRANGEMENT (Panel) .................... 97, 109, 110, 120, 121, 199, 200, 221, 224
Arrow key (Definition) ................... 274, 276, 280, 282
Arrows ....................................... 146
☞ AS MailMerge Formula ................. 138
☞ AS Set in Layout Page Setup ........ 245
☞ AS Set in Page Setup ................... 246
☞ AS Stationery ............................ 171
☞ AS Stationery Pad ....................... 183
☞ AUTOMATIC .............................. 245
☞ AUTOMATIC DATE ...................... 80
Automatic Following Pages ............. 166
Automatic Page Generation
  Settings ................................... 181
☞ AUTOMATIC TIME ...................... 80
Automobile (Spreadsheet) ............... 94
☞ AutoText Settings ....................... 262
Auxiliaries .................................. 42
☞ Auxiliaries ............................... 42, 126, 192, 195, 197, 204, 222, 231, 234, 247, 263, 266
<table>
<thead>
<tr>
<th>Auxiliary (Definition)</th>
<th>272</th>
</tr>
</thead>
<tbody>
<tr>
<td>f Average</td>
<td>124</td>
</tr>
<tr>
<td>☐ Average Height to Fill Container with Selected Rows</td>
<td>199</td>
</tr>
<tr>
<td>☐ Average Width to Fill Container with Selected Columns</td>
<td>199</td>
</tr>
</tbody>
</table>

**B**

<table>
<thead>
<tr>
<th>Back Page</th>
<th>226</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Knowledge: Containers and Content Types (Tip)</td>
<td>70</td>
</tr>
<tr>
<td>Basic Settings</td>
<td></td>
</tr>
<tr>
<td>Default Font</td>
<td>263</td>
</tr>
<tr>
<td>☞ Basic Settings</td>
<td>61</td>
</tr>
<tr>
<td>Basics (Spreadsheet)</td>
<td>93</td>
</tr>
<tr>
<td>Bézier Curve (Definition)</td>
<td>272</td>
</tr>
<tr>
<td>Bézier Curves</td>
<td></td>
</tr>
<tr>
<td>Edit</td>
<td>152</td>
</tr>
<tr>
<td>Bézier Objects</td>
<td>146</td>
</tr>
<tr>
<td>Bézier (Tool)</td>
<td>145</td>
</tr>
<tr>
<td>Bit Depth (Definition)</td>
<td>272</td>
</tr>
<tr>
<td>Boolean value (Definition)</td>
<td>282</td>
</tr>
<tr>
<td>Border (Definition)</td>
<td>272</td>
</tr>
<tr>
<td>Borders</td>
<td>93</td>
</tr>
<tr>
<td>☞ Borders</td>
<td>104, 109, 204, 221</td>
</tr>
<tr>
<td>BORDERS</td>
<td>109</td>
</tr>
<tr>
<td>☐ Bottom Border</td>
<td>104</td>
</tr>
<tr>
<td>☐ Bottom Margin</td>
<td>109</td>
</tr>
<tr>
<td>Bounding Box (Definition)</td>
<td>272</td>
</tr>
<tr>
<td>Business Letter</td>
<td>68</td>
</tr>
<tr>
<td>Business Publishing</td>
<td>20</td>
</tr>
<tr>
<td>Button (Component)</td>
<td>28</td>
</tr>
<tr>
<td>Buttons</td>
<td></td>
</tr>
<tr>
<td>☐ Add to Favorites</td>
<td>198</td>
</tr>
<tr>
<td>☐ Apply</td>
<td>104, 134</td>
</tr>
<tr>
<td>☐ As MailMerge Formula</td>
<td>138</td>
</tr>
<tr>
<td>☐ As Set in Layout Page Setup</td>
<td>245</td>
</tr>
<tr>
<td>☐ As Set in Page Setup</td>
<td>246</td>
</tr>
<tr>
<td>☐ As Stationery</td>
<td>171</td>
</tr>
<tr>
<td>☐ As Stationery Pad</td>
<td>183</td>
</tr>
</tbody>
</table>

- ☐ Automatic | 245 |
- ☐ Average Height to Fill Container with Selected Rows | 199 |
- ☐ Average Width to Fill Container with Selected Columns | 199 |
- ☐ Bottom Border | 104 |
- ☐ Bottom Margin | 109 |
- ☐ By Column | 124 |
- ☐ Center | 186 |
- ☐ Central Alignment | 225 |
- ☐ Clipping Path | 239 |
- ☐ Close | 192, 204 |
- ☐ Color Separation | 248 |
- ☐ Complete Data in the Document | 45 |
- ☐ Composite Color | 246 |
- ☐ Continue | 252 |
- ☐ Convert Everything to Images | 250 |
- ☐ Convert Formats | 141 |
- ☐ Convert to Image as Rarely As Possible | 251 |
- ☐ Create | 126, 179, 204, 231, 234, 262 |
- ☐ Create Document with Layout | 51 |
- ☐ Create from Selection | 127, 195, 197 |
- ☐ Cutmarks | 245 |
- ☐ Delete All | 216 |
- ☐ Double-Sided | 189 |
- ☐ Export Everything to a Single HTML Page | 251 |
- ☐ Export JPEG and PNG Pictures in Original Format | 251 |
- ☐ Fixed | 72 |
- ☐ Gray | 247 |
- ☐ If the Specified Formula Returns True | 219 |
- ☐ Inner Verticals | 221 |
- ☐ Insert | 102, 116, 122, 123 |
- ☐ Insert Symbol | 198 |
- ☐ Insert with Arguments | 122 |
- ☐ Linked to File | 45 |
Modify Stationery ............. 173

New ............................. 212

New (horizontal) .................. 186

New (vertical) .................... 186

OK .................. 104, 124, 132–134, 217, 218, 233

Only Screen Representation in Document ................. 45

Open .................. 161, 173, 205

Outer Borders .................. 221

Precision as Formatted .......... 203

Print All .................. 142

Printing ..................... 266

Range of Cells ................ 117

Save .................. 171, 183

Separate Print Jobs ............. 143

Set as Default ................ 51

Tear Off .................. 173

Text Flows Around ............. 163

To Which No Special Rule Applies ... 218, 237

Torn Off Completely .......... 181, 182

When in doubt, convert to image .......... 251

Whose Index Counted from the End Is Specified .......... 218, 219, 237

Whose Index Counted from the Start Is Specified .. 216, 217, 219, 237

Whose Number Is Specified .. 216–218

Zero Values Hidden .......... 203

By Column

Sort .......................... 124

By Column ..................... 124


text: "Calculate Width to Fill Container with Selected Columns ...... 120"

Calculation Methods ............... 113

Calculations .................. 93, 99

Calendar Dates ................ 96

Carriage return key (Definition) ........ 280

Categories .................. 134

Categories (Panel) ............. 134

Category Titles ................ 134

Category Titles (Graph) .......... 134

Cell Addresses (Spreadsheet) .... 111

Cell Borders ................. 93

Cell Contents

Spaces to cell borders .......... 200

Vertical Position ............... 200

CELL CONTENTS (Panel) ........ 203

Cell range (Definition) ......... 279

Cell Ranges

in Formulas .................. 123

Cell Unions .................. 109

Cells

Arrangement .................. 200

as Containers ................. 203

Highlight .................. 197

Union .................. 109

Cells (Spreadsheet) .......... 93

Center .................. 186

Central Alignment ............. 225

Change Name

Components .................. 218

Changes

to Master Layout ............. 224

Changing Object Type to Change the Shape (Tip) ........ 150

Changing Picture Size, Picture Position and Container Size (Tip) .......... 64

Character

Style Sheet .................. 24

Character Formats ............ 76

CHARACTER FORMATS (Dialog Box) .......... 76

CHARACTER STYLE SHEET EDITOR .......... 126,
Character Style Sheet Editor (Dialog Box) ........................................... 126, 127
Character Style Sheet ................................................................. 130

Character Style Sheets ............................................................ 126
    Create ......................................................... 126, 196
    Edit ........................................................... 126

Chart Type (Graph) ................................................................. 132

Checkboxes ................................................. see Buttons
CIRC! (Definition) ................................................................. 273

Circular Pipeline ................................................................. 179
    in Master Layout ................................................. 216

Circular Reference (Definition) ................................................ 273

Clear ................................................................. 224

Clipping Path ................................................................. 238

Clipping Path ................................................................. 239

Close ................................................................. 47

Close Document ................................................................. 47

Closed Shapes (Tool) ............................................................... 145

CMYK ................................................................. 247

Color
    Background ......................................................... 260
    Cell Background .................................................. 260
    Fill .............................................................. 260
    Font ............................................................. 260
    Lines .............................................................. 260

Select (Mac OS) ................................................................. 233

Select (Windows) ................................................................. 231

Style Sheet ................................................................. 24

Color ................................................................. 260

Color Editor ................................................................. 247

Color ................................................................. 197, 222, 261

Color Profiles ................................................................. 248, 249

Color Separation ............................................................... 248

Color Space ................................................................. 247

Colors (Panel) ................................................................. 246

Column Width
    Adapt ............................................................. 120
    Change ........................................................ 108

Columns (Spreadsheet) .......................................................... 93

Add Page ................................................................. 176, 185, 212, 227, 237, 265

Align ................................................................. 225

Amount of Pages .............................................................. 80, 177, 216

Append Page ................................................................. 224

Arrange Objects ............................................................... 61, 168, 235

Automatic Date ................................................................. 80

Automatic Time ................................................................. 80

AutoText Settings ............................................................... 262

Basic Settings ................................................................. 61

Borders ................................................................. 104, 109, 204, 221

Calculate Height to Fill Container with Selected Rows ......................................................... 120

Calculate Width to Fill Container with Selected Columns ......................................................... 120

Character Style Sheet Editor 126, 192, 195, 263

Clear ................................................................. 224

Close ................................................................. 47

Close Document ................................................................. 47

Color ................................................................. 260

Color Editor ................................................................. 247

Copy ................................................................. 132, 203, 264

Create Document with Layout ......................................................... 51, 118

Create from Selection ......................................................... 131

Create Union ................................................................. 110, 203

Cut ................................................................. 264

Date Field ................................................................. 264

Document Date ................................................................. 80

Document Date (short) ......................................................... 81, 195

Document Settings ......................................................... 80, 176, 181, 183, 194, 195, 263

Double-Sided Master Page ......................................................... 237

Duplicate ................................................................. 60

Edit Curve ................................................................. 152

Export ................................................................. 32

Export as HTML ................................................................. 250

Export as PDF ................................................................. 243
<p>| Index: C |
|---|---|
| Export HTML | 32 |
| Export PDF | 32 |
| Export to PDF | 242 |
| Fill Sequence | 105 |
| Fill Style Sheet Editor | 231, 266 |
| Fit Container to Picture | 239 |
| Fit to Window | 53 |
| Fixed | 72 |
| Formatting | 130 |
| Formula Borders in Text | 81, 139 |
| Formulas | 81 |
| Get Info | 64, 71, 96, 109, 169, 189, 216 |
| Guides | 186 |
| Hyphenate | 261 |
| Import | 32, 45, 83, 141, 160 |
| Insert | 132, 203 |
| Insert Columns | 125 |
| Insert Page Break | 117 |
| Insert Rows | 125 |
| Insert Symbol | 198 |
| Inventory | 40 |
| Keyboard Shortcuts | 262 |
| Layout | 219, 237 |
| Line Formats | 144, 234 |
| Line Style Sheet Editor | 204 |
| Mirror above &lt; – &gt; below | 159 |
| Non-printing Elements | 205 |
| Non-printing Items | 77 |
| Nonprinting Items | 29 |
| Number of Following Page | 80 |
| Open “Training” Folder | 62 |
| Open Current Library | 206 |
| Open Document | 173 |
| Open Inventory | 40 |
| Optimize Column Width / Row Height | 199 |
| Other | 231, 232 |
| Page Format | 53, 155 |
| Page Number | 80, 177, 187, 216 |
| Paragraph Formats | 79, 82 |
| Paste | 264 |
| Paste Special | 120, 262 |
| Pipelines | 87, 92, 176, 185, 260 |
| Place in a new layout component | 118 |
| Print | 46, 142 |
| Print Once | 46 |
| Quit | 47 |
| Remove Page Break | 117 |
| Remove Transformation | 152 |
| Remove Union | 111 |
| Reset Transformation | 152 |
| Rotate 90° to the right | 159 |
| Ruler and Grid Settings | 54 |
| Save As | 45, 172 |
| Save Document | 45, 171, 183 |
| Search and Replace | 29 |
| Select All | 78, 100, 200, 220, 261 |
| Select Library | 205 |
| Send Backward | 215 |
| Send to the Back | 215 |
| Settings | 264 |
| Show Grid | 54 |
| Snap to Grid | 54 |
| Sort | 124, 125 |
| Special Characters | 78, 97, 170 |
| Spreadsheet | 220 |
| Spreadsheet Commands | 125 |
| Swap Two Characters | 99 |
| Text | 214 |
| Tile Windows Horizontally | 138 |
| Tile Windows Vertically | 138, 261, 262 |
| Time Field | 80 |
| Transparency | 215, 261 |
| Typography | 66 |
| Undo | 99 |
| What's This? | 36 |
| Commercial Rounding | 203 |
| Complete Data in the Document | 45 |
| COMPLEX! (Definition) | 273 |</p>
<table>
<thead>
<tr>
<th>Index: D</th>
<th>289</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component (Definition)</td>
<td>273</td>
</tr>
<tr>
<td>Components</td>
<td>25</td>
</tr>
<tr>
<td>Button</td>
<td>28</td>
</tr>
<tr>
<td>Change Name</td>
<td>218</td>
</tr>
<tr>
<td>Drawing</td>
<td>26, 144</td>
</tr>
<tr>
<td>duplicate</td>
<td>265</td>
</tr>
<tr>
<td>Edit window</td>
<td>41</td>
</tr>
<tr>
<td>Graph</td>
<td>26, 131</td>
</tr>
<tr>
<td>Layout</td>
<td>27, 50</td>
</tr>
<tr>
<td>Master Layout</td>
<td>27</td>
</tr>
<tr>
<td>Picture</td>
<td>27</td>
</tr>
<tr>
<td>Sound</td>
<td>28</td>
</tr>
<tr>
<td>Spreadsheets</td>
<td>26, 93</td>
</tr>
<tr>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Composite Color</td>
<td>246</td>
</tr>
<tr>
<td>Construction of Formulas</td>
<td>100</td>
</tr>
<tr>
<td>Container</td>
<td>28</td>
</tr>
<tr>
<td>Edit</td>
<td>57</td>
</tr>
<tr>
<td>Fit to Picture</td>
<td>239</td>
</tr>
<tr>
<td>Hide Borders</td>
<td>77</td>
</tr>
<tr>
<td>Text</td>
<td>260</td>
</tr>
<tr>
<td>Container Border print</td>
<td>266</td>
</tr>
<tr>
<td>Set Properties</td>
<td>168</td>
</tr>
<tr>
<td>Container Content Type (Master Layout)</td>
<td>213</td>
</tr>
<tr>
<td>Container (Definition)</td>
<td>273</td>
</tr>
<tr>
<td>Container Representation</td>
<td>29</td>
</tr>
<tr>
<td>Containers</td>
<td>25, 50</td>
</tr>
<tr>
<td>CONTENT TYPE</td>
<td>69</td>
</tr>
<tr>
<td>CONTENT TYPE</td>
<td>214, 220</td>
</tr>
<tr>
<td>Contents transfer</td>
<td>120</td>
</tr>
<tr>
<td>Contents (Definition)</td>
<td>273</td>
</tr>
<tr>
<td>CONTINUE</td>
<td>252</td>
</tr>
<tr>
<td>Control key (Definition)</td>
<td>273</td>
</tr>
<tr>
<td>CONVERT EVERYTHING TO IMAGES</td>
<td>250</td>
</tr>
<tr>
<td>CONVERT FORMATS</td>
<td>141</td>
</tr>
<tr>
<td>CONVERT TO IMAGE AS RARELY AS POSSIBLE</td>
<td>251</td>
</tr>
<tr>
<td>Converter (Definition)</td>
<td>273</td>
</tr>
<tr>
<td>Coordinates Drawing Information</td>
<td>71</td>
</tr>
<tr>
<td>COORDINATES (Palette)</td>
<td>149</td>
</tr>
<tr>
<td>COORDINATES (Panel)</td>
<td>71, 74, 132, 148, 150, 157, 158, 168, 177, 185, 225</td>
</tr>
<tr>
<td>COPY</td>
<td>132, 203, 264</td>
</tr>
<tr>
<td>Create Character Style Sheets</td>
<td>126</td>
</tr>
<tr>
<td>CREATE</td>
<td>126, 179, 204, 231, 234, 262</td>
</tr>
<tr>
<td>CREATE DOCUMENT WITH LAYOUT</td>
<td>51</td>
</tr>
<tr>
<td>CREATE DOCUMENT WITH LAYOUT</td>
<td>51, 118</td>
</tr>
<tr>
<td>CREATE FROM SELECTION</td>
<td>127, 195, 197</td>
</tr>
<tr>
<td>CREATE FROM SELECTION</td>
<td>131</td>
</tr>
<tr>
<td>Create (Graph)</td>
<td>132</td>
</tr>
<tr>
<td>Create Letterhead</td>
<td>75</td>
</tr>
<tr>
<td>CREATE UNION</td>
<td>110, 203</td>
</tr>
<tr>
<td>CSS</td>
<td>250</td>
</tr>
<tr>
<td>CURVE EDITING (Palette)</td>
<td>152, 153</td>
</tr>
<tr>
<td>Curve Splitting (Tool)</td>
<td>153</td>
</tr>
<tr>
<td>Curves Anchor Points</td>
<td>152</td>
</tr>
<tr>
<td>curves</td>
<td>152</td>
</tr>
<tr>
<td>Edit Mode</td>
<td>152</td>
</tr>
<tr>
<td>CURVES EDITING (Palette)</td>
<td>154</td>
</tr>
<tr>
<td>Customizing Graphs (Tip)</td>
<td>136</td>
</tr>
<tr>
<td>CUT</td>
<td>264</td>
</tr>
<tr>
<td>Cut Pipeline Tool (Tool)</td>
<td>185</td>
</tr>
<tr>
<td>Cut Pipeline tool (Tool)</td>
<td>87</td>
</tr>
<tr>
<td>CUTMARKS</td>
<td>245</td>
</tr>
<tr>
<td>Data Base</td>
<td>32</td>
</tr>
<tr>
<td>Data (Definition)</td>
<td>273</td>
</tr>
<tr>
<td>CONTINUE</td>
<td>252</td>
</tr>
<tr>
<td>Data Entry (Spreadsheet)</td>
<td>95</td>
</tr>
<tr>
<td>Data Exchange</td>
<td>32</td>
</tr>
<tr>
<td>Data Export</td>
<td>32</td>
</tr>
<tr>
<td>Data from Foreign Applications as Address Source (Tip)</td>
<td>141</td>
</tr>
<tr>
<td>Data Import</td>
<td>32</td>
</tr>
<tr>
<td>Date</td>
<td></td>
</tr>
</tbody>
</table>
enter ............................... 80
long .................................. 81
short .................................. 81
Date (Definition) ...................... 274
% DATE FIELD .......................... 80
Date Functions ........................ 116
DATE! (Definition) ................. 274
DEFAULT CHARTS (Panel) ............ 132
Default Font
  Change ................................ 192
Default Tabs ............................ 81
Default Units ........................... 194
Default Value (Definition) ......... 274
Definitions
  Add-on ................................ 272
  Alt key ................................ 272
  AltGr key ............................... 272
  Apple key ............................... 273
  Argument ................................ 272
  Arrow key ............................... 274, 276, 280, 282
  Auxiliary ................................ 272
  Bézier Curve ............................ 272
  Bit Depth ................................ 272
  Boolean value ......................... 282
  Border .................................. 272
  Bounding Box ............................ 272
  Carriage return key .................... 280
  Cell range .............................. 279
  CIRC! .................................... 273
  Circular Reference ..................... 273
  Command key ............................. 273
  COMPLEX! ................................ 273
  Component ................................ 273
  Container ................................ 273
  Contents ................................ 273
  Control key .............................. 273
  Converter ................................ 273
  Data ..................................... 273
  Date ..................................... 274
  DATE! .................................... 274
  Default Value ........................... 274
  Discontinuous Cell Range .......... 274
  DIV/o! .................................... 274
  Enter key ................................ 274
  Error value .............................. 275
  ERROR! ................................... 275
  Escape key .............................. 275
  EVAL! ..................................... 275
  Export .................................... 275
  File ....................................... 275
  Fill ....................................... 275
  Formula .................................. 275
  Function .................................. 275
  ILLEGAL! ................................ 276
  Import .................................... 276
  Insertion Marker ...................... 276
  Interval .................................. 276
  Inventory ............................... 276
  Left and Right of Axes and Lines .... 276
  Line ....................................... 277
  Line Spacing ............................ 277
  List ....................................... 277
  Logical value ......................... 282
  Magnetic Grid ........................... 277
  Mixed .................................... 277
  Multiline text ........................... 277
  NA! ....................................... 277
  NAME! ..................................... 277
  NULL! ..................................... 278
  NUM! ....................................... 278
  Number ................................... 278
  Object .................................... 278
  Operand .................................. 278
  Operator .................................. 278
  Option key ................................ 278
  Page Down key ............................ 278
  Page Gap .................................. 278
  Page Size .................................. 279
  Page Tag .................................. 279
  Page Up key ............................. 279
  Palette .................................... 279
  Panel ..................................... 279
Point in Time ....................... 274
Range .............................. 279
RANGE! ............................ 280
REF! ............................. 280
Return .............................. 280
Return key .......................... 280
Rotation point ..................... 280
Scope ............................... 280
Screening ........................... 281
Script ............................... 281
Search Expression ................ 281
Selection Handles ............... 281
Shift key ............................. 281
Special Character ................ 281
Tab key ............................... 281
Tearing Off Menus ............... 281
Text ................................. 281
Time Span .......................... 282
Transform ........................... 282
Transformation .................... 282
Truth value ......................... 282
Value ................................ 282
VALUE! .............................. 282
DELETE ALL ....................... 216
Delete Columns (Spreadsheet) 125
Delete Rows (Spreadsheet) .... 125
Determining Guide Positions (Tip) ..... 227
Diagonal Text ..................... 225
Dialog Boxes
ALIGN OBJECTS .................. 225
Character Formats ............... 76
CHARACTER FORMATS .......... 76
CHARACTER STYLE SHEET EDITOR 126, 127
DRAWING INFORMATION 71, 74, 157, 162, 168, 185
EXPORT TO PDF .................. 242
FILL STYLE SHEET EDITOR 197, 222, 223
IMPORT ........................... 46
INFORMATION ..................... 71, 72
LAYOUT INFORMATION .......... 189, 237
LINE FORMATS .................... 234
LINE STYLE SHEET EDITOR .... 234
NEW CATEGORY SERIES ......... 132
OPEN ............................... 173, 205
PAGE SETUP ..................... 227
PAPER FORMAT ................... 227
Paragraph Formats ............. 76
PDF EXPORT ...................... 243
PICTURE INFORMATION ........ 64
SPREADSHEET INFORMATION .... 199, 200, 203, 205, 221, 224
SPREADSHEET INFORMATION .... 121
SYMBOLS ......................... 198
Discontinuous Cell Range (Definition) 274
Display Files (PDF) ............. 244
DISPLAY SCALE ................... 53, 188
Display Special Characters .... 97
Distance between text and container border .......... 169
_DISTANCE FROM CONTAINER .... 239
DIV/o! (Definition) ............. 274
Document Date ................... 116
in torn-off documents .......... 176
DOCUMENT DATE ................. 80, 170
Document Date (short) ......... 81, 195
DOCUMENT (Panel) 80, 176, 181, 183, 194, 195, 263
DOCUMENT SETTINGS 80, 176, 181, 183, 194, 195, 263
documents
Save as a Stationery Pad ....... 171
Tear Off ............................. 166, 172
double-sided documents
live ................................. 21
Double-Sided
Document .......................... 184
Layout .............................. 189
DOUBLE-SIDED .................. 189
double-sided Document with Two-column
Page Layout (Tip) ............... 191
E

Edit

Bézier curves  152
Character Style Sheets  126
Drawing Objects  147
Duplicate  60
Insert Special Text  80
Paste Special  120
Polygons  152

Edit Curve  152

Edit  38, 60, 78, 80, 81, 99, 100, 120, 132, 170, 177, 187, 195, 198, 200, 203, 216, 220, 224, 261, 262, 264

Edit Mode

curves  152

c Ed it window

for components  41

Effectively Managing Stationery in the Foyer (Tip)  173

empty (Spreadsheet)  94

ENABLE  46

Enter key (Definition)  274

ENTER SPECIAL TEXT  187

Entry fields

CATEGORY T ITLES  134

DISTANCE FROM CONTAINER  239

DUPICATION OFFSET  61

FROM...TO...  142

HEIGHT  110

MAXIMUM NUMBER OF DOCUMENTS TO REMEMBER  261

POSITION  71, 72

REDUCE FONT BY ... P I XELS  252

SIZE  71, 158, 192

TEXT WRAP DISTANCE  239

WIDTH  110

Error value (Definition)  275

ERROR! (Definition)  275

Escape key (Definition)  275

EVAL! (Definition)  275
Exact Changes (Tip) ........................................ 109
Example Files ............................................. 62
Excel Files .................................................... 32
Export
  HTML ......................................................... 32
  PDF .......................................................... 32
Export as HTML ............................................ 250
Export as HTML (Dialog Box) ......................... 250
Export as PDF ................................................. 243
Export (Definition) .......................................... 275
Export Everything to a Single HTML Page ........... 251
Export HTML .................................................. 32
Export JPEG and PNG Pictures in Original Format ... 251
Export PDF ....................................................... 32
Export to PDF .................................................. 242
Export to PDF (Dialog Box) ............................ 242
Extras ......................................................... 61, 72, 80, 176, 181, 183, 185, 195, 212, 224, 227, 261–265

Fill Sequence .................................................. 105
Fill Sequences (Spreadsheet) ......................... 105
Fill Style Sheet Editor ..................................... 231, 266
Fill Style Sheet Editor (Dialog Box) .................. 197, 222, 223
Fill Style Sheet ............................................... 215
Filling Multiple Cells with the Same Contents (Tip) .... 107
Fills
  Style Sheet ................................................... 24
  transparency ................................................. 215
Fit Container to Picture .................................... 239
Fit to Window .................................................. 53
Fixed ........................................................... 72
Fixed ........................................................... 72
Fixed ........................................................... 72
Font (Panel) .................................................... 129, 263
Font Size
  enter manually ............................................ 194
Font Sizes and Units (Tip) ............................... 195
Format ......................................................... 76, 79, 82, 109, 111, 122, 130, 144, 197, 215, 222, 225, 234, 261
Format (Palette) ............................................. 260
Formatting
  with character style sheets ............................. 126
Formatting ...................................................... 130
Formatting (Palette) ....................................... 127, 130, 132, 169, 170, 194–196, 200, 234
Formula
  in Text ......................................................... 81
Formula Borders in Text ................................... 81, 139
Formula (Definition) ......................................... 275
Formulas ....................................................... 99
  Construction ............................................... 100
  Functions .................................................... 102
  Operators .................................................... 101
  References to cells ..................................... 101
  References to ranges ................................... 101
  spread ....................................................... 114
Formulas ....................................................... 81
  FILE ......................................................... 32, 38, 43, 45, 46, 51, 53, 83, 141, 142, 155, 171–173, 183, 205, 206, 242, 250
  FILE TYPE ................................................. 46, 171, 183
  Fill (Definition) ............................................. 275

Favorites (Panel) ............................................ 44, 174, 192, 198
File
  Enter (Mac OS) ............................................. 62
  Import ......................................................... 83
  Insert (Windows) .......................................... 62
File Compacting When Closing ....................... 264
File (Definition) ............................................. 275
File Formats
  Excel ........................................................ 32
  foreign ...................................................... 45
  Picture ...................................................... 32
  Word ........................................................ 32
  FILE ......................................................... 32, 38, 43, 45, 46, 51, 53, 83, 141, 142, 155, 171–173, 183, 205, 206, 242, 250
  FILE TYPE ................................................. 46, 171, 183
  Fill (Definition) ............................................. 275
Formulas (Palette) ........................ 99
Foyer ........................................ 43
Context Menu .............................. 44
Favorites .................................. 44
New Beginning With ..................... 44
Open document ........................... 44
Open recently used document .......... 44
Recent Documents ....................... 44
Recently used documents ............... 261
Set as Default ............................ 44, 51
Settings .................................... 44
Tear off stationery pad .................. 44
FROM...TO .................................. 142
Front Page .................................. 226
Function (Definition) ..................... 275
Function Window ......................... 116
Functions .* ............................... 101, 122
 fAverage .................................. 124
 fDocument Date .......................... 176
 fMax ........................................ 124
 fMin ........................................ 123
 fSum ........................................ 122
Functions in Formulas .................. 102
Functions Window ....................... 102

Gallery (Graph) ......................... 132
GENERAL (Panel) ......................... 117, 189, 205, 217, 243,

  261
General Program Settings .............. 264
GET INFO ................................. 64, 71, 96, 109, 169, 189, 216
Ghostscript (PDF) ....................... 160, 242
GLYPHS (Panel) ......................... 198
Graph ...................................... 131
Graph (Component) ..................... 26
Graphical Text ......................... 65, 177, 186
  Adjustments ............................ 66
Graphs
  Adding source data ................... 132
  Category Titles ......................... 134

Chart Type ............................... 132
Create .................................... 132
Gallery .................................... 132
Selecting graph type .................... 132
Tool Bar ................... .......................... 136
Working Procedures .................... 134
GRAY ....................................... 247
Gray Frame ................................ 52
Green Checkmark ....................... 102
Grid Lines (Spreadsheet) ............. 117
Guides .................................... 73
  Color .................................... 187
  Delete All ............................... 216
  in Master Layout ....................... 213
GUIDES ....................................... 186
GUIDES (Palette) ......................... 73, 212, 216, 227, 229

HEIGHT ..................................... 110
HELP ........................................ 62
Hide Cell Grid Lines .................... 205
Horizontal Pipeline (Tool) .......... 87
HTML Export
  Fonts .................................... 250
  Line Breaks ............................ 250
  Paragraph Properties ................. 250
  Rotated Objects ....................... 250
HTML-Export ............................ 32, 250
Hyperlink ................................ 242, 251, 263
HYPERLINKS (Panel) ................... 263
HYPHENATE ................................ 261

ICC ........................................ 249
ICC Color Profiles ...................... 249
IF the Specified Formula Returns
  True .................................... 219
ILLEGAL! (Definition) ................. 276
IMPORT ................................. 32, 45, 83, 141, 160
Index: L

L

LANGUAGE ................................. 261

LAYOUT ................................. 219, 237

Layout Component
Add ........................................... 219
Create ....................................... 237
First Page Number ......................... 217
Layout (Component) ....................... 27, 50
Layout Development in Master Layout
(Tip) ......................................... 230
LAYOUT INFORMATION (Dialog Box) 189,
237

LAYOUT ................................. 189, 216, 237
Left and Right of Axes and Lines (Defini-
tion) ........................................ 276
Left Indentation .............................. 78
Left Margin ................................... 78
Letter .......................................... 68
Library ........................................ 205
Library: Transferring Pages from Existing
Documents (Tip) ............................ 205
Line (Definition) ............................ 277

LINE FORMATS ............................. 144, 234
LINE FORMATS (Dialog Box) ............. 234
Line Spacing ................................ 77
Line Spacing (Definition) .................. 277
Line Style Sheet
Create ....................................... 234

LINE STYLE SHEET EDITOR ............... 204

LINE STYLE SHEET ............................ 234
Line Style Sheets
Assign ....................................... 234
Define ....................................... 204
Utilize ....................................... 234
Line Wrapping in Multiline Texts .......... 98
Lines
Design ....................................... 230
Draw ......................................... 230
horizontal .................................. 146
Style Sheet ................................... 24

J

JOB (Panel) ................................. 243, 244
JOB SETTINGS (Panel) ...................... 244

K

KEYBOARD SHORTCUTS .................. 262
Keyboard (Spreadsheet) .................... 98
Kink Curve Point (Tool) ..................... 153

INDEX: L 295
vertical .......................... 146
Lines in Front .................. 205
Lines (Tool) ..................... 145
LINGUISTICS (Panel) .......... 263
☑ LINKED TO FILE .......... 45
Links ............................. 242
List
Formulas ......................... 123
List (Definition) .............. 277
live documents ................. 21
Logical value (Definition) .... 282

M

Magnetic ......................... 73
Magnetic Grid (Definition) ... 277
Mail Merge ........................ 137
display for monitoring ........ 140
Insert form of address ........ 141
print ............................. 142
Show Elements ................. 139
MailMerge
Drop Options ................... 138
Margin
left ............................ 78
Margin Stops .................... 77
Master Layout
Add Layout Component ....... 219
as Stationery Pad ............. 208
Circular Pipeline .............. 216
Container Content Type ....... 213
Delete Pages .................... 224
Guides .......................... 213
Install Pipelines ............... 237
Page Numbering ............... 216
Page Numbers ................... 216
Page Title ....................... 217
Pipelines ....................... 216
Relationship to Document .... 208
Rules for Page Usage .......... 237
Rules for Using Pages ........ 216
Settings .......................... 209
Steps ............................. 211
Usage of Master Pages ........ 237
Master Layout (Component) ... 27
Master Layout Pages ........... 208
Master Layouts ................. 23, 207, 208
  Automatically Append Pages 208
  Changes ........................ 224
Master Page Usage at a Glance (Tip) .. 218
Master Pages .................... 208
  Double-Sided .................. 237
MASTER PAGES (Panel) ........ 216
ƒ Max ............................. 124
☐ MAXIMUM NUMBER OF DOCUMENTS TO
  REMEMBER .................... 261

Menus

☑ AUXILIARIES ... 42, 126, 192, 195, 197,
  204, 222, 231, 234, 247, 263, 266
☑ CHARACTER STYLE SHEET .. 130
☐ COLOR ......................... 197, 222, 261
☐ CONTENT TYPE .............. 69
☐ CONTENT TYPE .............. 214, 220
☐ DISPLAY SCALE .............. 53, 188
☑ DRAWING ... 61, 71, 150, 152, 159, 168,
  169, 214, 215, 220, 225, 235
☐ EDIT ......................... 38, 60, 78,
  80, 81, 99, 100, 120, 132, 170, 177,
  187, 195, 198, 200, 203, 216, 220,
  224, 261, 262, 264
☐ ENABLE ....................... 46
☐ ENTER SPECIAL TEXT ....... 187
☑ EXAMPLE FILES .......... 62
☐ EXTRAS ... 61, 72, 80, 176, 181, 183, 185,
  195, 212, 224, 227, 261–265
☐ FILE ......................... 32, 38, 43, 45, 46, 51,
  53, 83, 141, 142, 155, 171–173, 183,
  205, 206, 242, 250
☐ FILE TYPE .................. 46, 171, 183
☐ FILL STYLE SHEET .......... 215
☐ FORMAT ... 76, 79, 82, 109, 111, 122, 130,
  144, 197, 215, 222, 225, 234, 261
Help ........................................ 62
INFO ..................................... 62
INSERT SPECIAL TEXT 80, 81, 100, 170, 
177, 178, 195, 216
LANGUAGE .................................. 261
LAYOUT .................................... 189, 216, 237
LINE STYLE SHEET ......................... 234
METHOD ................................... 243
NEW COMPONENT .......................... 219, 237
OBJECT TYPE ............................... 150
PAGE NAVIGATION ......................... 251
PALETTE ..................................... 73
PALETTES ................................... 35, 36, 38–40, 
66, 81, 94, 125, 130, 146, 150, 153, 
161, 169, 186, 260
PARAGRAPH FORMATS ...................... 76
PARAGRAPH STYLE SHEET .............. 37
PICTURE ....................................... 64
PROTECTION .................................. 72
RULERS AND GRIDS ......................... 54
SCANNER AND CAMERAS ................. 32
SETTINGS FOR ............................. 181
SETTINGS FOR ............................. 263
SHOW ........................................... 27, 29, 77, 78, 81, 87, 92, 97, 
139, 170, 176, 185, 205, 260
SPREADSHEET ............................... 96, 104, 105, 109, 111, 
118, 124, 125, 199, 204, 221
SPREADSHEETS ................................ 94
STACKING ..................................... 215
STYLE ........................................... 109
TRAINING ..................................... 62
TRANSFORMATION ............................ 150, 152, 159
VALUE FORMAT ............................... 111, 122
WINDOWS .................................... 27, 
29, 35, 36, 38–40, 42, 53, 54, 66, 
73, 77, 78, 81, 87, 92, 94, 97, 125, 
126, 130, 138, 139, 146, 150, 153, 
161, 169, 170, 176, 185, 186, 188, 
192, 195, 197, 204, 205, 219, 222, 
224, 231, 234, 237, 247, 260, 263, 266
METHOD ................................... 243
\Min ........................................... 123
Mirror
Above < – > Below ............................ 159
Drawing Objects ............................. 150
\textbf{MIRROR ABOVE \textless – \textgreater BELOW} .......... 159
Mixed (Definition) ........................... 277
\textbf{MODIFY STATIONERY} ................. 173
Move Tool (Tool) ............................. 64
Moving Fill Style Sheets to Other Docu-
ments (Tip) .................................. 222
MultiLine Text (Spreadsheet) ............. 94
Multiline Text ................................. 94
Multiline text (Definition) ................. 277
Multiline Texts
Line Wrapping ............................... 98
NA! (Definition) .............................. 277
NAME! (Definition) ......................... 277
Names of months added .................... 121
Naming Style Sheets (Tip) ................. 128
Navigation (Spreadsheet) ................. 98
NEW BEGINNING WITH (Panel) .......................... 44, 51, 95, 155
NEW ........................................... 212
NEW CATEGORY SERIES (Dialog Box) ........... 132
NEW COMPONENT .......................... 219, 237
New Document .............................. 29
NEW (HORIZONTAL) ....................... 186
NEW (VERTICAL) ......................... 186
\textbf{NON-PRINTING ELEMENTS} .......... 205
\textbf{NON-PRINTING ITEMS} .............. 77
\textbf{NONPRINTING ITEMS} .............. 29
NULL! (Definition) ......................... 278
NUM! (Definition) ......................... 278
Number (Definition) ....................... 278
\textbf{NUMBER OF FOLLOWING PAGE} .......... 278
Numerical Entries (Spreadsheet) .......... 96
Numerical values
too long.......................... 97

**O**

Object Coordinates (Palette) .... 71, 74, 109, 132, 148, 150, 157, 158, 177, 185, 212, 221
Object coordinates (Palette) . 168, 199, 225
Object (Definition) ................. 278
Object Type ........................ 150
Objects moving with the Text ........ 118
Objects (Panel) ............. 72, 163, 170, 239
OK . 104, 124, 132–134, 217, 218, 233
Only Screen Representation in Document ............. 45
Open “TRAINING” Folder ........... 62
Open ................................ 161, 173, 205
Open Current Library .............. 206
Open (Dialog Box) ............. 173, 205
Open Document ..................... 173
Open Inventory ...................... 40
Operand (Definition) .............. 278
Operator (Definition) .............. 278
Operators in Formulas ............. 101, 113
Optimise Column Width / Row Height .......... 199
Option buttons ............... see Buttons
Option key (Definition) ........... 278
Other ............................... 231, 232
Other Components Set as Default for Document Generation (Tip) .... 51
Other Methods of Calculation (Tip) .... 113
Other Ways of Entering Formulas (Tip) 123
Outer Borders ...................... 221
overflow symbol ............... 87

**P**

Page Break (Spreadsheet) ......... 117
Page Down key (Definition) ........ 278
Page Format ........................ 53, 155
Page Gap (Definition) ............. 278
Page Management
Stationery Pads ...................... 166
Page Navigation ..................... 251
Page Number ...................... 80, 177, 187, 216
Page Numbering ............... 177
Master Layout ..................... 216
Page Numbers (Master Layout) .... 216
Page Representation .............. 27
Page Representation and Print Pages (Tip) .... 27
Page Setup (Dialog Box) ........... 227
Page Setup (Panel) ............... 245, 246
Page Size (Definition) ............ 279
Page Tag (Definition) ............. 279
Page Title (Master Layout) ....... 217
Page Up key (Definition) ........... 279
Page View ......................... 27
Pages
Automatically Append (Master Layout) .... 208
copy ............................... 264
Delete ......................... 224
drag ......................... 264
move ......................... 264
Palette
Windows ......................... 36
Palette (Definition) ............. 279
Palette Dock
Mac OS .......................... 39
Palette ....................... 73
Palettes
Coordinates ...................... 149
Curve Editing ..................... 153
Curve Editing ..................... 152, 153
Curves Editing .................... 154
Drawing Commands 146, 150, 161, 225
Format ......................... 260
Formatting .... 127, 130, 132, 169, 170, 194–196, 200, 234
<table>
<thead>
<tr>
<th>Section</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formula Palette</td>
<td>81, 101, 102, 111</td>
</tr>
<tr>
<td>Formulas</td>
<td>99</td>
</tr>
<tr>
<td>Guides</td>
<td>73, 212, 216, 227, 229</td>
</tr>
<tr>
<td>Mac OS</td>
<td>39</td>
</tr>
<tr>
<td>Object Coordinates</td>
<td>71, 74, 109, 132, 148, 150, 157, 158, 177, 185, 212, 221</td>
</tr>
<tr>
<td>Object coordinates</td>
<td>168, 199, 225</td>
</tr>
<tr>
<td>Spreadsheet Commands</td>
<td>94, 125</td>
</tr>
<tr>
<td>Typography</td>
<td>132, 194, 196</td>
</tr>
<tr>
<td>Palettes</td>
<td>35, 36, 38–40, 66, 81, 94, 125, 130, 146, 150, 153, 161, 169, 186, 260</td>
</tr>
<tr>
<td>Panel (Definition)</td>
<td>279</td>
</tr>
<tr>
<td>Panels</td>
<td>264</td>
</tr>
<tr>
<td>APPLICATION</td>
<td>97, 109, 110, 120, 121, 199, 200, 221, 224</td>
</tr>
<tr>
<td>ARRANGEMENT</td>
<td>109</td>
</tr>
<tr>
<td>CATEGORIES</td>
<td>134</td>
</tr>
<tr>
<td>CELL CONTENTS</td>
<td>203</td>
</tr>
<tr>
<td>COLORS</td>
<td>246</td>
</tr>
<tr>
<td>COORDINATES 71, 74, 132, 148, 150, 157, 158, 168, 177, 185, 225</td>
<td>132</td>
</tr>
<tr>
<td>DEFAULT CHARTS</td>
<td>80, 176, 181, 183, 194, 195, 263</td>
</tr>
<tr>
<td>DOCUMENT</td>
<td>61</td>
</tr>
<tr>
<td>DRAWING</td>
<td>44, 174, 192, 198</td>
</tr>
<tr>
<td>FAVORITES</td>
<td>129, 263</td>
</tr>
<tr>
<td>FONT</td>
<td>117, 189, 205, 217, 243, 261</td>
</tr>
<tr>
<td>GENERAL</td>
<td>261</td>
</tr>
<tr>
<td>Glyphs</td>
<td>198</td>
</tr>
<tr>
<td>HYPERLINKS</td>
<td>263</td>
</tr>
<tr>
<td>JOB</td>
<td>243, 244</td>
</tr>
<tr>
<td>JOB SETTINGS</td>
<td>244</td>
</tr>
<tr>
<td>LINGUISTICS</td>
<td>263</td>
</tr>
<tr>
<td>MASTER PAGES</td>
<td>216</td>
</tr>
<tr>
<td>NEW BEGINNING WITH</td>
<td>44, 51, 95, 155</td>
</tr>
<tr>
<td>OBJECTS</td>
<td>72, 163, 170, 239</td>
</tr>
<tr>
<td>PAGE SETUP</td>
<td>245, 246</td>
</tr>
<tr>
<td>PICTURES</td>
<td>263</td>
</tr>
<tr>
<td>RECENT DOCUMENTS</td>
<td>44</td>
</tr>
<tr>
<td>RECENTLY USED</td>
<td>261</td>
</tr>
<tr>
<td>SAMPLES</td>
<td>44</td>
</tr>
<tr>
<td>TEXT MARGINS</td>
<td>79</td>
</tr>
<tr>
<td>UNICODE CHARACTERS</td>
<td>198</td>
</tr>
<tr>
<td>VALUE FORMAT</td>
<td>96, 111, 122</td>
</tr>
<tr>
<td>PAPER FORMAT (Dialog Box)</td>
<td>227</td>
</tr>
<tr>
<td>Paragraph</td>
<td>24</td>
</tr>
<tr>
<td>Style Sheet</td>
<td>76</td>
</tr>
<tr>
<td>Paragraph Formats</td>
<td>79</td>
</tr>
<tr>
<td>Text Margins</td>
<td>79</td>
</tr>
<tr>
<td>PARAGRAPH FORMATS</td>
<td>76, 82</td>
</tr>
<tr>
<td>PARAGRAPH FORMATS</td>
<td>76</td>
</tr>
<tr>
<td>Paragraph Style Sheet</td>
<td>196</td>
</tr>
<tr>
<td>Create</td>
<td>37</td>
</tr>
<tr>
<td>PARAGRAPH STYLE SHEET</td>
<td>264</td>
</tr>
<tr>
<td>PASTE</td>
<td>120, 262</td>
</tr>
<tr>
<td>PDF</td>
<td>242</td>
</tr>
<tr>
<td>Adobe Distiller</td>
<td>242</td>
</tr>
<tr>
<td>and RagTime (Mac OS)</td>
<td>242</td>
</tr>
<tr>
<td>and RagTime (Windows)</td>
<td>242</td>
</tr>
<tr>
<td>Display Files</td>
<td>244</td>
</tr>
<tr>
<td>Ghostscript</td>
<td>160, 242</td>
</tr>
<tr>
<td>PDF Converter</td>
<td>242</td>
</tr>
<tr>
<td>Place one Page</td>
<td>160</td>
</tr>
<tr>
<td>Supported Properties</td>
<td>242</td>
</tr>
<tr>
<td>PDF Converter (Mac OS)</td>
<td>242</td>
</tr>
<tr>
<td>PDF Export</td>
<td>32</td>
</tr>
<tr>
<td>PDF EXPORT (Dialog Box)</td>
<td>243</td>
</tr>
<tr>
<td>Picture</td>
<td>62</td>
</tr>
<tr>
<td>add</td>
<td>214</td>
</tr>
<tr>
<td>behind Text</td>
<td>64</td>
</tr>
<tr>
<td>Change Position</td>
<td>64</td>
</tr>
<tr>
<td>Change Size</td>
<td>64</td>
</tr>
<tr>
<td>File Formats</td>
<td>32</td>
</tr>
<tr>
<td>Text in front of Pictures</td>
<td>214</td>
</tr>
<tr>
<td>with text wrapped around it</td>
<td>161</td>
</tr>
<tr>
<td>Picture (Component)</td>
<td>27</td>
</tr>
<tr>
<td>PICTURE INFORMATION (Dialog Box)</td>
<td>64</td>
</tr>
</tbody>
</table>
INDEX: R

<table>
<thead>
<tr>
<th>Category</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Picture</td>
<td>64</td>
</tr>
<tr>
<td>Fine Adjustments</td>
<td>162</td>
</tr>
<tr>
<td>PICTURES (Panel)</td>
<td>263</td>
</tr>
<tr>
<td>Circular Pipeline</td>
<td>179</td>
</tr>
<tr>
<td>Cut tool</td>
<td>87</td>
</tr>
<tr>
<td>Display</td>
<td>87</td>
</tr>
<tr>
<td>Horizontal tool</td>
<td>216</td>
</tr>
<tr>
<td>Installing new containers</td>
<td>91</td>
</tr>
<tr>
<td>Master Layout</td>
<td>216</td>
</tr>
<tr>
<td>Remove</td>
<td>90</td>
</tr>
<tr>
<td>Representation</td>
<td>181</td>
</tr>
<tr>
<td>Vertical tool</td>
<td>87</td>
</tr>
<tr>
<td>Pipelines</td>
<td>87, 92, 176, 185, 260</td>
</tr>
<tr>
<td>Place in a new layout component</td>
<td>118</td>
</tr>
<tr>
<td>Planes (Spreadsheet)</td>
<td>93</td>
</tr>
<tr>
<td>Point in Time (Definition)</td>
<td>274</td>
</tr>
<tr>
<td>Polygon</td>
<td></td>
</tr>
<tr>
<td>Edit</td>
<td>152</td>
</tr>
<tr>
<td>Polygon (Tool)</td>
<td>145</td>
</tr>
<tr>
<td>Position</td>
<td>71, 72</td>
</tr>
<tr>
<td>Positioning</td>
<td></td>
</tr>
<tr>
<td>Accuracy</td>
<td>60</td>
</tr>
<tr>
<td>Precision as Formatted</td>
<td>203</td>
</tr>
<tr>
<td>Prepare PostScript File for Deferred Distillation</td>
<td>243</td>
</tr>
<tr>
<td>Print All</td>
<td>142</td>
</tr>
<tr>
<td>Print</td>
<td>46, 142</td>
</tr>
<tr>
<td>Print Once</td>
<td>46</td>
</tr>
<tr>
<td>Print Preview</td>
<td>27</td>
</tr>
<tr>
<td>Print Range (Spreadsheet)</td>
<td>117</td>
</tr>
<tr>
<td>Printing</td>
<td>266</td>
</tr>
<tr>
<td>Printing Spreadsheet Components Separately (Tip)</td>
<td>117</td>
</tr>
<tr>
<td>Protection</td>
<td>72</td>
</tr>
<tr>
<td>Push buttons</td>
<td>see Buttons</td>
</tr>
<tr>
<td>QUIT</td>
<td>47</td>
</tr>
<tr>
<td>Quotation Marks</td>
<td>264</td>
</tr>
<tr>
<td>R</td>
<td></td>
</tr>
<tr>
<td>Radio buttons</td>
<td>see Buttons</td>
</tr>
<tr>
<td>Range (Definition)</td>
<td>279</td>
</tr>
<tr>
<td>RANGE OF CELLS</td>
<td>117</td>
</tr>
<tr>
<td>RANGE! (Definition)</td>
<td>117</td>
</tr>
<tr>
<td>Rearranging Style Sheets and Making them Globally Available (Tip)</td>
<td>129</td>
</tr>
<tr>
<td>RECENT DOCUMENTS (Panel)</td>
<td>44</td>
</tr>
<tr>
<td>Recently used documents</td>
<td>261</td>
</tr>
<tr>
<td>RECENTLY USED (Panel)</td>
<td>261</td>
</tr>
<tr>
<td>Rectangle</td>
<td></td>
</tr>
<tr>
<td>Edit</td>
<td>57</td>
</tr>
<tr>
<td>with rounded corners</td>
<td>148</td>
</tr>
<tr>
<td>Rectangle Tool (Tool)</td>
<td>55</td>
</tr>
<tr>
<td>Red Cross</td>
<td>102</td>
</tr>
<tr>
<td>Reduce Font by ... pixels</td>
<td>252</td>
</tr>
<tr>
<td>Reference to ranges in formulas</td>
<td>101</td>
</tr>
<tr>
<td>References to cells in formulas</td>
<td>101</td>
</tr>
<tr>
<td>Relationship to Document (Master Layout)</td>
<td>208</td>
</tr>
<tr>
<td>Remove Anchor Points (Tool)</td>
<td>153</td>
</tr>
<tr>
<td>Remove Page Break</td>
<td>117</td>
</tr>
<tr>
<td>Remove Transformation</td>
<td>152</td>
</tr>
<tr>
<td>Remove Union</td>
<td>111</td>
</tr>
<tr>
<td>Representation of the Containers</td>
<td>29</td>
</tr>
<tr>
<td>Reset</td>
<td></td>
</tr>
<tr>
<td>User Interface</td>
<td>34</td>
</tr>
<tr>
<td>Reset RagTime User Interface (Tip)</td>
<td>34</td>
</tr>
<tr>
<td>Reset Transformation</td>
<td>152</td>
</tr>
<tr>
<td>Reset User Interface</td>
<td>34</td>
</tr>
<tr>
<td>Return (Definition)</td>
<td>280</td>
</tr>
<tr>
<td>Return key (Definition)</td>
<td>280</td>
</tr>
<tr>
<td>Rotate</td>
<td></td>
</tr>
<tr>
<td>Drawing Objects</td>
<td>150</td>
</tr>
<tr>
<td>Rotate 90° to the right</td>
<td>159</td>
</tr>
</tbody>
</table>
Index: S

Rotation point (Definition) ........ 280
Rounding
   Commercial .......................... 203
Row Height
   Change ................................ 108, 221
Rows (Spreadsheet) ................. 93
Ruler
   Presets for New Windows .......... 263
   RULERS AND GRIDS ................. 54
Rules for Page Usage (Master Layout) 237
Rules for Using Pages (Master Layout) 216

S

SAMPLES (Panel) .................... 44
Save .................................. 45
   SAVE AS ............................. 45, 172
   SAVE ................................. 171, 183
   SAVE DOCUMENT ........................ 45, 171, 183
Scale Tool (Tool) .......................... 64
   SCANNER AND CAMERAS ........... 32
Scope (Definition) .................. 280
Screening ............................... 248
   Screening (Definition) .......... 281
Script (Definition) .................. 281
   SEARCH AND REPLACE ............ 29
   Search Expression (Definition) 281
Sector shapes .......................... 148
Select
   Anchor Points .................. 152
   Drawing Objects ............... 147
   Spreadsheets .................. 98
   Tricks .............................. 57
   SELECT ALL .......................... 78, 100, 200, 220, 261
   SELECT LIBRARY ..................... 205
Selecting graph type (Graph) .......... 132
Selection Handles (Definition) ..... 281
   SEND BACKWARD ................ 281
   SEND TO THE BACK .......... 215
   SEPARATE PRINT JOBS ....... 143
Serial Printing ........................ 142
   SET AS DEFAULT .................. 51
Set Properties
   Container Border ............. 168
   SETTINGS ............................ 264
   SETTINGS FOR ........................ 181
   SETTINGS FOR .................... 263
   Settings (Master Layout) ........ 209
Shift key (Definition) .............. 281
Shortcut (Spreadsheet) ........... 104
   SHOW GRID ......................... 54
   SHOW ................................ 27, 29, 77, 78, 81, 87, 92, 97, 139, 170, 176, 185, 205, 260
   SIZE ................................ 71, 158, 192
Skew
   Drawing Objects ................. 150
SlideTime ................................ 21
Snap to Grid ............................. 54
   SNAP TO GRID .................... 54
Sort
   By Column ......................... 124
   Sort Keys .......................... 124
   Sorting Order ................... 124
   SORT .............................. 124, 125
   Sort Keys .......................... 124
   Sorting Order ................... 124
Sound (Component) .................. 28
   Special Character (Definition) 281
   SPECIAL CHARACTERS ........... 78, 97, 170
Specify Page Format .................. 52
   Spot Colors ....................... 248
   Spreadsheet Cells as Containers 203
   SPREADSHEET .................... 220
   SPREADSHEET COMMANDS ........ 125
   SPREADSHEET COMMANDS (Palette) .. 94, 125
Spreadsheet Grid
   Print ............................... 117
Spreadsheet Information
   Arrangement .................... 109, 121, 200
   Value Format ................... 111
Spreadsheet Information (Dialog Box)
199, 200, 203, 205, 221, 224
Spreadsheet Information (Dialog Box)
121
Spreadsheet ... 96, 104, 105, 109, 111, 
118, 124, 125, 199, 204, 221
Spreadsheets ............ 93, 103, 220
Addresses ............... 93, 111
Alternative to Tabs ........ ... 80
Automobile ............. 94
Basics .................. 93
Borders ................ 93
Cell Addresses .......... 111
Cells .................... 93
Columns ................. 93
Create Union ........... 110
Data Entry .............. 95
Delete Columns ........ 125
delete Rows ............ 125
empty .................. 94
Error Value ............ 94
Fill Sequences .......... 105
Grid Lines .............. 117
Highlight Cells .......... 197
in the Layout .......... 118
Insert Rows ........... 125
Keyboard ............... 98
Manually Change Row Height ... 221
Multiline Text ........ 94
Multiline Text .......... 94
Navigation ............ 98
New Beginning With ... 95
Numerical Entries ......... 96
Object Coordinate Palette ...... 221
Operators ................ 113
Page Break ................ 117
Paste Special .......... 120
place in new layout component .... 118
Planes .................. 93
Print Range ............ 117
Remove Union .......... 111
Rows ........................ 93
Selection ................ 98
Shortcut ................ 104
Sort ..................... 124
Sum Button ........... 124
Technical Terms .......... 95
Third Dimension ........ 93
Tips for Data Entry ......... 95
Title Columns ........... 222
Title Rows .............. 222
Tool Bar ............... 94
Tools .................. 93
Value Formats .......... 94
Value Type ............ 94
Value Type Multiline Text .... 95
Value Type Text ....... 94
Values ................. 94
With Pipeline .......... 220
Spreadsheets (Component) .... 26, 93
Spreadsheets (Tool) .... 93, 94, 103
Squirrel ................ 40
Stacking ................ 215
Stacking Sequence ....... 214
Stationery Pads ........ 22
Different Following Pages ...... 184
Fundamentals .......... 167
in the Foyer .......... 173
modify ................. 173
Multi-page .......... 175
Notes .................. 185
Open to Change .......... 173
Page Management ....... 166
Save as a Stationery Pad .... 171
Settings .............. 181
Tear Off .............. 166, 172
with Master Layout .... 208
Style .................. 109
Style Sheet
Create ................ 196
Style Sheets .......... 23
Character ........................................... 24
Color .................................................. 24
Dependencies ........................................... 128
Fill ...................................................... 24
Inheritance ............................................. 128, 129
Lines ..................................................... 24
Naming ................................................... 128
Paragraph .............................................. 24
Properties ............................................... 128
use ......................................................... 130
Utilize Globally ........................................ 222
Sum Button ............................................. 95, 114
ƒ Sum ................................................... 122
Summarized in Short: The Steps to
Achieving a Master Layout (Tip) ............. 211
Supported Properties (PDF) ...................... 242
xor SWAP TWO CHARACTERS ................. 99
SYMBOLS (Dialog Box) .............................. 198

T
Tab for Right Alignment ......................... 178
Tab key (Definition) ................................. 281
Table Composition .................................. 93
Tabs ....................................................... 79
  Default ................................................. 81
  individual ........................................... 81
  Right Alignment ..................................... 178
Tabular Composition ............................... 192
Tag in the Center ..................................... 211
c TEAR Off ............................................ 173
Tear Off Copy from Stationery .................. 172
Tear Off from Stationery ............................. 181
Tearing Off Menus (Definition) ................. 281
Tearing off of Documents ......................... 166
Technical Terms (Spreadsheet) ................. 93
Text
  calculated ........................................... 81
  exporting ............................................ 260
  follows Picture Outline .......................... 238
  Graphical ............................................ 65
  in front of Pictures ................................. 214
  Objects moving with the Text .................. 118
xor TEXT ................................................. 214
  Text (Component) ................................. 25
  Text Container ...................................... 260
  Text (Definition) .................................... 281
xor TEXT FLOWS AROUND ....................... 163
Text Information
  Text Margins ........................................ 79
Text Margins
  Paragraph Formats ................................. 79
TEXT MARGINS (Panel) .............................. 79
Text Modules .......................................... 262
Text Ruler .............................................. 82
Text Tool (Tool) ....................................... 66
xor TEXT WRAP DISTANCE ....................... 239
Text Wrapping around Pictures
  Fine Adjustments .................................. 162
Text wrapping around pictures .................. 161
Third Dimension (Spreadsheet) ................. 93
xor TILE WINDOWS HORIZONTALLY ............... 138
xor TILE WINDOWS VERTICALLY ................ 138, 261, 262
Time ..................................................... 96
xor TIME FIELD ....................................... 80
Time Periods .......................................... 96
Time Span (Definition) ............................. 282
Tips
  Adjust Foyer ........................................ 44
  Aligning Tabs to Left or Right Margin ....... 179
  Background Knowledge: Containers
     and Content Types ................................. 70
  Changing Object Type to Change the
     Shape ............................................... 150
  Changing Picture Size, Picture Position
     and Container Size ................................. 64
  Customizing Graphs ................................. 136
  Data from Foreign Applications as Ad-
     dress Source ....................................... 141
  Determining Guide Positions .................... 227
  Double-sided Document with Two-
     column Page Layout ............................... 191
Drawing Circles and Squares ................. 55
Effectively Managing Stationery in the
Foyer ........................................ 173
Exact Changes ................................. 109
Filling Multiple Cells with the Same
Contents ....................................... 107
Font Sizes and Units ............................ 195
Inserting Spreadsheets in Other Com-
ponents ........................................ 118
Inserting Symbols ............................... 198
Layout Development in Master Layout
230
Library: Transferring Pages from Exist-
ing Documents ............................... 205
Master Page Usage at a Glance ............ 218
Moving Fill Style Sheets to Other Docu-
ments ........................................... 222
Naming Style Sheets ............................ 128
Other Components Set as Default for
Document Generation ....................... 51
Other Methods of Calculation .............. 113
Other Ways of Entering Formulas ....... 123
Page Representation and Print Pages27
Printing Spreadsheet Components Sep-
arately .......................................... 117
Rearranging Style Sheets and Making
them Globally Available .................... 129
Reset RagTime User Interface ............ 34
Summarized in Short: The Steps to
Achieving a Master Layout .................. 211
Turning Lines into Arrows ................... 146
Undo Steps ..................................... 60
Using Grid Lines ............................... 54
Using Guides ................................... 73
Which PDF Properties are Imple-
mented? ........................................ 242
Why Color Management? ..................... 248
Working with Multiple Windows ........... 137
Tips for Data Entry (Spreadsheet) ....... 95
Title Columns (Spreadsheet) ............... 222
Title Rows (Spreadsheet) ................... 222

© To Which No Special Rule Applies 218,
237

Tool
lost ........................................... 56
Switching ....................................... 56

Tool Bar
Abacus ......................................... 101
Mac OS ......................................... 38
Spreadsheets .................................. 94
Windows ....................................... 35

Tool Bar (Graph) ............................... 136

Tools
Add Anchor Points ............................ 153
Bézier .......................................... 145
Closed Shapes .................................. 145
Curve Splitting ................................ 153
Cut Pipeline Tool ............................. 185
Cut Pipeline tool ............................... 87
Horizontal Pipeline ........................... 87
Kink Curve Point .............................. 153
Lines ........................................... 145
Move Tool ..................................... 64
Polygon ........................................ 145
Rectangle Tool ................................. 55
Remove Anchor Points ...................... 153
Scale Tool ..................................... 64
Spreadsheets ................................. 93, 94, 103
Text Tool ...................................... 66
Vertical Pipeline .............................. 87

☑ Torn Off Completely ............... 181, 182
☑ Training ....................................... 62
Transform (Definition) ...................... 282

Transformation
Drawing Objects .............................. 150
Remove ......................................... 152
Reset ............................................ 152
Transformation (Definition) .............. 282

☐ Transformation ........................... 150, 152, 159
☒ Transparency .............................. 215, 261
Truth value (Definition) ................... 282

Turning Lines into Arrows (Tip) ............ 146
Typography .................................. 66
Typography (Palette) .......... 132, 194, 196

Undo ............................................. 99
Undo Steps (Tip) ................. 60
Unicode Characters (Panel) .... 198
Units ............................................. 194
Units of Measurement .......... 54
Usage of Master Pages (Master Layout) .................................. 237
Using Grid Lines (Tip) .......... 54
Using Guides (Tip) ............... 73

Value (Definition) ................. 282
Value Format ......................... 94
Value Format (Panel) ....... 96, 111, 122
Value Type Multiline Text (Spreadsheet) .... 95
Value Type (Spreadsheet) .... 94
Value Type Text (Spreadsheet) .... 94
VALUE! (Definition) .............. 282
Values (Spreadsheet) .......... 94
Vertical Pipeline (Tool) .......... 87

What’s This? .......................... 36
When in doubt, convert to image 251
Which PDF Properties are Implemented? (Tip) ................. 242
Who's Index Counted from the End Is Specified .......... 218, 219, 237
Who's Index Counted from the Start Is Specified .......... 216, 217, 219, 237
Who's Number Is Specified .... 216–218
Why Color Management? (Tip) .... 248
Width .................................. 110